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About This Guide

The STEP’n’design User Guide contains information about the STEP’n’design plug-in to Stibo’s STEP solution.
The STEP’n’design plug-in is available from Stibo.

The guide assumes that:

o Users (creative staff and/or designers) have a working knowledge of InDesign

o Users have a working knowledge of the STEP workbench

« Users have a working knowledge of STEP Flatplanner (if using this component)
o Users have a working knowledge of STEP AutoPage (if using this component)

« Users have a STEP user name and password assigned to be able to connect to the STEP database

Note: The guide only contains information about the STEP’n’design plug-in. For more information about STEP
PIM, see the STEP Product Information Manager User Guide and the Online Help. For more information about
STEP Flatplanner, see STEP Flatplanner User Guide. For more information about STEP AutoPage, see STEP
AutoPage User Guide.

About STEP’n’design

This section provides general information about the STEP’n’design plug-in and how it is used in connection with
Adobe InDesign, the STEP Workbench, STEP Flatplanner, and STEP AutoPage components.

Note: Supported versions of Adobe InDesign are CS6, CC 2015 (CC11), and CC 2015.4 (CC11.4.0, June 2016
release).

Businesses producing printed collateral—including catalogs, brochures, and sales flyers—face a rapidly changing
set of challenges in producing frequent publications, often for multiple brands. In addition, complexity has
increased with the requirement for marketing in multiple languages, price versions, and to specific customer
segments. The final challenge—creativity in page design, even for the most unadventurous product ranges—is a
must if a promotion is to catch the attention of the customer.

Using STEP’n’design allows you to connect to the STEP database and work with InDesign documents as
dynamic documents, greatly simplifying (and even fully or partially automating) the production of printed collateral.
The benefits of using STEP'n'design include:

« Use of pre-built InDesign page layout templates that can be used repeatedly ('create once, use many')
« Instant availability (via STEP) of text and images for placement ('mounting') on pages

« Ability for creative users to access content in STEP without having to log into the workbench (all tasks can be
performed from within InDesign)

« One-click capabilities to update previously mounted pages with the latest content updates from STEP (for
example, updates to prices, product availability, and marketing text)

« Ability to write data from mounted pages back to STEP

© Stibo Systems - Confidential 6
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« Ability to save InDesign documents to STEP, not only making the documents available to users in multiple
geographical locations, but bringing information about product placement and space usage into STEP that
can later be used for data export and reporting purposes

« Ability to dynamically create indexes and tables of contents

« Integration with publishing workflows, easing communication between departments in production
environments (only available with the Flatplanner component)

This documentation assumes that users have a basic understanding of STEP and a working knowledge of
InDesign. Instructions on how to use InDesign itself are outside the scope of this documentation, except where
required to explain how InDesign's standard functionality interacts with STEP'n'design.

Topics covered in this documentation include:

o STEP'n'design template creation
« Mounting (paginating) pages
+ Saving Documentsto STEP

« Index generation
Though the STEP Flatplanner and STEP AutoPage publishing components are mentioned in various places
throughout this documentation / user guide, full details of these components are covered in their own sections:
+ STEP Flatplanner user guide
« STEP AutoPage user guide

Additionally, limited STEP'n'design functionality—including print on demand—is available in the Web UI. For more
information, see the STEP Publishing Web Ul section of the Web User Interfaces documentation here.

Mounting (Paginating)

STEP’n’design provides creative users with a view of text and images within STEP. Mounting of product data can
be done by dragging and dropping from the STEP’n’design STEP palettes onto the InDesign page.

To reduce the time needed to build pages, ensure style consistency, and improve accuracy, STEP’n’design
enables you to create templates to plan the layout roughly before mounting.

A template predefines a selection of STEP database content with powerful formatting rules that will automatically
style content dragged and dropped onto the page. This feature reduces the time needed to build pages, ensures
style consistency, and improves accuracy. Templates can easily be created, maintained, and reused by designers
using InDesign.

Using the STEP’n’design plug-in, you can create the following documents:

o Product templates
« Page templates

« Publication templates

Which templates to use depends on your system setup (see table below).

© Stibo Systems - Confidential 7
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InDesign STEP Flatplanner STEP AutoPage
Product Template X* X X
Page Template X
Publication Template X X X

* The use of product templates is optional, but strongly recommended.

Note: The product templates used when working with or without STEP Flatplanner / STEP AutoPage are
exactly the same.

For more information about mounting products and planned pages, see "Mounting Products" on page 103 and
"Mounting Planned Pages".

For more information about creating templates, see "Product Templates" on page 59, see "Publication Templates"
on page 80and "Page Template".

Saving Documents to STEP

Another feature in STEP’n’design is the ability to save InDesign documents back to STEP. Documents to be
saved back could be either templates or finalized pages or documents. The advantages of saving documents back
to STEP are:

o Theybecome visible in STEP

© Stibo Systems - Confidential 8
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« ltis possible to reuse product layout

¢ ltis possible to create indexes

For more information about saving mounted pages and documents, see the section about “finalizing
pages/documents” in the respective chapters describing mounting.

Updating Documents / Database

A key feature in STEP’n’design is the ability to update your already created page(s) with the latest changes from
the database. This ability enables you to start building your pages even when product data is not complete or
approved yet. Using the update features, you can, at all times, make sure that the contents of your page matches
that of the STEP database. You can also work the other way around and update the STEP Database with the
latest changes in content on your mounted pages.

For more information about updating documents and writing information back to STEP, see "Updating Documents
in InDesign" on page 141, and "Writing Data Back to STEP" on page 137.

Creating Indexes

As STEP’n’design enables you to save documents back to STEP with page numbers, you can create an index by
using the STEP Export Manager to export the index words in an XML file. From InDesign, the file can then be
imported from the File menu. For more information, see Creating Document Indexes.
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Publications and Versions

As complexity has increased with the requirement for marketing in multiple languages and to specific consumer
segments, it is necessary to define different versions for your publications.

STEP’n’design is capable of supporting 'multi-dimensional’ product data. This means that the database can store
multiple 'views' on the same product data. Typically, these views—called versions—are modeled around specific
language and country views on data. Versions could also be created to support currency zones, vertical markets,
or type of catalog. Therefore, product data is organized into different versions in publications to enable publishing
into InDesign.

~~[[7) Asset Placeholders

[“_‘| Configurations

[+#1-([25) Image Hierarchy

--E, Index Words

[#1-(25) Sample Data

[“_‘| Supplier Portal

E Customer Data Root
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[+l Templates

0
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-- Section 1
/(22 Primary Product Hierarchy
-5 Collections
/-3 eCatalogs
]c’_*} Recyde Bin

| R ey B o O e |

The advantages of STEP’n’design that enable you to work with different versions (defining context and
workspace) and layers are the following:

« You can see a proof view of the individual layers

« You save cost for printing by using black plate change

For more information about creating publications and versions, see STEP PIM User Guide. For more information
about working with versions, see "Working With Version Layers" on page 97.

Using Workflow

When working with STEP Flatplanner it is possible to set up a workflow. The STEP’n’design integration enables
creative staff to use a STEP Flatplanner workflow to access the publications in STEP and accept and complete
tasks from within InDesign.

For more information about using a workflow, see "Mounting Planned Pages".
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Installing STEP’n’design

This section contains information about installing the STEP’n’design plug-in(s) on your local computer, logging on
to STEP from within InDesign, and setting preferences for your InDesign session.

This topic assumes that you already have InDesign installed on your computer.

Installing the STEP’n’design Plug-in

In order to log onto STEP from within InDesign, you must first install the STEP’n’design plugin relevant to the
system that you are trying to access. It is strongly recommended that InDesign is closed while you install the
plugin. If InDesign is open, you will need to close and reopen InDesign before the plugin can be registered.

1. Open abrowser and type http://IMYSTEPDATABASE:11207/webstart/indesign- Plugin.html in the
Address bar to locate the plug-ins.

Note: Substitute MYSTEPDATABASE with the name of your own STEP system.

2. Depending on your platform, do the following:

« If Windows platform, unzip step-n-design.win.client.csX.zip, and then save the two InDesign plug-ins,
step-n-design.logic.win.csX.pln and step-n-design.ui.win.csX.pln into the Plug-Ins folder within
Adobe InDesign.

« If Mac platform, save the step-n-design.osx.client.csX.dmg plug-in on your Macintosh. Open it, and then
copy the two files into the Plug-Ins folder within Adobe InDesign.

Note: Instead of installing the files in the Plug-Ins folder, you can also create your own folder within the Plug-
Ins folder, such as e.g. “STEPplugins”.

After installing the plug-ins, you can now log on to the STEP database.

Logging on to STEP and Starting InDesign

Tolog on to STEP you must have the STEP’n’design plug-ins installed and have a STEP user name and
password. Furthermore, a version must have been created, defining the workspace and context you want to work
with. For more information about creating a version, see STEP PIM User Guide.

1. StartInDesign. A Connect to DB dialog box appears.

|lsername:;

|
Password: |
l

SErver:

Logon | Cancel |

2. Inthe Username field, type your user name.

3. Inthe Password field, type your password.

© Stibo Systems - Confidential 12
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4. Inthe Server field, type the name of the server (STEP database) you want to connect to.

5. Click Logon. The Change Version dialog displays.

b
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context to be used.

Unfold the relevant publication, click a version, and then click OK. The version defines the workspace and

InDesign will now open. As the STEP’n’design plug-ins have been installed, the InDesign interface contains a

STEP menu in the menu bar and a number of STEP Palettes.

For more information about the STEP menu and the STEP Palettes, see "Description of the InDesign

Interface" on page 14.

© Stibo Systems - Confidential
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Description of the InDesign Interface

This section contains a description of the InDesign interface and the different commands and views that are
available in a STEP Palette and STEP menu when the STEP’n’design plug-in is installed and you are connected
to a STEP database. For more information, see Installing STEP’n’design in the STEP'n'design
documentation.
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In the menu bar of InDesign, a STEP menu is available. Clicking the STEP menu gives you access to specific
STEP’n’design function and allows you to perform a range of operations on the active InDesign page.
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STEP

Connect to DE ...
Feload

IUpdate Document Daka ...
Laver Version Update ...
Check DE Update ...
Cleanup Mount Tags

Preferences ...
Change Yersion ...
Table Settings ...

Save Document o DE ...
Writeback to DE ...
Durnp Dacurment Daka . ..

Below you will find a brief description of the commands available from the STEP menu.

Connect to DB

Connect To DB L

|lsername;

|
Password: |
|

Server:

Logon | Zanicel |

Use this command to connect your InDesign installation to the STEP database.

For more information about connecting to STEP database, see "Installing STEP’n’design" on page 12.

Reload
Use this command to reload STEP PIM data to ensure that the current view in InDesign is up-to-date.

© Stibo Systems - Confidential 15



StiboSystems

Update Document Data

Document Update

Property Selection

[ 5] Atmibute Growps

[+ ) Object Properties
[ 5] Commerdal Types
[+ EﬁTablE Types

[+ [Z7)Referance Types
[» [ Table Content

|| (o | o

[T Selact [ Deselect All 0/ 33 Selected
[T Update Template Section

[ Update Repeat Area

[T Obtain values from transformed tables, checking for table structural changes

™ Force Update

[T Update Attribute Groups [ ok | Cancel

| £

Use this command to update your existing document with the latest STEP data structures such as attributes,
images or tables.

You can selectively choose which data structure to update, if you know that a certain category of data (such as
image references, attributes or tables) have been changed in the database, and you want to have your page
updated to reflect those changes.

You can update either a small data structure such as one individual attribute, or you can update an entire group of
attributes, images and tables. A very typical use is to do a traditional price merge, where all price attributes must be
updated.

You select data structures to be updated by expanding the element types and selecting the relevant check boxes
(right hand-side) for one or several data structures.

When selecting the Select/Deselect All check box you allow selection/deselection of all items within the tree. The
check box indicates how many items have been selected, and the total amount of items.
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When selecting the Update Template Section check box the list of objects applicable to a template section is
compared to those mounted on the page (ignoring order). Additional objects are placed at the end of the list unless
deleted items are also found - in which case added items replace the deleted items until there are no more deleted
items and the remaining items are then placed at the end of the list. When the Force Update check box is selected
the template section is removed from the page and replaced with the original gap etc settings - thus the objects will
appear in the order of the database.

When selecting the Update Repeat Area check box the list of objects applicable to a repeat area is compared to
those mounted on the page (ignoring order). Additional objects are placed at the end of the list unless deleted
items are also found - in which case added items replace the deleted items until there are no more deleted items
and the remaining items are then placed at the end of the list. When the Force Update check box is selected the
repeat area is removed from the page and replaced with the original gap etc. settings - thus the objects will appear
in the order of the database.

Selecting the Obtain values from transformed tables, checking for table structural changes check box will
update the attribute values by resolving the table and getting the value from the table - if strucure matches. This
option is very useful since transformations in a table are applied in a sequence, and the resulting attribute value in
a cell may therefore be very different from the value entered by the PIM operator.

Selecting the Force Update check box will re-send a value from the STEP database to the page and overwrite
local changes on the InDesign page.

For more information about updating existing document with the latest STEP data, see "Updating Documents in
InDesign" on page 141.

Layer Version Update

Layer ¥ersion Update
urrent evizad
Publication: Master Publication: Master _I ‘
Layer Wersion WoH:space Conkeit Wersion Varkspace Contest Clear Contert Owerides  Apply
Aotk Master Main Global |Master - I Main Global (Il - =l
=l

[ Obtain values from transformed tables, checking for table structural changes |Main vll_ Override Version YWorkspace
[~ Do not update matching DB/placed values Ik, | cancel |

Use this command to switch context/workspace for an InDesign version layer of your own choice.
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Changing version layer will force InDesign to re-fetch the data contents for your version from STEP. Changing
context / workspace for a certain version layer will potentially affect all data in the selected version layer in the
active document. For more information about changing version layers and context / workspace, see "Working With
Version Layers" on page 97.

It is possible to change the publication as well by clicking the [...] button (upper right area). This is useful if you want
to attach an existing document to another publication.

You can also use the command to swap workspace of mounted products. When swapping workspace, you may
need to mount product data from the Main workspace first and then swap the workspace to the Approved
workspace later. To be able to swap workspace the Override Version Workspace check box must be selected.

You can choose not to update placed values in case the placed values are identical to the new values. This is done
by selecting the Do not update matching DB/placed values check box. The placed values will be compared to
the values that need to be replaced and if these two values are identical no change will occur. This is a useful way
to retain styling made to placed values that matches the new values.

The Clear Context Overrides option sets the context applied to all items on the layer to that assigned to the
version. If a frame or attribute had a specific context applied through the product template settings on the template
palette there are removed.

For more information about workspaces, see About Workspaces.
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Check DB Update

Database updates since place

= [C_JFrame: Dascrption
= [ Context: EM All All Workspace: Main Object: 112368 Object Type: Product
= [C)éteibute Irerns
= JIDescriptinn
Placed: 12" Dual Torqua Harrmer Drill 20:0000 =Madel 1194605 5R 2030000 = <0x0000 =
DB: 1/2" Dual Torque Harmmer Drill 20:0000 =Model 119485k 2000000 = =0x0000=  * D

e

w
= Ternplate Sactions H j|

= Template Section: Context: EM All Al Warkspace: Main Sbject: 19337 Ohject Type: Product Source]
Additions: 1134ENM

=
[ Select [ Deselect al 0 f 0 Selacted
[ Obtain values from transformed tables when structure matches
¥ Show ohiject lists
Frame Perspective - ik Cancel
[ P =l | | 4

Use this command to check the page against the STEP database and list all the cases where a newer version of
the data exists in the STEP database.

From the list (lower left corner) you can choose to display the update-candidates by:

« Frame-Perspective (which means that data will be displayed frame-by-frame as mounted on the page)

« or by Object Perspective, which means data will be displayed product-by-product as it is organized in the
STEP database.

When selecting the Select/Deselect All check box you allow selection/deselection of all items within the tree. The
check box indicates how many items have been selected, and the total amount of items.

Selecting the Show object lists will split the dialog box into two areas, with the lower area showing object lists. If
repeated areas or template sections have a different object list, then items are shown in the object list.

Itis possible to perform the actual update from within this dialog box by selecting the relevant check boxes in the
right hand-side. If selecting the Obtain values from transformed tables when structure matches check box
when updating, the table structure is retained and only the values are updated - if structure matches.
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Use this command to cleanup mount tags on the page after removing a product (unless you are using the Unplace
selected object option under STEP Structure View/Place).

STEP Preferences

See Configuring the STEP Preferences Menu in the STEP'n'design documentation for full details.

Preferences
Multi-place Gap 0.0417 in Multi-drop cormmit 0
Structure Tree view options
Show all Attributes in Tree
[]show Tables in Tree
[ ] show Asset References in Tree
[] show ID after name
[]rlace in Galley
[#]Place in Free Space
Fit Calculated Table Width to Frame Width

Process Folder C:\Users\abcd\step-dtplindesigny,
Template Path C:\Users\abcd\Documents) Templates
Template Cache size 0

Server presentation MNone

Use default asset path

Asset Location

Mote Layer MNotes
Mote Colour

[]Don't mount Done Motes

[] Prompt: for Version

[ ] Auto Show Version Update [ | Auto save before save to DB
SOAP Timeout 900 cURL Timeout 00

[ ok ][ cancel

)
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Change Version

[ [@ oo Publication 2 |||
Celebrity Pub

CHIO Publications
Clowen Pub

CYLT Publications
DABA_TEST
DABA_TEST Spreads
Edian

EIER all publications
EJER 052

EJER Discowvety

EJER Galley

EJER HC InDesign
EJER PL Test

= [l EXER TRD

B OB OV RO RO &%

L7

'éi'-.-'er‘si-:-n 1
'-.-'ersi-:-n 2
'-.-'er:inn 3

[ [l EER Ticket 32423

=] | l"

[~

[ (]34 | Cancel |

&

Use this command to change version. The version defines the workspace and context you view in.

For more information about creating a version, see STEP PIM User Guide. For more information about working
with version layers, see "Working With Version Layers" on page 97.

Clean Mount Tags

Use this command to cleanup mount tags on the page after removing a product (unless you are using the Unplace
Selected Object option under STEP Structure View/Place).
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Save Document to STEP Database
Structure Point

StiboSystems

[» [3THEI Publications -]
[+ CTITHED Web Client 4.7

[ [CZ1Tink ternplates

[+ [T Tony

[ [TORI Classifications

[+ TR images

[» () Training Test Classification
[+ [TJUMSPSE classification

[ [[yWorks of Art

[+ [Ci123458

| Publications

[+ T=|Inde: Wards

[» CIProduct hierarchy root

[ Clase document and delete local copy

(]34 | Cancel |

&

Use this command to save your InDesign page back to the STEP database (alternative to storing it on your local
hard drive). If you save templates and publication templates back to STEP, the documents are selectable as
templates for other STEP users. You can save templates and publication templates back to a green publication
group. This way you keep publications and relevant templates together.

You can save the page in the following ways:

Save as Template: It is possible to save a document back to STEP as a product template. Once saved as a
product template, the document is selectable as a template for STEP users, who want to assign it as a default
template for a product.

Save Page Information: Document data (product assignment, page numbers, preview)—but not the
physical InDesign file—is stored in STEP. A document can only be saved into the section in the green
Publication hierarchy.

Save Document and Page Information: Document data (product assignment, page numbers, preview) as
well as the physical InDesign file, is stored in STEP. A document can only be saved into a Section in the green
Publication hierarchy.

Note: For users with large files and/or slow network connection, this option will significantly increase the time
taken to save to database compared to the Save Page Information option.
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Save Publication Template: It is possible to save a document back to STEP as a publication template. A
publication template is the one that product data is mounted onto.

Save Page Template: (Only relevant if you have a STEP Flatplanner license) Itis possible to save a
document back to STEP as a page template. A page template is used together with Flatplanner. A page
template specifies areas where products, assets and other items can be mounted.

Selecting the Close document and delete local copy check box will delete your locally stored document after
saving back to database.

Writeback to DB

Writeback to DB

= [T |Frame: Description [ :!
5 gl Context: GL Workspace: Main Object: 5075 Object Type: Product H
= [C1atbute Ttams [ |
= JIDescripti-:-n I_

Placed: SORA has been here . CThoose a Gran Canaria haliday and youll
DB: SORA has been here ... Choose a Gran Canaria holiday and vou'll get

= [C_JFrama: Hotel Description IF
57 g Sontext: GL Workspace: Main Object: Phoenix Beach Hotel Object Type: Prafv
= [C0)étribute Trerns v

v JIHDIEl Drescription v

Placed: This bright maderm, law-rise hotel iz well maintained and has 2 wa

DB This bright madetn, low-rise hotel is well maintained and has a watm

[T Select | Deselect Al 00 Selected
Ittaback workspace: -
| Frame Perspective ok | _ cacel |2

Use this command to write back mounted attribute content from InDesign to the STEP PIM database in case you
have made some changes to the product data in your InDesign document that must be reflected in the database.

You can choose which data to write back by selecting the check box in the right hand-side.

When selecting the Select/Deselect All check box you allow selection/deselection of all items within the tree. The
check box indicates how many items have been selected, and the total amount of items.

From the Writeback workspace list you can select the workspace to write back to.
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From the list (lower left corner) you can then choose to display the write back-candites by:

« Frame-Perspective (which means that data will be displayed frame-by-frame as mounted on the page)

« or by Object Perspective, which means data will be displayed product-by-product as it is organized in the
STEP database.

For more information about writing data back to STEP, see "Writing Data Back to STEP" on page 137.

Show Hidden Text Markers
Use this command to display the hidden text markers around STEP values.

Dump Document Data

Use this command to save an XML file containing information about the document, such as context, workspace,
mounted Objects, layers and page information. This is useful in case of troubleshooting.

Configuring the STEP Preferences Menu

The STEP Preferences menuin STEP'n'design contains settings that control much of the behavior of the STEP
palettes within InDesign as well as how tables are mounted, where hi-res images are mounted from, the location
of product templates when mounting pages through 'drag and drop' operations, and more.

Preferences
Multi-place Gap 0.0417 in Multi-drop cormmit 0
Structure Tree view options
Showr all Attributes in Tree -
[]show Tables in Tree
[ ] show Asset References in Tree
[ Show ID after name
[]Place in Galley
[/] Place in Free Space
Fit Calculated Table Width to Frame Width

Process Folder C:\Users\abcd\step-dtplindesigny, E]
Template Path C:\Users\abcd\Documents) Templates E]
Template Cache size 0

Server presentation MNaone -

Use default asset path

Asset Location E]
Mote Layer MNotes

Note Colour -

[ ] Don't mount Done Notes
Prompt for Version

[ ] Auto Show Version Update [ | Auto save before save to DB
SOAP Timeout s00 cURL Timeout 900
oK) [ Cancel ]
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The Preferences menu is accessed by navigating to STEP > Preferences ... from the InDesign application bar
across the top of the InDesign interface.

STEP | iy H~
Connectto DB ...
Reload
Update Document Data ...
Layer Version Update ...
Check DB Update ...

Cleanup Mount Tags

Preferences ...

Change Version ...

Table Settings ...

Save Document to DB ...
Writeback to DB ...
Dump Document Data ...

Relink Assets

The following list describes the settings contained within the Preferences menu:

« Multi-place Gap: The distance added here is the distance that STEP’n’design will add between objects when
mounting multiple objects in the same drag and drop operation.

o Multi drop commit: The number added here is the frequency of mount that should take place before a commit
is made, when mounting multiple objects in the same drag and drop operation.

o Structure Tree view options: Controls the visibility of attributes when viewing objects in the STEP Structure
View panel. Options are Show all Attributes in Tree, Show Attributes with Values in Tree, and Don't
show Attributes in Tree. Showing attributes makes them available for page mounting.

+ Show Tables in Tree: Check this box to display the tables that are linked to products and classifications in the
STEP Structure View panel, thus making them available for page mounting.

+ Show Asset References in Tree: Check this box to display the STEP asset references linked to Products
and Classifications in the STEP Structure View panel, thus making them available for page mounting.

o Show ID after name: Check this box to display both object IDs and Names in the different STEP palettes
(panels).

« Place in Galley: Selecting this check box indicates that mounting using a product template (and not using
STEP Flatplanner) should be performed into a text galley. For more information, see the Mounting Products
section of the STEP'n'design documentation.

« Place in Free Space: Check this box to make STEP’n’design place your element in the first available free
space on the page (rather than placing it in the specific location where you drop it) when creating a product
template. For more information about creating product templates, see the Product Templates section of the
STEP'n'design documentation.
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Fit Calculated Table Width to Frame Width: Check this box to adjust the width of calculated table columns
(starting with the widest column) until the width is identical to the width of the frame if a table width is not defined
in STEP.

Process Folder: This is the path in the directory structure in which STEP'n'design stores information. This
folder may contain a number of items: inSTEPLogOptions.xml to control logging and sub-folders for logs
(default destination for logging), tmp (where any temporary files are stored), comms (where communications
trace information is stored for diagnostic), and scripts (JavaScript event handler[s], when applicable).

Template Path: This is the path to the folder / directory where your product templates are stored. Required
when mounting pages locally through drag and drop operations.

Template Cache size: Increases performance when working with templates saved in STEP. Size is defined in
MB and a setting of 2 to 5 MB is normally suitable for most users.

Server Presentation: Defines which product template should be used for mounting objects. Choose None to
use the product template specified in the STEP Structure View panel. Choose Product default to use the
default product template assigned to the objectin STEP. Choose Publication rules to use the product
template(s) specified by the Object Layout pagination rules specified in STEP.

Use Default Asset Path: If checked, a default Asset Push path will be used to mountimages. A default asset
path is typically configured by Technical Support. Do not check if an Asset Location is specified in the Asset
Location field.

Asset Location: If a system has been set up to use Asset Push, then a path to the location of the hi-res images
is specified here. This field should be left empty if your system has not been set up to use Asset Push. See the
Linking to an Asset Location on an InDesign Server documentation for more information.

Note Layer: (Only relevant for Flatplanner) Type the name of the layer in which the Notes from the Flatplanner
should be shown.

Note Colour: (Only relevant for Flatplanner) Select a color for the Notes to be displayed.

Don't mount Done Notes: (Only relevant for Flatplanner) Check this box to prevent any Flatplanner Notes
marked 'Done' from mounting on the InDesign page.

Prompt for Version: Check this box to have STEP'n'design prompt you to select a publication version every
time you mount an object onto a page.

Auto Show Version Update: Check this box to automatically show the Change Version dialog box
whenever your version has been redefined in STEP (e.g., if the workspace on a version has been changed
from Main to Approved).

Auto Save before save to DB: Check this box to automatically save your documents (templates and actual
pages) locally before saving them to STEP. Since documents must be saved locally anyway before they can be
saved to STEP, checking this box will eliminate the clicks needed to save the documents manually.

SOAP Timeout: Enter a configurable timeout for SOAP operations in order to improve performance on slow
systems. Default is 900 seconds (15 minutes).

cURL Timeout: Enter a configurable timeout for cURL operations in order to improve performance on slow
systems. Default is 900 seconds (15 minutes).
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« Export: Click this button to save your STEP'n'design preferences into a text file. This file can be used by Stibo
support personnel to help troubleshoot issues.

STEP Palettes in InDesign

The STEP Palettes are used for actual mounting of STEP data, including template composition and image
mounting. Six InDesign palettes (also known as panels in InDesign terminology) are used with STEP'n'design:

STEP Structure View

STEP Template Frame

STEP Template Content

STEP Images

STEP Tasks (Flatplanner only)

STEP Publication View (Flatplanner only)

The STEP palettes are accessed from the Window menu in InDesign (accessed from the InDesign application
bar across the top) and function like any other panels in the InDesign interface. For example, they can be docked,
stacked, resized, and collapsed.

Details on each STEP’n’design palette are addressed in the following sections of this documentation.
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W vep s @ @ % v | £
Arrange *
Workspace *

Browse Add-ons

Articles

CC Libraries
Color >
Control Ctrl+ Alt+6
Editorial »
Effects Ctrl+Shift+F10
Info Fa
Interactive »
Layers F7
Links Ctrl+Shift+D
Object & Layout b
Cutput -]
Overlays

Pages F12
STEP Images

STEP Publication View
STEP Structure View
STEP Tasks

S5TEP Template Content
STEP Ternplate Frame

Stroke F10

Styles -]

Text Wrap Ctrl+Alt+W
~ Tools

Type & Tables »

Litilities *

STEP Structure View

The STEP Structure View InDesign palette (or panel, in InDesign terminology) is used primarily to mount
product and classification objects to InDesign pages, though asset references and attributes may also be
mounted. Other STEP hierarchies may also be accessed here if needed (for example, entities).

The STEP Structure View is essentially a mirror of the Tree in the workbench. It allows InDesign (DTP) users to
access contents of the workbench from within InDesign without having to log into the workbench.
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Most of the work in STEP’n’design is carried out from the STEP Structure View, as products and other objects are
dragged from the Structure View tree onto InDesign pages.

{ STEP Structure View | STEP| STEP| STEP| STEP =
[r []Assets -
[ [S]Configurations b
[» EZIETIMSE Articke Groups

[» ESIETIM Articde Groups
[» [C]Merchandising Hierarchy
[» [C]Suppliers
[r [CTemplates
[» [Cweb Ses
[» IEntity Roct
b (&) GDSN
l» () GOSN Receiver dats pook
l» [ Promations
[» [ Publications
7 [I]Primary Product Hierarchy
= [I0] Products
[» [Z)Apparel
- |_'_=|Fmtwea
= [[0]Shoes
- |_'_=|Pumps
~ -Pumps Items
7 =2k - High: 3" or higher

1

b @ 20714-A
b @ aories
b [ ®aor1ac -
Templzte: Main Product Template,indd -
L]
Fit to destination -

2 Spring Wedding Catalog / English US

Accessing the STEP Structure View

The STEP Structure View is accessed by navigating to Window > STEP Structure View from the InDesign
application bar across the top of the InDesign interface.
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[Window | Help sTEP B E 25% v | E%w
Arrange *
Workspace *

Browse Add-ons

Articles

CC Libraries
Color »
Control Ctrl+Alt+6
Editorial »
Effects Ctrl+Shift+F10
Info Fa
Interactive »
Layers F7
Links Ctrl+ Shift+D
Object & Layout b
Output ¥
Overlays

Pages F12
STEP Images

STEP Publication View
STEP Structure View
STEP Tasks

STEP Ternplate Content
STEP Template Frame

Stroke F10

Styles -]

Text Wrap Ctrl+Alt+W
+  Tools

Type & Tables »

Utilities *

Navigation and Search in the STEP Structure View

The STEP Structure View can be navigated by browsing or searching. To browse, hierarchies may be expanded
and collapsed by clicking on the arrow signs to the left of the hierarchy levels. To search, click on the magnifying
glass search icon in the lower left corner of the panel to display the Search dialog. (The Search dialog can also be
accessed by clicking the Options dropdown arrow in the upper right corner of the panel.)
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& STEP Structure View ||STE| STE| STE| & =
LS .
V3 |__=|Confqlaﬁnns
[» (CZ1ETIME Articke Groups
[» C3ETIM Articke Groups
[» [T]Meschandising Hierarchy
[» [T5uppliers
[» [IEntity Root
[ [C)GDsn
[» B Publications
[» [T Primany Product Hierarchy

Object Types
. [#]Product
[] Asset

[ ] Classification v
|| Publishing Hierarchy
[ ] Entity

OK

Fit to destination -

S pring Viedding Catalog / English US

The Search dialog enables typeahead and filtered searches in the STEP Structure View. Searches are
performed by Name or ID. Searches may be filtered by one or more of the following object types: Product, Asset,
Classification, Publishing hierarchy, and Entity. Search is not enabled unless at least one Object Types checkbox
is selected in the Search dialog.

Searches in the STEP Structure View may also be limited to a specific level (node) of a hierarchy by using the
Search below option. Search below is accessed through a right-click action on the chosen node. Note that there
is a three-character limit before typeahead search results will populate using Search below.

[ & publications
7 [T Primary Product Hierarchy

[» [ Discontinued P,

[ ﬁﬁuhct Ovemides

URL ...

Search below

b [iPackaging Refresh template list
E =pac:'"g pe= Place 4
Packaging Prod
Selection s
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Additional Features of the STEP Structure View Panel

« Publication Hierarchy: Templates and actual pages that have been saved back to STEP can be opened for

editing from the Publication hierarchy. To open a template or actual page, right-click on the document and
select Open Document from the menu.

[» [CV Promotions
- ﬁmhh:atbns
- @Templata
[ @ Publication Templates
4 @ Product Templates

toliday: Prodi s 1
[ D.o.ns&c:rahs URL..

R
% STEP Structure View | STER STER STER STEF =
R

b [ Main Produc Search below

b [EE] wedding prod Show mounted items

b Elpery protc | Open Document |

[» DPFDET&HEH' Refrech | T

b Elparty Product efresh template list

b [Elprice TaBL Clear template document type

b [ semontndea Place '
b [ Tocntes cs Selection b

[ @ Page Templates
[+ [ Standard Publications
[ @ Autopage Publications

« Template dropdown list: When working with local product templates (as opposed to using the Default
Template functionality), product templates are selected from this list. This list is populated by the product
templates that are saved into the folder specified in the Template Path in the STEP Preferences menu. See

the Configuring the STEP Preferences Menu section of the STEP'n'design documentation for more
information.
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4 STEP Structure View

L[

= [0 Products
[» ) Apparel
- |ijtwear
= [[Sjshess |,_-:|
- |_'_=|P|.|mps
- -Pl.lmps[hems
= [ Hesk - High: 3" or higher
I [ ®aories
Lo o071 =

Template: Main Product Templzte.indd -

b 4

Fit to destination hd

2 Spring Wedding Catalog / English US

+ Image display area: Appears directly below the Template dropdown list. If the selected object is referenced to
a Primary Image, a thumbnail of the image will be displayed in this area. (When an attribute is selected in the
Structure View, its value appears here.)

« Scaling dropdown list: Appears in the lower left corner of the panel. Options in this list define the following
settings for the scaling of your element when mounting attributes or asset references:

Fit to destination ll]
Width: a
Hiht: ]
Scale
Number of Colsmn:
Fit to destination

« Width: Sets the width of the text or image frame when dragging an attribute or asset reference directly
onto a page (not into an existing frame)

« Height: Sets the height of the text or image frame when dragging an attribute or asset reference
directly onto a page (not into an existing frame)

« Scale: Applies to images only, both when creating a frame (dragging directly onto the page) or
dragging into an existing frame. Enables you to apply a scaling factor (such as 90%) for an image. The
scaling factor will be applied to the image’s original (actual) size.

+ Number of columns: Makes the text or image frame conform to the width of one or more columns
within your active document when dragging an attribute or asset reference directly onto a page (not
into an existing frame)
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« Fit to destination: Causes an image reference to scale (up or down) to fit the existing frame that it is
dragged into

« Status bar: Displays the name and version of the publication you are currently working with. For example,
'Spring Wedding Catalog / English US'

Options Menu

The Options menu in the STEP Structure View is accessed by clicking in the dropdown arrow in the upper right
corner of the panel. It contains the following commands:

URL ...
Search
v Show mounted items
Refresh mounted items
Open Document
Refresh template list
Clear template document type
Place r
Selection r

o URL: Use this option to enter a STEP URL pointing to a node in STEP. This way you can easily navigate to a
specific node without browsing through the Structure View.

o Search: Click to access the Search dialog
« Show mounted items: Use this option to highlight mounted items in the STEP Structure View tree

+ Refresh mounted items: Use this option if you have mounted more items (after using the Show mounted
items option) and want them to be highlighted as well.

o Open document: Use this option to open an InDesign document saved in STEP (you must select the relevant
document in the STEP Structure View first).

+ Refresh template list: Use this option to update the product template list in the STEP Structure View.

+ Clear template document type: Select this to change a template document to a standard InDesign
document. A Save As dialog will appear, prompting you to save the document as a new document. The original
template document will not be affected unless you save the new document over it with the same name.

Place Options

The options available in the Place sub-menu enable you to set a range of parameters for the mounting process, as
follows:
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URL ...
Search
v Show mounted items

Refresh mounted items

Open Document

Refresh template list

Clear template document type

Place *| v Snap To Column

Selection 4 Place in Galley

v Place in Free Space

Unplace selected object
Replace selected object with template selected

Page Sel is part of Mount of Tree Se

+ Snap to Column: When selected, an item dropped on an InDesign page will align itself with the nearest inside
column edge to the left of the object.

« Place in Galley: When selected, STEP’n’design will place your galley text in the same frame when mounting
products (without using STEP Flatplanner). Option is disabled if Place in Free Space is selected.

« Place in Free Space: When selected, STEP’n’design will place your object in the first available free space on
the page, rather than placing it in the specific location where it is dropped. Option is disabled if Place in Galley is
selected.

« Unplace selected object: Use this option to unmount the object selected in the STEP Structure View tree.

+ Replace selected object with template selected: Use this option to recompose / reset the mounted object
according to the selected product template. Use this option if, for example, you have manually changed the
appearance of a mounted object on the page, but then decide to return to the original layout.

« Page Sel(ection) is part of Mount of Tree Sel(ection): (Only relevant for Flatplanner) Use this option if you
have items on the page that are not part of the product template (e.g., standalone graphics that do not exist in
STEP), but you want them to be included when using a Pickup Page Layout operation in STEP Flatplanner.

Selection Options

The options available in the Selection sub-menu enable you to perform a range of operations on the element that
you have selected on your InDesign page, as follows:
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URL ...
Search
v Show mounted items

Refresh mounted items

Open Document

Refresh template list

Clear template document type

Place r

Selection » Go To Page Selection in Structure view
Go To Page Selection in Workbench
Go To Structure Selection in Workbench
Update Page Selection

Write Page Selection back to DB

« Go To Page Selection in Structure view: When selected, the element you have selected on the page will be
shown in the STEP Structure View tree.

+ Go To Page Selection in Workbench: When selected, the element you have selected on the page will be
shown in STEP Workbench (this requires that STEP Workbench is already running on your computer).

o Go To Structure Selection in Workbench: When selected, the element you have selected in the STEP
Structure View will be shown in STEP Workbench (this requires that STEP Workbench is already running on
your computer).

« Update Page Selection: When selected, the element you have selected on the page will be updated with the
latest value from STEP.

« Write Page Selection back to DB: When selected, the value you have selected on your page will be written
back to the attribute in STEP (privilege restrictions apply).

STEP Template Palette

The STEP Template Palette (or panel, in InDesign terminology) is used primarily to create product templates
in InDesign. This palette is where elements from STEP—including attributes, asset references, and tables—are
linked to InDesign pages in order to build mounted pages in conjunction with publication templates. The STEP
Template Palette can also be used to link these same elements to page templates and publication templates,
though this is less common.

The STEP Template Palette mirrors many of the contents of the System Setup tab in the workbench. It allows
InDesign (DTP) users to access contents of the workbench from within InDesign without having to log in to the
workbench.
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Accessing the STEP Template Palette

The STEP Template Palette is accessed by navigating to Window > STEP Template Palette from the InDesign
application bar across the top of the InDesign interface.
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Navigation and Search in the STEP Template Palette

The STEP Template Palette can be navigated by browsing or searching. To browse, hierarchies may be
expanded and collapsed by clicking on the arrow signs to the left of the hierarchy levels. To search, click on the
magnifying glass search icon in the lower left corner of the panel to display the Search dialog.
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The Search dialog enables typeahead and filtered searches in the STEP Template Palette. Searches are
performed by Name or ID. Searches may be filtered by one or more of the following object types: Attribute Group,
Attribute, Table Types, Reference Types, and Commercial data lists. Search is not enabled unless at least one
Object Types checkbox is selected in the Search dialog.

STEP Template Palette Parameters

A range of parameters are set on product templates, page templates, and publication templates from the
lower half of the STEP Template Palette panel. These parameters control the behavior of elements on the page
when pages are mounted, such as the scaling of text or images to match the size of their frames; allowing a text
box or table to split if it reaches the bottom of a column or a page; whether to delete a frame if there is no content in
STEP to populate it; and many more.

STEP Template Palette parameters differ depending on the type of template being configured and the type of
frame being configured. The following sections of this topic list these parameters and describe their functions.

Parameters Available for Product Templates

Parameters for product templates in the STEP Template Palette are different depending on what type of frame is
being configured on the page: text frame, image frame, or grouped frame. As the list of parameters available for
each is extensive, they are covered separately in the following STEP'n'design topics:

o Text Frame Parameters in the STEP Template Palette

o Image Frame Parameters in the STEP Template Palette

o Grouped Frame Parameters in the STEP Template Palette
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Parameters Available for Page Templates

Only relevant when using the STEP Flatplanner component. For more information, see the STEP Template
Palette Parameters for Page Templates section of the Flatplanner documentation and the Galley Templates
section of the Flatplanner documentation.

Parameters Available for Publication Templates
Attributes and other frames may be added to publication templates that are intended for use with the STEP
Flatplanner or STEP AutoPage publishing components.

Elements added to publication templates from the STEP Template Palette are typically text frames that either
display description attribute values (such as page headers) or Product Continuation Notes for AutoPage
publications. Image frames may also be added to display logos or background images, though this is less
common.

Attribute text frames and image reference frames are configured on publication templates the same way that they
are configured for product templates.

For more information about adding Product Continuation Notes to publication templates for AutoPage
publications, see the About Templates in AutoPage section of the AutoPage documentation.

Options Menu
The Options menu in the STEP Template Palette (arrow in upper right corner) contains the following commands:

<STEPREF A="stibo.pseu-
doObjectName” />

& STEP Template Frame e | ~  Show Adornments |

Timar yPToductlmdgze

ITEFREF A="Longltembe-
scription” />

Product Template

« Apply Condition to Selection: This option is activated when the XML tagging for more than one attribute in a
text frame is selected. You can select multiple attributes by highlighting them using the InDesign Text tool.
Once highlighted, you can apply parameters such as Delete Before / Delete After and Fail Text to the group
of attributes at one time. Once the attribute tags are selected and the parameters chosen, click Apply
Condition to Selection to apply the selections to all the attributes at once.

+ Repeat Selection: Use this option when you want to perform a repeat selection for XML tags. For more
information about the repeat selection option, see the Using the Repeat Function for Subproducts section
of the STEP'n'design documentation.
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+ Repeat Options: Use this option to apply styling to elements in Repeat Selection. For more information about
styling, see the Using the Repeat Function for Subproducts section of the STEP'n'design documentation.

« Show Adornments: Use this option to display the STEP ID of the asset reference type assigned to each
image frames on the product template.

ﬁlmaryProductI ge

When adornments are not displayed, the asset reference type assigned to a frame can be found by selecting
the frame, at which point the STEP Template Palette tree will scroll to the assigned asset reference type.

¢ Group Alignment: For information, see the Grouped Frame Parameters in the STEP Template Palette
section of the STEP'n'design documentation.

Text Frame Parameters in the STEP Template Palette
Below is a description of the individual parameters available when configuring text frames using the STEP
Template Palette in InDesign.
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StiboSystems

+ Delete No Content: This option can be best understood as 'Delete IF No Content.' Check this box to ensure
that empty frames do not mount on pages if there is no content in STEP available to populate the text of the
attribute(s) linked to the text frames. This setting ignores static text within the frame. If this box is left unchecked,
the frame will be mounted, either as empty or with the XML references appearing, depending on the settings
placed in 'Delete Before' and 'Delete After' (details on these settings are explained further down in this list).

+ Keep With Next: Check this box to ensure that the selected frame remains with the frame that follows it
(resides directly below) on the page. This setting prevents situations where, for example, the name of a product
would be separated from its image if the product mounts at the bottom of the page and there is only enough
room to mount the frame containing the product name. With this box checked, both frames will mount on the
following page in order to keep the two frames together. A frame with Keep With Next set cannot have a Split

setting of Anywhere or Within Spread and vice versa.
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« Context: Use this option to mount textual content from a specific contextin STEP. If left empty (which is the
default, and most common setting), the system will mount data from the selected publication version onto the
page instead. One example for the use of this setting would be if your publication version is English but there are
one-off instances in your document where you need to mount the same attribute twice on the page butin a
different language, e.g. a product name should appear on the same page in both English and French, even
though the version for the entire publication pulls from an English context.

+ Delete Before + Delete After: In case your attribute is empty, you can force STEP’n’design to remove some
characters either before or after the location where the attribute should have been placed. This is especially
useful if you have some characters, which do not make sense to have on the page, when the mounted attribute
is empty.

For example: You want your page to display 'Special Offer: [PromoPrice] this week only'. If your database does
not contain a value in the 'PromoPrice' attribute for the product you are mounting, you do not want these text
strings before or after the attribute.

By using the Delete Before and Delete After functions, you can eradicate them.

For this example, setting a Delete Before value of 14 will delete the 14 characters of the “Special Offer:” string.
Setting a Delete After value of 15 will delete the 15 characters of the “this week only” string.

Note: In most cases you do not need to count the exact number of characters to delete, as delete before / after
will not delete another attribute reference. In addition, these delete options only take effect if there is no value
for the attribute.

These options should also be used even if there is no free text before or after a value but you need the frame to
disappear if there is no content. Using a value of DB = 1 or DA = 1 will remove any 'stray' XML tagging that
appears on the page if there is no content in STEP and ensures that the text frame itself will disappear when
Delete No Content is applied to the entire frame.

« Fail Text: If an attribute does not contain a value for the product you are mounting, you can use this field to
insert text that should appear on the page instead of a blank space or frame. This field is typically used for text
replacement strings such as 'Not Applicable', 'N/A', 'Call for details', '"None', etc. A Fail Text value can also be a
blank space or an invisible character. If an attribute is empty and does not have a Fail Text configured, the
attribute will appear on the page as a STEP XML tag (unless DB or DA values also have been configured; see
above for more information).

o Price Number: Used to designate which price break (price number) should be mounted from the values of a
commercial terms list.

« Transformation: Used to apply an attribute transformation to an attribute when being mounted onto the
InDesign page. The STEP Name (not ID) of the transformation must be typed into this field for it to take effect.
The name of the transformation is case sensitive. The most common types of attribute transformations used
here are those that transform text values into images.

o Repeat Sep.: This option is used in conjunction with the repeat area (STEPREPEAT) function as well as multi-
value attributes. If not set for a multi-value, then the multisep tag (Character Tags under System Setup >
Tags) from the database is used.
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The Repeat Separator value is a string, which is setin by STEP’n’design every time a 'Repeat Selection'
operation is performed. Often, the repeat separator is used to putin a new line character between the individual
attribute rows. In that case, the Repeat Separator is the InDesign character for new line \n.

Split: For non-repeating text frames, three split options are available from this dropdown list: Never,
Anywhere, and Within Spread. These settings are used to control the behavior of text frames that are too
lengthy to fit entirely in a column or on a page.

split: | Never |l

+ Never
Anywhere
Within Spread

Select Never to prevent the text box from ever splitting across a column or a page. Select Anywhere to allow
the text box to split across columns and pages even if the split results in the creation of a new spread. l.e., the
text box will be permitted to split from a right-hand page onto a left-hand page. Select Within Spread to limit
the split to within a spread only, i.e., only permit the text frame to split from a left-hand page to a right-hand
page, disabling the ability to create a new spread.

A text frame with a Split setting of Anywhere or Within Spread cannot have Keep With Next set, and vice
versa. (Information on Split options for repeating text frames appears below in this list.)

Set Height to Content: Check this box if you want STEP’n’design to automatically adjust the height of your
text frame if the text or table content is too lengthy to fit in the frame at its original size.

Cond requires all:

Data source: This controls whether the frame should mount content from the object that is being mounted
(Mount Object; most common), from children of the mounted object (Mount Children), or from an asset or
product linked to the mounted object by a reference type. By default, the data source is Mount Object, which
extracts values from the mounted object only.

Select Mount Children or a product / asset reference type when the text frame is intended to repeat on the
page. The text frame repeats in instances where information is available from multiple child objects or from
multiple referenced products or assets. When selected, the following options are activated in the STEP
Template Palette: Data Filter, Tile across, Max Distance, Gap, and Split.

Data source: |Mount Children v|
Data Filter: | Limit to Section Object Types v|
|| Tile across

Max Distance: |0 in |

Gap: |0in |

Split: | Between repeats v|
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« Data Filter: Choose Limit to Section Object Types when using the STEPREPEAT function to mount
metadata attributes and/or other information from child section objects when mounting publication or section
objects

« Tile across: Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another

« Max Distance: The maximum distance that horizontally tiled frames should repeat across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

« Gap: The amount of space to place between repeated frames when tiled horizontally

o Split: (For repeating text frames) For repeating text frames, the three split options are Never, Between
repeats, and Between repeats in spread.

split: | Never v

+ Never
Between repeats
Between repeats in spread

Select Never to prevent a series of repeating text frames from splitting across a column or page if there are too
many frames to fit in one column or on one page. Select Between repeats to allow the series of repeated
frames to split across a column or onto another page, even if the split continues from a right-hand page to a left-
hand page, creating a new spread. Checking Between repeats in spread only permits the repeated frames
to continue from a left-hand page to a right-hand page, disabling the ability to create a new spread.

« Align mount bottom: Select this to ensure that a text frame will always mount at the bottom of the page. In
Flatplanner, the frame will align to the bottom of the Flatplan frame. If more than one frame is designated to
align mount bottom, the lowermost frame will align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

Image Frame Parameters in the STEP Template Palette

Below is a description of the individual parameters available when configuring image frames using the STEP
Template Palette in InDesign.
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Delete No Content: This option can be best understood as 'Delete IF No Content.' Check this box to ensure
that empty image frames do not mount on pages if there is no image of the asset reference type linked to the
mounted product.

Keep With Next: Check this box to ensure that the selected frame remains with the frame that follows it
(resides directly below) on the page. This setting prevents situations where, for example, the name of a product
would be separated from its image if the product were mounted at the bottom of the page and there is only
enough room to mount the image frame. With this box checked, both the image and the text box below it
containing the product name will mount on the following page in order to keep the elements together. A frame
with Keep With Next set cannot have a Split setting of Anywhere or Within Spread and vice versa.

Context: Use this option to reference an image from a specific context into your product template. If left empty,
the system will mount the image from your version into the page instead. Normally, you will only choose a
specific context here if you are building a multi-versioned document and need to determine exactly which
context goes into a certain layer version. The quickest and most flexible solution is to leave the context selection
empty.

Import Asset at Scale: Image will be scaled according to the Scale value entered in the STEP Template
Palette. By default, the Scale field is blank, meaning that the image will be mounted at actual size unless a
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percentage below or above 100% is entered.

« Scale: Only active when Import Asset at Scale is selected. Using this option, images can be scaled with a
certain percentage, calculated on the basis of their original scanned size.

I @) Import Assat at Sc,alel

Sczle fsset to Frame
Fit Asset to Frame Width

Fit Asset to Frame Height

Scaler | B5%

+ Scale Asset to Frame: Image will be scaled proportionally until either width or height fit into the box, unless a
Max Scale limit is set (see below)

« Fit Asset to Frame Width: Image will be scaled proportionally until the width is identical to the width of the
frame, unless a Max Scale limit is set (see below)

o Fit Asset to Frame Height: Image will be scaled proportionally until the height is identical to height of the
frame, unless a Max Scale limit is set (see below)

+ Max Scale: Only active when Scale Asset to Frame, Fit Asset to Frame Width, or Fit Asset to Frame
Height are selected. Max Scale can be set from 5% to 500%.

Import Asset at Scale

I @) Scale Asset to F'er"el

Fit Asset ta Frame Width

Fit Ass=t to Frame Height

Max Scale: | 35%

The ability to constrain the image scale for the frame-fitting options using Max Scale prevents issues where
scaling too high results in a poor image that is not acceptable when printed. For example, if the actual size of
the image in STEP is much smaller than the frame to which it is being mounted, the Max Scale option will
prevent this small image from scaling up to such a large size that its resolution is too low for print.

Note that if the actual size of the image is larger than the frame, it will still scale down to fit the frame, regardless
of whether the Max Scale value is set above 100%. If Max Scale is left blank, images will scale up or down to fit
the frame, frame width, or frame height.

o Multi Asset Across: Allows multiple images (when there are multiple images linked to a single product using
the same asset reference type) to be placed inside a single frame and tiled horizontally. If not selected, the
images will be composed vertically. Only available when Import Asset at Scale is selected.

+ Size Frame to Asset: Automatically sizes the image frame to match the size of the image(s) linked inside. l.e.,
if the image mounts smaller than the image frame on the product template, the frame will shrink to fit the size of
the image, and vice versa for images that mount at a larger size than the original image frame.

« Alignment: Defines whether the images should be aligned left, center, or right within the image frame.
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Data Source: This controls whether the frame should mount content from the object that is being mounted
(Mount Object; most common), from children of the mounted object (Mount Children), or from an asset or
product reference type. By default, the data source is Mount Object, which mounts the object only.

Select Mount Children or a product/ asset reference type when the image frame is intended to repeat on the
page. The image frame repeats in instances where information is available from multiple child objects or from
multiple referenced assets. When selected, the following options are activated in the STEP Template Palette:
Data Filter, Tile across, Max Distance, Gap, and Split.

Data source: |Mount Children v|
Data Filter: | Limit to Section Object Types v|
[ ] Tile across

Max Distance: {0 in |

Gap: [0in |

split: | Between repeats v|

Data Filter:(For AutoPage only) Choose Limit to Section Object Types when using the STEPREPEAT
function to mount metadata attributes and/or other information from child section objects when mounting
publication or section objects in AutoPage publications.

Tile across: Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another

Max Distance: The maximum distance that horizontally tiled frames should repeated across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

Gap: The amount of space to place between repeated frames when tiled horizontally

Split: (For repeating image frames) For repeating image frames, the three split options are Never, Between
repeats, and Between repeats in spread.

split:  |Never v

+ Never
Between repeats
Between repeats in spread

Select Never to prevent a series of repeating image frames from splitting across a column or page if there are
too many frames to fit in one column or on one page. Select Between repeats to allow the series of repeated
frames to split across a column or onto another page, even if the split continues from a right-hand page to a left-
hand page, creating a new spread. Checking Between repeats in spread only permits the repeated frames
to continue from a left-hand page to a right-hand page, disabling the ability to create a new spread.
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« Align mount bottom: Select this to ensure that an image frame will always mount at the bottom of the page. In
Flatplanner, the frame will align to the bottom of the Flatplan frame. If more than one frame is designated to
align mount bottom, the lowermost frame will align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

Grouped Frame Parameters in the STEP Template Palette

Below is a description of the individual parameters available when configuring grouped frames using the STEP
Template Palette in InDesign. One common use for grouped frames is to group an image frame together with a
text frame in order to mount a linked asset and a metadata attribute connected to the asset (for example, animage
caption).

44 X

ﬂ % STEF Template Palette Si S! S! =

Templztz Type  Product Template -
[ £ Atribute Groups -
7 [£5]Object Properties

-
Delete Mo Content
l:‘ Keap With Nest
Context: -
Data sowrce:  PrimaryProductimage b
Data Filer -
D_ile aooss
Max Distance:
Gap!
Split:  Mever -

D.ﬂqlign mount bottom

« Delete No Content: This option can be best understood as 'Delete IF No Content.' Check this box to ensure
that the group of frames does not mount on pages if no content exists in STEP for all of the individual frames
included in the group.

o Keep With Next: Check this box to ensure that the grouped frame remains with the frame that follows it
(resides directly below) on the page. A frame with Keep With Next set cannot have a Split setting of
Anywhere or Within Spread, and vice versa.

« Context: Use this option to mount textual content from a specific contextin STEP. If left empty (which is the
default, and most common setting), the system will mount data from the selected publication version onto the
page instead. One example for the use of this setting would be if your publication version is English but there are
one-off instances in your document where you need to mount the same content twice on the page butina
different language, e.g. a product name should appear on the same page in both English and French, even
though the version for the entire publication pulls from an English context.
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Data source: This controls whether the frame should mount content from the object that is being mounted
(Mount Object; most common), from children of the mounted object (Mount Children), or from an asset or
product linked to the mounted object by a reference type. By default, the data source is Mount Object, which
extracts values from the mounted object only.

Select Mount Children or a product / asset reference type when the text frame is intended to repeat on the
page. The text frame repeats in instances where information is available from multiple child objects or from
multiple referenced products or assets. When selected, the following options are activated in the STEP
Template Palette: Data Filter, Tile across, Max Distance, Gap, and Split.

Data source: |Mount Children v|
Data Fiiter: | Limit to Section Object Types v|
[ ] Tile across

Max Distance: |0 in |

Gap: [0in |

Split: | Between repeats v

Data Filter: (For AutoPage only) Choose Limit to Section Object Types when using the STEPREPEAT
function to mount metadata attributes and/or other information from child section objects when mounting
publication or section objects in AutoPage publications.

Tile across: Check this box if repeated frames should be tiled horizontally across the page instead of stacking
vertically beneath one another

Max Distance: The maximum distance that horizontally tiled frames should repeat across the page (L-R)
before stopping and wrapping back around to begin a new row of repeated frames underneath

Gap: The amount of space to place between repeated frames when tiled horizontally

Split: The three split options are Never, Between repeats, and Between repeats in spread.

split:  |Never v

+ Never
Between repeats
Between repeats in spread

Select Never to prevent a series of repeating grouped frames from splitting across a column or page if there
are too many frames to fit in one column or on one page. Select Between repeats to allow the series of
repeated grouped frames to split across a column or onto another page, even if the split continues from a right-
hand page to a left-hand page, creating a new spread. Checking Between repeats in spread only permits
the repeated grouped frames to continue from a left-hand page to a right-hand page, disabling the ability to
create a new spread.
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« Align mount bottom: Select this to ensure that a grouped frame will always mount at the bottom of the page.
In Flatplanner, the frame will align to the bottom of the Flatplan frame. If more than one frame is designated to
align mount bottom, the lowermost frame will align to the bottom and the other frame(s) will mount above it,
separated by the same gap amount as on the product template.

Group Alignment Options
The Group Alignment selections in the Options menu enable you to set additional parameters for grouped frames.

% Apply Condition to Selection

-

Repeat Selection
I - Repeat Options ...
v _Show Adornments
Group Alignment ¥ | v Distance to Left Edge
Horizontal Spacing
Distance to Right Edge

m

« Distance to Left Edge: Same distance as if items were not grouped.

« Horizontal Spacing: If the text is to the right of the image with a 5 mm gap and the image changes size, the
text ends up 5 mm from the image.

« Distance to Right Edge: If the group grows or shrinks due to image size, the boxes maintain their distance to
the right edge.

STEP Images

The STEP Images panel is used to find images and mount them on the InDesign page. STEP Images enables
you to search for images across the whole STEP database. You can use wild cards * (wild card string) and ? (wild
card character) in your search. Searching is performed under the selected hierarchy (if a hierarchy is selected).
The maximum number of images returned in a search is 150.

Note: Searches in the STEP Images panel do not function the same way as searches in the STEP Structure
View and STEP Template Palette panels, i.e., searches are not typeahead and cannot be filtered by object type.
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The lower part of STEP Images displays the details of the current selected image if the Show Details option is
selected (see the next section of this topic, Options Menu).

Clicking the Reset button after a search will return the view to the top level.
Clicking the Up button will bring the view one level back.
Use the Scale field to scale selected items in the STEP Images palette.

Options Menu
The Options menu in the upper-left corner of the STEP Images palette contains the following commands:

« Case Sensitive: Use this option to determine if you want to search in case sensitive mode or not.

« Use Full Text Index: Use this option to search for attribute values that are defined as full text indexable in
the attribute editor in STEP. (It may take a little while to show the results).

« Show Details: Use this option to get details about a selected image. The details are shown in the lower part
of the window.
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STEP Tasks

STEP Tasks is used for DTP operators to pick up tasks available in Flatplanner workflows. DTP operators can
accept tasks, submit tasks, reject tasks, etc. from this view. Typically it is used when a page has already been
planned in STEP by a merchandiser user, then it goes to the DTP operator for further work.

Depending on the configuration of your Flatplanner workflow, comment fields may also be visible here.
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STEP Tasks comprises a tree view of tasks similar to the STEP Workflow Tasks tab in STEP. The tasks are
grouped by publication.

The status of the task is indicated visually by the following layout:

« Ifbold, the task is new and it has not been accepted yet.
« Ifregular (and not bold), the task has been accepted.

For more information about accepting tasks, see "Accepting Tasks from ".

Options Menu
The Options menu in the STEP Tasks palette (arrow in upper right corner) contains the following commands.
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Accepk Task

zancel Task

Task Completed

Show Details

Refresh

LT ] e [ i M = T
Gaboin Publication Yiew
Fotain Imane Search
Cipen dacument

Filter

Accept Task: Use this option to accept a task if working in a workflow. After accepting a task, the listin the
STEP Tasks tab is refreshed.

Cancel Task: Use this option to cancel a task that you have already accepted. The task is returned to the list of
incomplete tasks. After canceling a task, the list in the STEP Tasks tab is refreshed.

Task Completed: Use this option to complete a task and send a message to the next person in the workflow.
After completing a task, the listin the STEP Tasks tab is refreshed.

Show Details: Use this option if you want to see more details about a selected task.
Refresh: Use this option to refresh the list of tasks in the STEP Tasks tab.

Goto in Structure View: Use this option to go to task objectin STEP Structure View.
Goto in Publication View: Use this option to go to task object in STEP Publication View.
Goto in Image Search: Use this option to go to task object in STEP Images.

Open document: Use this option to open an attached document in an external editor.

Filter: Use this option to filter your task types. A Choose Item dialog box appears where you can select the
tasks you want to see.

STEP Publication View

The STEP Publication View panel is used in conjunction with the STEP Flatplanner publishing component.

STEP Publication View is used to view the Publication hierarchy in STEP.

Note: Search functionality is not available within the STEP Publication View panel.
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STEP, STEF, STEF, STEF J STEP Publication View

[ B Standard Publications -
[» [ Avtopage Publications -
= [E0 Flatplanner Publications
= [l Sering Wedding Catalog
[+ [ March Exchusives
= [l Party Favors
[+ [ Party Favors_2
R - Pary Hass
BR7 - Party Has
[R5 - Goodie bags
B9 - Goodie bags
EE10 - Party Masks
ER 11 - Party Masks
ELZ - Napkins
EB - Napkins
R 14 - Gonfert
R 15 - Gonfert
(22 16 - Noisemakers
R 17 - Noisemakers -

111

Itis also possible to mount or unmount page cells from the Preview area (lower part of the STEP Publication
View); see the next section of this topic, Options Menu, for more information.

Options Menu
The Options menu in the STEP Publication View (arrow in upper right corner) contains the following commands.
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URL ...

Mount planned page

Mount on current page

Create document from plan
Unmount planned page
Remount planned page
Mount page ce

Unmount page ce

Update page cell(s)

Import notes

Open actual page

v Scroll to page

Page Pickup ...

Refresh

Clear template document type
Show r

URL.: Selecting this option allows you to enter a STEP URL pointing to a node in STEP. This way you can
easily navigate to a specific node without browsing through the Structure View.

Mount planned page: Use this option to mount a planned page.

Mount on current page: Use this option to mount a planned page on a specific page, e.g. page 3 in your
InDesign document.

Create document from plan: Use this option to mount the plan using the publication template saved in
STEP.

Unmount planned page: Use this option to remove mounted plan on a page.

Remount planned page: Use this option to remount planned pages if content in STEP has been updated
since the page was originally mounted.

Mount page cell: Use this option to mount a page cell if you have mounted a Flatplan and selected a cell in
the Preview area (lower area of the STEP Publication View).

Unmount page cell: Use this option to unmount a page cell if you have mounted a Flatplan and selected a
cellin the Preview area (lower area of the STEP Publication View).

Update page cell(s): Use this option to update cells if you have mounted a Flatplan and selected a cell in
the Preview area (lower area of the STEP Publication View). If you need to update page cells, a “not equal’

symbol #is shown in the STEP Publication View.
Import notes: Use this option to import Notes placed on the Flatplan in STEP

Open actual page: Use this option to open a DTP document (InDesign page) from a section in your
publication.

Scroll to page: Use this option to auto-scroll the page in the document that corresponds to the selected
Flatplan in the STEP Publication View.

Page Pickup: n/a - Currently not available.
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+ Refresh: Use this option to update the STEP Publication View.

« Show: Use this option to choose between different views of the pages (actual / planned) in the lower part of
the STEP Publication View.
Available Show options are Plan only, Actual only, Plan on top, Actual on top, Plan on left, and Actual on left.

Plan only Show r
Actual only
v Plan on top
Actual on top
Plan on left
Actual on left

© Stibo Systems - Confidential 58



StiboSystems

Product Templates
This section describes how to create a product template and how to store a product template locally and/or in
STEP.

Product templates are used whether you use InDesign with or without STEP Flatplanner and STEP AutoPage.
The advantage of using a product template is that it enables you to mount specific product data from one or several
products directly to the page in one operation.

You can work in InDesign without using a product template, but it is strongly recommended to create product
templates, as you can mount one or several products directly to the page in one operation. If you mount without
using a template, you can only mount data one attribute / reference at a time.

Using the product template, you can control:

« Which attributes are part of the product presentation.

« How the product presentation is formatted in terms of fonts, styles, etc. by applying style names to the
content and frames.

« How the individual elements are positioned.

Note: Before you can use the product templates together with STEP Flatplanner and STEP AutoPage, the
templates must be saved to STEP.

The general method for linking a STEP element into a product template includes four operations:

1. Drawing a text frame or an image frame on your InDesign page.

2. Determining which database element (such as attribute or image) you want in the template, and which
parameters apply to it.

3. Dragging your definition into the frame.

4. Applying style names to the content or frame to be able to apply InDesign formatting such as style, font size,
indent, frame border etc.

Creating a Product Template

STEP’n’design enables you to mount fully made-up product presentations directly to the page. In order to do that,
you must first define one or several product templates, which the product will be mounted according to.

This section contains a description of how to:
o Draw text framesin InDesign
+ Determine frame content
o Link STEP data into frame
« Edit STEP tags within an InDesign text frame

« Draw image frames in InDesign (create template elements for images)
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« Create product template containing galley text

o Create layers

Note: As you work with your product template set-up, it is recommended that you save your work as you go
along. As the product template is a normal InDesign document, you can save it as a normal file anywhere on your
hard drive.

Designating the Template Type
1. Navigate to STEP > Template Type
2. Select Product Template from the STEP menu
(S| B B 1w00% v | v Ev @
Connectto DB ...
Reload

Change Version ...

Preferences ...

Template Type b Publicaticn Template
Update Document Data ... Page Ternplate

Layer Version Update ... +~  Product Template
Check DB Update ...

Relink Assets

Cleanup Mount Tags
Table Settings ...

Save Document to DB ...

Writeback to DB ...

Dump Decurnent Data ...

Draw a Text Frame
1. Draw atext frame using the Type tool (T).

The width and the height of the frame should be the correct width/height for your future output, unless you have
set the height to be auto-adjusted by STEP’n’design depending on the data mounted into it.

For information about drawing an image frame, see , see "Creating Template Elements for Images" on page
65.

Determine Frame Content
To determine what content to put in the created frame:
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1. Putthe cursor in the frame to which you want to add content.
2. Ifnotselected, click the STEP Template Palette.

STEF TEMPLATE PALETTE

Template Type | Product Template |
| _Search |
[ 5] Attribute Groups ﬂ

[ 5] Commerdial Types
[+ CipfjTable Types
[» [0]Reference Types

[T Delete Mo Content
[T Keep With Next

Frame Type:

|obis =

Delete Bafore

Delete After

Fail Text

Price Number

Transformation

Repest Sep.
I~ Can Split
[T Set Height to Content
[ Cond requires all

3. Select what you want to put into the template frame: Attributes, Product ID/Name, tables or Commercial Data
(Term-lists).

« Attributes are found in the Attribute Groups hierarchy. The Attribute hierarchy shows the valid metadata for
Attributes as children of each Attribute. Expanding the Attribute hierarchy, you can also add an Attribute
metadata property to a template.
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L= JIF\IOT Drescription attribute
Ji Ohbject Mame
Ji Attribute Dascription
Ji Attribute Crescrption
[T Attrbute EBSC Key
Ji Attribute Example

« The ID or name of the product you are using can be put into your template using Object ID or Object Name,
respectively. ID’s can be found under Object Properties hierarchy.

« Tables can be found in the Table Types hierarchy.

o Commercial Data can be found in the Commercial Data hierarchy.

Note: Text frames cannot have images added, unless an image frame is embedded into the text frame. For

more information about creating template elements for images, see 'Description of the InDesign Interface on
page 14.

1. Once you have selected which element you want to link into your product template, you can optionally set a
range of parameters (lower half of the STEP Template Palette panel) to control how the element is
referenced into the product template.

For example, template parameters can control the behavior of your database element by scaling the text box to
the size of the text, or allowing the text box to split if it reached the bottom of a column.

For more information about the individual parameter 'Description of the InDesign Interface on page 14.

Link STEP Data Into a Text Frame

Once you have selected your STEP element and set the correct parameters for it, you are ready to link it into the
product template.

« The actuallinking is a drag and drop operation. Drag the attribute from the STEP Template Palette and into
the created InDesign text frame.

When the element is dropped, the definition will appear as a STEP XML tag within the text frame.
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STEP TEMPLATE PALETTE

Templste Type | Product Template |
[ _Search |
= [C0)5tibo Area Attributes :|

= [F2] Default Attributes
b | Part Number

art Numbc&' [=

[» 2] FlatPlznner
[» [=)Global Product Atributes
[+ [)Local Product Attributes
[ C2)Marketing Attributes
[ [£01System Attributes
[» 21 Object Properties
[+ 01 Commencial Types
[ Cipfj7able Types
[» 0] Referance Types =

[m]

[T Deletz No Content
[T Keep With Nest
Context: | x|
Fame Ty | <]
|obea =] | 2

mm«e|

Delete After

Fail Text

Transformation

|
|
PlioeNl.mberI
|
s=. |
I~ Can Spit

[T Set Height to Content

[T Cond reguires 2l

Edit STEP Tags within a Text Frame

After STEP data is linked to a frame it is possible to perform a range of modifications and operations to the text
frame and the STEP XML tag itself. Among the most important are:

Insert additional attributes, product names and tables into existing frame.

Add plain text and characters in-between STEP XML tags.

Use the “repeat” function to let XML tags be repeated for sub-products.
Edit the XML tags freehand.
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Insert Additional Attributes into Existing Text Frame
You can link (drag and drop) as many STEP elements as you want into the text frame (overset text is allowed in
the text frame).

« Toadd an additional text element, repeat the linking STEP data procedure (see "Link STEP Data Into a Text
Frame" on page 62), and drag your new STEP element into the text frame.

Note: In the InDesign text frame, the element can exist before or after other elements, but not
within/overlapping.

Add Plain Text and Characters Between STEP XML Tags

Using the normal editing features of InDesign, you can add plain text or characters such as new-line, tab, empty
lines, etc. to the text frame. This means that you can separate multiple attributes (i.e. multiple STEP XML tags) by
tab, space, new-line character or really any other text string of your choice.

The characters you add into the text frame manually, will be used every time the template is utilized to mount
products on a page.

See an example of adding plain tex and characters in-between STEP XML tags below:

<STEPREF A="stibo.pseudoObjectName™ /=
<STEPREF A="MarketingText” />

Price this week: <STEPREF A="Price” />§
<STEPTABLE TT="SpecificationTable” /=

In this example:

« atemplate text frame has been set up.

« STEP XML tags have been created by dragging and dropping definitions for product name, the attribute
Marketing Text, the attribute Price and a table type called SpecificationTable.

Notice how a paragraph-character separates all data structures and how some plain text has been added as a
prefix to the Price attribute. Likewise, the currency symbol for price has been applied directly in the template.

Edit XML Tags Freehand

Though the normal way of maintaining the STEP XML tags in the text frame is by dragging the definition across
from the STEP Template Palette, it is also possible to change or add tags manually. Just be aware that the
system will not perform any data validation on the tags, so if you create a new tag such as <STEPREF
A="MarketingText” />, make sure that the name of attribute as well as XML syntax is correct.

Note: When placing the cursor in the XML text it is also possible to edit XML tags using the STEP Template
Palette.
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Creating Template Elements for Images
Images are built into the product template in much the same way as text elements (typically attributes) are.

To apply an image to your product template:

1. Draw animage frame on the product template using the Rectangle Frame Tool (F).

2. Todetermine your image frame content, click the STEP Template Palette.

STEP TEMPLATE PALETTE

Template Type | Product Template |
| _Sexch |
[» 5] Attribute Groups ;|

[+ [J)Object Proparties
[» 7] Commencial Types
[ Cipfj7able Types
= [£7) Reference Types
=7 [C7] Asset References
[+ EKDHaSIEEt
[» e Primary Image
b Bl Product References
[» [°-)Classification References
[» CAEntity References

[T Delete Mo Content
[T Keep With Nesxt

Colmt:l LI

Frame Type: I j

" Import Asset at Scale

{* Scale Asset to Frame

{~ Fit Asset to Frame Width
™ Fit Asset to Frame Height
[ relultil szt Scrozs

[T Size Frame to Asset

Gap: |
Alignment: Il_eﬁ |

The system automatically displays the valid choices for the image frame setup.
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3. Optionally, you can set a range of parameters (lower half of the STEP Template Palette tab) to control how
your image frame is referenced into the product template.

For more information about the individual parameters, see "Description of the InDesign Interface" on page 14.

Creating Product Templates Containing Galley Text

The procedure of creating a product template containing galley text is the same as if creating any other product
template, except that it can only have one text frame defined. You can link as many attributes into the text frame as
desired. See the Galley Product Templates section of the Flatplanner documentation for more information.

Creating Layers

When creating a product template it is possible to work with more layers, e.g you can create a text / language layer
and an image layer if you want to separate your images. This is useful in case you want to create catalogs in
different languages but use the same images for all of them.

To create a new layer, do the following:

1. Ensure that the relevant product template is opened.

2. Click the Layers tab, expand the Options menu, and then click New Layer.

A New Layer dialog box appears.

Mame: [Images Lok |
Color: |.Red _ﬂ Canicel I

W Show Layer W Shiow Guides

™ Laock Layer [~ Lock Guides

W Print Layer

[T Suppress Text Wrap When Layer is Hidden

3. Inthe Name field, type a name for the new layer, e.g. 'Images,' and then click OK.

4. You now create the relevant frames, determine frame content, link STEP data etc. as previously described in
this section.

Important: When creating different layers in a product template you must remember to map the layers in the
publication. If the layers are mapped correctly, the elements will automatically be placed on the defined layers
when mounting products. For more information about creating publications and layer mapping, see the STEP
User Guide.

Product Template Layout and Formatting

After creating a product template and defining which elements (attributes, images and other elements) should be
part of your product template, it is possible to define how the data should be formatted once it comes across to the
InDesign page, hereunder:
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+ How to apply style name to the content or frame.

« How to position text and image frames within the product presentation.

Below you will find information about how to apply style names to content or frame and how to position and group
frames on the product template.

Applying Style Name to Content or Frame

In your product template you can have several text or image frames. To make these frames and their content
appear in a certain way you must define style names on your template and apply them to the frames.

Note: Ensure that styles—with corresponding style names—are defined in the publication template. You can also
define all styles in the product template and then load them to the publication template—or vice versa (When
using STEP Flatplanner the styles must be defined in the publication template). Defining styles in a product
template is identical to the procedure of defining styles in a publication template. For more information, see
"Publication Template Layout and Formatting" on page 82.

To define the style names do the following:

1. Create the needed style name, either:

« paragraph style name (to format contents of a text frame)

Note: The process of applying style names to STEP content is case-sensitive, therefore you must be familiar
with the 'tag' naming in STEP in order to use paragraph styles successfully.

« or object style name (to format image or text frame)

2. Select the relevant content/ frame and then apply the created style name on it.

Positioning Text and Image Frames
The STEP’n’design product template also enables you to position the individual frames, effectively enabling you to
assign a layout to the general product page presentation.

For some publications, this functionality means that you can build templates in such a way that a product can be
mounted onto the page with a perfect or near-perfect layout. You can even build multiple templates, and when
mounting, you can select the template most appropriate for the kind of catalog you are building

Positioning Frames
Once you have built a product template with some image and text frames, you can determine their position-
relationship (i.e. distance between the individual frames) by simply moving or sizing the frames.

The distance between the elements in the product template will be kept, when a product is mounted to the page
using that template.

Note: When organizing and positioning your frames, you can use standard InDesign functions such as aligning,
grouping and rotation.
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Grouping Frames

When the product template has been built with all needed frames containing products, tables and images, it is
possible to group the frames.

To group frames do the following:

1.
2.

Multi-select the relevant frames by holding down Shift button and clicking on each frame.

In the Object menu, click Group (you can also just press Ctrl G on keyboard if using a PC, or Apple G if using
Mac) to group the frames.

In the Item menu, click Group (you can also just press Ctrl + G on keyboard if usinga PC, or Apple + G if
using Mac) to group the frames.

Clicking a grouped frame will enable options in the STEP Template Frame palette, where you can specify
from where the template contents should be mounted.

% STEP Template Frame E
<STEPREF A="stibo.pseu-
doObjectName” /> [ Delete Mo Content
____________ P e e B With Next
I YA vET ot iigee Y e
i i [ align Mount Eottom
Spiit | | v
Dats Source | Mount Object v |
':j o Data Filter | | ¥ |
E E D Tile across
| Max Distance | |
=3 1eEPREEF A="Caption1™ 7=
s S o O Gap | |
Group Align |Distanua1n Left Edge | = |
Product Template

For more information about the individual parameters, see "Description of the InDesign Interface" on page 14.

Storing your Product Template

Once you have created a product template, you can:
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« Store the product template on your own hard drive and use it for mounting products from your own
computer.

« Upload the product template to STEP, which means that other users can use of the template, and that the
template can be used with STEP Flatplanner.

Storing Product Templates Locally
To store a product template on your local computer:

o Saveitasanormal InDesign file into a directory or folder on your own hard drive.

Note: To be able to use the Product template for page mounting, remember to set the Template Path in the
Preferences dialog box (Preferences command in the STEP menu).

Storing Product Templates in STEP
To store the template in STEP database:

1. Save the InDesign document on your local hard drive as a standard InDesign file (suffix .indd).
2. Inthe STEP menu, click Save Document to DB.

A Save Document to STEP Database dialog box appears.
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Save Document to STEP Database

Structure Point

b [ |suppliers

# [ CJUNSPSCL4C

b [ JunsPsCi7

P [ JUNSPSCi8

b [T Entity Root

» apsn

b ! GDSN Receiver

b (O] GDSN Receiver Root

¥ ) promations
v B publications
- ﬁTETFlH‘E
2 ﬁnuhltm Templates
| 3 ﬁnmducnemlatp_r.
2 ﬁpagETEmla‘hﬁ

3 ﬁ‘.—'riandard Publications I

2 ﬁ.ﬁ.umpage Publications
3 ﬁ Flatplanner Publications

Min Max
Width | 2.260n |
Height  [2.82in | [2.82in |
|Save As Product Template | v |

[ Close document and delete local copy

| oK | | cancel |

3. Select a publication group you want to save the document to, and then click Save as Product Template from
the list. This way you keep publications and relevant templates together.

Clicking Save as Product Template will make the product template selectable for other STEP users.

Note: If you want to create a new publication group for your templates, you must do soin STEP.

4. Optionally, you can specify a Minimum and Maximum value for the product template's dimensions by entering
the values in the Min/Max value fields for the Height and Width dimensions. The Min/Max dimension values
can be used in Pagination rules. For more information on Pagination Rules, see Pagination Rules for
Flatplanner in the Flatplanner documentation and About AutoPage Pagination Rules in the AutoPage
documentation.
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Note: The Min/Max value fields for the Height and Width dimensions are prepopulated based on the
dimensions of the total content of your product template. These values can be overridden by entering new values
in the fields.

5. Click OK. The product template is saved in STEP.

Creating a Table of Contents Product Template

Product templates that mount tables of contents in publications can be created in STEP'n'design. Tables of
contents typically appear at the beginnings of publications and/or sections and can be mounted manually using
'drag and drop' operations, as well as automatically using AutoPage. These tables of contents can also be thought
of as section indexes, as their intent is to alphabetically list the STEP names of all sections that appear within an
entire publication and/or the names of all subsections that appear within a section.

Product templates designed to create tables of contents / section indexes utilize tagging that mounts the following
information:

« STEP names of the child sections and subsections of the publication

« Values from calculated description attributes that pull in the first and last page numbers of mounted pages
that are saved into the publication's sections and subsections

In addition, paragraph styles are set up to insert dot leaders between the section names and the page numbers.

The following screenshot shows an example of a table of contents mounted from a publication object:

lGarden Tools ... w4-13
Weed Trimmers.... A4-13
Electric ....u.. 7-10
Gas Powerad.....ccvveveenn 11-13

] 0 LS 15-21
ADNESIVE REIMIOVETS. . csesrieessessirsressessssseneessessnssssssessrsssnesssssssnsssssssnmnsssssssssrssssessssasnsssssssnnnnes 1O-21
POWET TOOIS ciiirusrisnssmsssissssmsmsrssassssisnssssssmssrssss s s s nesnsssssas s nnes 22-21
a1 (= 14-15
HEM HEES .ovveiieccisieeessscsmssssnssssssssessssssssssssssrsesssssssnnssssessessrsssssssssnnnssssensannsssesssssnssessssssonesssl 0]
Safety EQUIPITIENT ..ot ceeeceese i s s sssssse s s e rss s sa e ssnsssnmmssssssssssssssssanssssssassssnssssnnnnns 14715
L == S UPT SR SUPOPPRPRRRPRRORRN § o |
TOOIDOXES ..oieevrarsssrarsnsssnrarsssssarsnsssssanssssssnssnssninnsasssssasnansssnnsnssnsssnsnnssnsansnns 2-3

This topic explains the steps involved in creating the page number calculated attributes, the required tagging for
the product template, the InDesign paragraph styling needed to insert dot leaders, and instructions for mounting
the table of contents once the product template is configured.

This topic explains how to mount a table of contents using standard STEP'n'design functionality. For instructions
on how to mount a table of contents using AutoPage, see the Creating Tables of Contents in AutoPage
section of the AutoPage documentation.
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Note: Names of sections and subsections are mounted in alphabetical order in tables of contents / section
indexes.

Configuring Page Number Calculated Attributes

Two calculated Description attributes must be created and made valid on the section object type(s) that you are
using in your publication. One of these attributes should pull the first page number in the section and the second
attribute should pull the last page number in the section.

To create these attributes, follow these steps:

1. Create a Description attribute by the same method that you would create any other description attribute. (See
the Creating Attributes section of the System Setup / STEP Super User Guide documentation for more
information.) Give it a name that indicates what it is used for, e.g., FirstPageNumber.

2. After creating the attribute, right-click in the Value template field on the Attribute tab and select Edit
Function. The Function Editor displays.

3. ClickInsert Template, then expand the Publishing Functions section of the Default Templates.

4. Select'Find the first page number in the section’ and click OK. The Insert Template window closes.

£33 Insert Template @

E-Default Templates Description

E-Conditional Functions Returns the first page number in the section.
F-Text Functions
[-Attribute Value Functions
F-Mumber Functions
[+-List Functions
E
E
E

+Reference Functions

+-Hierarchy Functions

#-All Functions

=+Publishing Functions
~-Find the first page number in the section]

Find the last page number in the section

----- Find an attribute value for an offer in a location

--Find the value of a commercial list and breakpoint in a location

----- Find an attribute value in the publishing (green) hierarchy

“-Get the publication of the current page or section.

Template
o« 111 p | |sectionFirstPageNumber() |

’ 0K H Cancel |

5. No additional action is needed in the Function Editor, so click OK to close it.

6. To create the second calculated attribute—which will pull the last page number in the section—the steps are
identical to 1 - 5 above, except in step 4 you will select 'Find the last page number in the section.'

Note: Calculated attributes related to publishing functions cannot be tested in the Function Editor, as publication
hierarchy [green] objects are not among the available options when selecting an object as the Evaluation Node.
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7. Onthe Validity tab for each of your attributes, check the Section box to make them valid on the desired section
object types.

System Setup FirstPageNumber - Validit
‘53 Metadata Profile || Log || State Log || Tasks

F-£3 Asset Metadata

B1-E3 Link Metadata Atfribute I References “ Atfribute Transfor
=-£3 Publication Metadata = Valid for Product Types

-[IT catalog Group Theme —— || @ valid for Classification Types

~[I Catalog Theme ‘5 - Valid for Asset Types

[T Circulation ||| = valid for Entity Types

~[IT cover Photo Shot Due

- |F Effective Date % Valid for Publication Types

-[IT Expiration Date [l An

+ 14 FirstPageNumber [ Publication

-[| FlatplanwF_DTPOperatorGrou

-[IT FlatplanwF_IDs [ ] Publication group types

-[|T FlatplanwF_MerchandiserGroL
-[I Get Inherited Pub Group Value
-(| Get Inherited Publication Value & valid fBFVETSIDI‘IT)'p&i

8. When actual pages have been saved to STEP into your section, the calculated attributes will display page
numbers as such:

_ Tree €  Weed Trimmers - Publication Section
-l Zeta Tools 2017 + ||| Page Inspector || Status || State Log || Tasks

@ Beta Tools_Section TOC Financial Summary AutoPage Publication Planner || Pagin

= - Beta TUU|S_F’!..Ih|ICE|tIUI"I Toc Publication Section [ Plan “ Publication Planner ”_
% Commercial Data

-8 Toolboxes * |Path Publications/Autopage Publications/B
=@ Garden Tools
-2 Weed Trimmers

W

Start section on page 1

W

Mail Date (same as Effe

- | 20-68204

E 21033 » Total Number of Ttems 122
E 555-22346 » [Effective Date
~ {8 RP4100 > [Expiration Date
- 22196 B :

E L23-RP4100 * |Section Theme abe:
- | 20862 * |Circulation 123

B[ Electric > |Cover Photo Shot Due
@8 Gas Powered =
=, =) ﬁ
+ B DTP Documents FirstPageMumber #
#-El DTF Documents « || LastPageNumber A 13

Configuring the Table of Contents Product Template

A product template intended to mount tables of contents will look similar to the following example. (Note that text
styles, colors, etc., are completely configurable to individual user needs. This is only a sample for illustration
purposes.):
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Toc Index

<STEPREPEAT NF="Limit to Section Object Types™ RS="\n" ><STEPREF A="stibo.
yseudoObjectName” [> .... <STEPREF A="FirstPageNumber” />-<STEPREF
A="LastPageNumber” />
<STEPREPEAT NF="Limit to Section Object Types” RS="\n" ><STEPREF A="stibo.pseudoObjectName"” />
<STEPREF A="FirstPageMumber” />-<STEPREF A="LastPageNumber” />
<STEPREPEAT NF="Limit to Section Object Types” RS="\n" ><STEPREF A="stibo.pseudoObjectiame” /=
<STEPREF A="FirstPageNumber” />-<STEFREF A="LastPageMNumber” /></STEPREPEAT></STEPREPEAT ></
STEPREPEAT >

Note: This topic does not explain all aspects of product template creation; it merely focuses on how to create a
product template to mount a table of contents. For more general information on creating product templates, see
the Product Templates section of the STEP'n'design documentation.

The sample pictured above is designed to mount three levels of subsections by using the Repeat Options
available in the STEP Template Palette. The following text is the content that appears in the above screenshot:

<STEPREPEAT NF="Limit to Section Object Types” RS="\n" ><STEPREF A="stibo.pseudoObjectName” />
<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” />

<STEPREPEAT NF="Limit to Section Object Types” RS="\n" ><STEPREF A="stibo.pseudoObjectName” />
<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” />

<STEPREPEAT NF="Limit to Section Object Types” RS="\n" ><STEPREF A="stibo.pseudoObjectName” />
<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber”
[><ISTEPREPEAT></STEPREPEAT></STEPREPEAT>

To set up this tagging on a product template in InDesign, follow these steps:

1. With your product template open, open the STEP Template Palette by navigating to Window > STEP
Template Palette from the application bar across the top of the InDesign interface. Make sure that Product
Template displays in the Template Type dropdown menu at the top of the palette.

2. Using the InDesign Text tool, draw a text frame to the width that you would like your table of contents to
appear.

3. Dragthe Object Name 'pseudo attribute’ into the text frame. Object Name is located in the Object Properties
folderin the STEP Template Palette. Object Name will be used to mount the STEP names of the sections and
subsections in the publication.

 STEF Template Palette 5 =
Templste Type  Product Template -
[ (5 Artribute Groups "
=+ [£5) Object Proparties
STEPREF A="stibo.pseudoObjectName” /># 5 Asset Contan

111

DI Anribute valee
DI Esport dats
18 Keyee
(I otjexr 1D N
|| Object Name
[» 53 Commercial Types -
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4. Drag the attribute that you are using for the first page number into the text frame directly after the Object Name
tag.

& STEP Template Palette =

Templztz Type  Product Template -

T -
4'-...-t' [+ (1T FlatplanWF_DTPOperatorGn

[+ [J3 FiztplznivF_10=

I [IF FetplanWF_MerchandiserGre

’STEPREF A="stibo.pseudoObjectName” [><STEPREF A="FirstPageNumber" />#

5. Drag the attribute that you are using for the last page number into the text frame, directly after the first page
number tag, then place a hyphen between the two tags.

_SI % STEP Template Palette 5

< il

Templste Type  Product Template

e [+ []3 Get Inhesited Publication Val .

[13 et Inhesited Saction Vahe

="stibo.pseudoC
="LastPageNumber” /=

[» DI Mail Date (same as Effective

6. To setup the dots (dot leader) between the tags for the section name and the first page number, follow these
steps. (Note: This dot leader should be added to your paragraph style so you can reuse it later if needed.)
« With your text frame selected, navigate to Type > Tabs in the InDesign application bar. The Tabs dialog will
display at the top of your text frame.
« Click the right tab icon, then click anywhere on the ruler to apply the right tab.

Tabso

£ + 3+ xjz7in Lesden Align O,

E 1lﬁ
|{:I [ |1 L.l |2 m. |3 [ |4 T B | |5 [ |6 T B | |? 1 ||

'iTEPREF A="stibo.pseudoObjectName™ /><STEPREF A="FirstPageNumber™ />-<STEPREF ‘ |

4
1}

="LastPageNumber” />

« Click the tab symbol that you just placed in the ruler, then hold down the left button on your mouse and drag
the tab symbol to the far right of the ruler until it aligns with the right edge of the text frame. (The edge of the
frame will turn green if you have Smart Guides turned on in InDesign.)

Tabs

+ 4+ + X|7.5in Lesden: Align On: =
E:' i 2 t 3 [ 5 = 7 |

| [ | L.l | [ | [ | T B | | [ | T B | | 1 ||

TEPREF A="stibo.pseudoObjectName™ /><STEPREF A="FirstPageNumber™ /[>-<STEPREF
="LastPageNumber” />

© Stibo Systems - Confidential 75



StiboSystems

« Place a period in the Leader box, then click X to close the Tabs dialog.

Tabs o e =]

£+ A H Leader:|, Align O

E 1lﬁ
|{:I [ |1 L.l |2 [ |3 [ |4 T B | |5 [ |6 T B | |? 1 ||

TEPREF A="stibo.pseudoObjectName” [><STEPREF A="FirstPageNumber” />-<STEPREF
="LastPageNumber” />

7. Using the text tool, place your cursor between the tags for the section name and the first page number, then
press the Tab key. The dots will appear between the two tags.

.

'iTEPREP A=Tstibo.pseudoCbjectName”

- |«:LTEPREF A="FirstPageNumber™ /><STEPRE
="LastPageNumber” /=

8. Next, using the text tool, highlight all content in the frame. On the STEP Template Palette, type \n into the
Repeat Sep. (repeat separator) field. (The repeat separator is the string or character that will be placed
between each repeated entry. \n is the symbol for hard return.)

Then, click the Options menu in the upper right corner of the STEP Template Palette and click Repeat
Selection.

| 8 ¢ STEP Template Palette T

Apply Condition to aect'on

Template Type  Product Template - -
Repeat Selection

Repeat Options ...
[+ ] M=il Date (s2me 25 Effentive
D [T Object Narme = v Show Adormnments

b []T section Theme Group Alignment r
[ [1T Totzl Number of Ttems
I:‘I}ale‘he Mo Content

STEPREF A="stibo.pseudoObjectName” /=
A="LastPageNumber” />

|:| Keep With Next
Contest: -
Object  W* -
Dielete Bafore
Delete After
Fail Tem
Price Number

Transformation

Repeat Sep. |'n
Split:  Maver -

9. With the text still highlighted, click on the Options menu again and select Repeat Options. In the Set Repeat
Options dialog that displays, choose Limit to Section Object Types from the Node filter dropdown list,
then click OK.
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Set Repeat Options
First Line Style: [Mo Paragraph Style] -
0dd Line Style: [MNo Paragraph Style] -
Even Line Style: [No Paragraph Style] -
Odd Last Line Style:  [Mo Paragraph Style] -
Even Last Line Style: [Mo Paragraph Style] -
I Node filter: Limit to Section Object Types I -
[ 0K ] [ cancel |

10. Your tagging should now look like this.

stibo.pseu oL -

TEPREPEAT >+

11. Copy and paste the tagging into the same frame two more times. This will enable the product template to pick

up section names and page numbers from two additional levels of subsections. Your tagging should look like
this:

STEPREPEAT NF="Limit to Section Object Types” R5="\n" ><STEPREF A="stibo.pseudoObject-
Name” />-<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /></STEPREPEAT

STEPREPEAT NF="Limit to-Section Object Types” RS="\n" »<STEPREF A="stibo.pseudoObject-
Name” />-<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /></STEPREPEAT
STEPREPEAT NF="Limit to Section Object Types™ RS="\n" ><STEPREF A="stibo.pseudoObject-
Name” />-<STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /></STEPREPEAT

12. Cutthe two </STEPREPEAT> end tags from the end of the first and second paragraphs, then paste them at

the end of the last paragraph. There should now be three </STEPREPEAT> end tags at the end. Your tagging
should look like this:

STEPREPEAT NF="Limit to-Section -Object Types” R5="\n" ><STEPREF A="stibo.pseudoObject-
Name”™ />...coernitornesennenewne <STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /=
STEPREPEAT NF="Limit to Section Object Types™ RS="\n" ><STEPREF A="stibo.pseudoObject-
Name” />..ccmermerniireesneenewne <STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /4
STEPREPEAT NF="Limit to Section Object Types™ RS="\n" ><STEPREF A="stibo.pseudoObject-
Name” />....coeeceeeiireevneenewne <STEPREF A="FirstPageNumber” />-<STEPREF A="LastPageNumber” />
/STEPREPEAT></STEPREPEAT ></STEPREPEAT>#|

13. Apply styling (e.g., font size, text bolding, paragraph indents) as needed to differentiate the three levels of the
TOC. For example:
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14. Next, test your product template to ensure that it has been set up correctly.

<STEPREF A="FirstPageNumber” />-<STEPREF A ="LastPageNumber” /=]

StiboSystems

="stibo.pseudo-

bjectName” /> {STEPREF A= FlrstPﬁgeNumber” = =:STE PREF A="LastPageNumber” /
<STEPREPEAT NF="Limit to-Section Object Types” RS="\n"><STEPREF A="stibo.psendoObjectName” />

<STEPREPEAT NF="Limit to-Section Object Types” RS="\n" ><STEPREF A="stibo.psendoObjectName” /> ... <STEPRE
A="FirstPageNumber” />-<STEPREF A="LastPageNumber” /=</(STEPREPEAT></(STEPREPEAT =< /STEPREPEAT ==

Mounting the Table of Contents Product Template

The TOC product template can be manually tested in InDesign by dragging the desired publication object from the
STEP Structure View panel and dropping it onto a blank InDesign page (or a publication template).

To test the TOC product template, follow these steps:

1.

With your blank document / publication template open in InDesign, locate the relevant publication in the STEP

Structure View panel.

Make sure that your TOC product template is displayed in the Template dropdown at the bottom of the STEP

Structure View panel.

Left-click the desired publication, then hold down the mouse button as you drag the publication onto the page.

Release the mouse button in the upper left corner of the page.

& STEP Structure View | § 5 5 5

4
1[1

[¢ [T]wieb Si=s

[» [Entity Root

> Ol GosN

> (O] GDSN Recsiver

[ [E Promotions

- @ Publications
[ @Templam
[ B Standard Publications
~ @ Autopage Publications

B
B
7
7
7
>
;

Arme Toolks

Zetz Took 2016

Acme Tooks 2017_AP Doc Level 3
Acme Tooks 2017_AP Doc Level 1
Zeta Took 2017

Betz Took_Section TOC

[ Beta Tooks_Publication TOC

V3 @ Flatplanner Publications
[ B webUIPublicationTypes
[ B TempweblUTPublications
[» [T Primany Product Hierarchy

I Template:

TOC Prod Template,indd I

»

111
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4. The table of contents will mount and should look similar to the following:

T TN T

Weed Trimmers
Electric i
Gas Powered........

IGLOWVES woeiiiuiiminmisissssrsimsssssssssnnmsssssssssnssssssssnmassssssassnsmnssssssssessssssssss sassenmsnnssssesssrssnsssnssassnsmssns
Adhesives

A EEITE BLETIOVETE 1o tieseieesiaesiass e et imassss bt st 5 4444444545040 £841 4515041541 4504501454 454204250 284204 011
POWEE TOO0S.cciiiiiiiicsiiiisnessssssisssnsssssssss st s sesrssse s samssrssae s e s bbb 0408008 SbmeE S e b 88 se s s bmmrd s

Hand Toaols
L PP PR 14-15

Safety Apparel

Safety Equipment

FLATEE 1.ttt £ £ 4££4 1544141 5416841 454 4544880 4545440 10 L e
ITODLDOKES 1 vrveeererissacsenrisee st rissss s e s asssse b s bs st e st sarasm b ans e snt e rrass st eo b erabaambesassasnnsennssans sanermansnsen
Mails and Screws
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Publication Templates

This section describes how to create a publication template (which is a standard InDesign document), how to add
graphical formatting to the template, and how to store the template locally and/or in STEP.

The publication template is the InDesign document that is used when mounting product data. A publication
template defines the document size and contains information about styles to be used from the product template.
The publication template must contain all styles (paragraph styles, object styles, character styles, swatches - ID
colors - and line styles) that are used / defined in the different product templates you have created. Furthermore, it
must contain the same layers as used in the product template (if working without STEP Flatplanner or STEP
AutoPage). A publication template is used to create the PDF files of your pages.

Publication templates are required in a certain capacity whether you use 'standard' STEP'n'design (‘drag and
drop') publishing, STEP Flatplanner, or STEP AutoPage. If you choose not to create a publication template but
just to mount product data on an empty InDesign page, this page is considered the publication template.

Note: Before a publication can be created in STEP, a publication template must be saved to the STEP
Workbench.

Creating a Publication Template
1. Open InDesign, from the File menu, point to New, and then click Document.

A New Document dialog box appears.

Mew Document i

Docurnent Preset: | [Custorn] j (0] 4 I

Murnber of Pages: |1 ¥ Facing Pages Cancel |
[ Master Text Frame

Save Preset... |

— Page Size: I.-'l'-.4 j

wiith: [H49p7,276 Orientation: | (] [
Height: E?Dp 1,89

— Colurmms

urnber: El Gutter: 1p0

— Margins

Maore Cptions |

Top: 3p0 _ Inside: 3p0

I
Bottom: F={3p0 Dutsice: EBpD
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2. Define the settings for the document: page size, columns and margins.

3. Checkthat the Facing Pages check box is selected to create a spread.

When using STEP Flatplanner it is recommended to create the publication template as a spread.

4. Click OK.

A new empty document is created. You now need to define publication template layout and formatting.

Note: A publication template can consist of several spreads, a spread for each section, e.g. containing different
thumb tabs for each chapter in a catalog. To use a specific spread in a publication template, you must define a rule
in STEP AutoPage or in STEP Flatplanner that points out a spread in a publication template document. For more
information about Pagination Rules in STEP AutoPage, see "About Pagination Rules" in the STEP AutoPage
User Guide. For more information about Pagination Rules in STEP Flatplanner in the STEP Flatplanner User
Guide.

Creating Layers

Note: If working with STEP Flatplanner and using a Multi-Version license, you do not create layers in the
publication template as described below, as you only need to mount one version and then the other versions in the
same publication will be mounted automatically (provided that layer mapping has been performed correctly for
each version). If you have a single version publication, then you do not need to create layer mapping. The layers
from the product template will be copied across to the output page when mounting.

When creating a publication template it is possible to work with more layers, e.g you can create a text/ language
layer and an image layer if you want to separate your images. This is useful in case you want to create catalogs in
different languages but use the same images for all of them.

To create a new layer, do the following:

1. Ensure that the relevant publication template is opened.

2. Click the Layers tab, expand the Options menu, and then click New Layer.

A New Layer dialog box appears.

Mare; ;Images L_E_IJ_K_l
olor; |.Red _‘J Cancel I

V¥ Show Layer ¥ Show Guides

[~ Lock Layer ™ Lock Guides

W Print Layer

[T Suppress Text Wrap Wwhen Laver is Hidden

3. Inthe Name field, type a name for the new layer, e.g. “Images”, and then click OK.
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Publication Template Layout and Formatting
You can apply layout and formatting to the publication template either by:

« Defining all the styles being used in your product templates in the publication template. Generally, you use
standard InDesign formatting features, such as font face, size, color, style, frame border to format the
document.

Note: Itis recommended to organize graphical formatting using InDesign paragraph styles, object styles,
swatches, and line styles as these styles can be updated globally, thereby providing you with a more flexible
solution.

« orbyloading all styles (paragraph styles, object styles, character styles, swatches - ID colors - line styles and
table styles) from each product template you have created.

Note: The publication template must contain all styles used on the relevant templates. Ensure that the naming of
the styles defined in the publication template is identical to the style naming in the templates.

Formatting Document Using Styles
In your product template, you can have several text or image frames. To make these frames and their contents
appear in a certain way on your output page, you can add graphical formatting to your publication template using:
« Paragraph styles (to format contents of a text frame): mandatory if mounting STEP tables
« Object styles (to format image or text frames): user preference, not needed at all to work with STEP
« Swatches and line styles (to format tables): mandatory if mounting STEP tables

Standard InDesign features are used when creating paragraph styles and object styles. Make sure that the
naming of the styles in the publication template is identical to the style naming on the product template. If styles
used in the product template are not defined on the publication template, then the styles from the product template
are copied to the publication template.

For more information on how to create and configure paragraph styles, swatches, and line styles in publication
templates, see Configuring Table Styles in Publication Templates in the STEP'n'design documentation.

Storing Your Publication Template

Once you have created a publication template, you can:

« Store the publication template on your own hard drive and use it for mounting products from your own
computer.

« Upload the publication template to STEP, which means that other users can use the template.

Storing Publication Templates Locally
To store a publication template on your local computer:

o Saveitasanormal InDesign file into a directory or folder on your own hard drive.
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Storing Publication Templates in STEP
To store the publication template in STEP:

1. Save the InDesign document on your local hard drive as a standard InDesign file (suffix .indd).
2. Inthe STEP menu, click Save Document to DB.

A Save Document to STEP Database dialog box appears.

Save Document to STEP Database

Structure Point

[» [[T]Asset Placeholders ;l
[ [0 Configurations
[» [[Z)Image Hierarchy
[» [15ample Data
[z [[Z)Suppher Portal
= (&l Publications
= [E Stibo Area
= ﬁT&mpla‘lE
- ﬁlnDEign

- Fr-_T Master Doouments
[ % 7IFstPlanPub
[+ */z|STEPnDesign Master
» [ Page Templates
> & Product Templstes
[ [0 Quark
[» [l stibo Spring Edition

[+ [C2Primany Product Hierarchy

| Save As Publication Template |
[T Close document and delete local copy
| oK | cancel |
&

3. Select a publication group you want to save the document to, and then click Save as Publication Template
from the list. This way you keep publications and relevant templates together.

Clicking Save as Publication Template will make the publication template selectable for other STEP users.

Note: If you want to create a new publication group for your templates, you must do so in STEP.

4. Click OK. The publication template is saved in STEP.
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Configuring Table Styles in Publication Templates

In order to format STEP Tables on InDesign pages, a parallel set of formatting configurations must be created in
STEP and InDesign for the following:

o Colors (used both for rule lines and background shading)
e Rulelines
o Textstyles

In STEP, these configurations are the Colors, Rules, and Style Tags created on the System Setup tab. The
corresponding configurations in InDesign are swatches, line styles, and paragraph styles. The InDesign
configurations are created in the InDesign publication template that will be used to mount (generate) tables in
InDesign.

This topic deals only with the table formatting definitions created in publication templates. Full details on how to
configure the corresponding definitions in STEP are outlined in the Creating Table Formatting in System
Setup section of the STEP Tables documentation.

Example of Styled Table in STEP

The following screenshot shows a styled table in STEP as it appears in the STEP Table Preview. The background
colors, rule lines, and text styles have been applied using the settings created in System Setup. In order for the
table to appear with the same colors, text styles, and rule lines in InDesign, the corresponding settings must be
created in the publication template.

Note: If no styles are defined for the table in STEP, the table will be mounted in InDesign with basic InDesign
paragraph styling, and the table must then be styled manually using the standard InDesign table editor. Manual
styling of tables on InDesign pages is strongly discouraged, as formatting not connected to STEP is easily lost
when tables are updated.
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Definition m

Select version iAcme Party Supplies/English US viSeIect Preview Mode
Product Name Part No. Image Product Name Price
Chriztmas Party Hat 121184-A o Christmas Party Hat 5759
Cosmic Party Hat 121177-A Cosmic Party Hat $3.99
3

Pink & Green Party Hat 121171-A Pink & Green Party Hat $2.99

Pink & Green Pem-Pom Hat  |121193-A Pink & Green Pom-Pom Hat  |32.59

Political Party Hat 121192-4 Pelitical Party Hat §17.76
* | * [Transformation » |Parameters »
> Alternate Row Colors Color 1 rows "White" then 1 "Light Blue". Restart count after...

* |Add Transformation

Configuring Table Colors in InDesign
Colors defined in STEP are configured in InDesign as Swatches, as follows:

StiboSystems

1. InInDesign, navigate to Window > Color > Swatches (or press F5). The Swatches panel displays.

% Swatches |

Iﬁn =T Tint: k%

] ene] 7
W [Registration] 7
[ (Peper

| EEES] 7

[ c=i00 M=0 Y=0 K=0
B c=0M=100 Y=0 K=0
[] ©=0mM=0v=100 K=0
B c=15 M=100 Y=100 K=0
] c=75 M=5 v=100 K=0

B c=100 M=50 ¥=10 K=0

A Al q

2. Click the Options menu in the upper right corner of the Swatches panel, then click New Color Swatch.

3. Onthe New Color Swatch dialog, deselect the Name with Color Value check box, then type a name in the

Swatch Name field.

Note: The name of the swatch must be identical to the corresponding color created in STEP. Names of colors

and swatches are case sensitive.
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Swatch Options
Swatch Name: |Light Blue
[ Name with Color Value
Color Type: Process -

Color Mode: CMYK

Cyan Loy —

Magenta g— ———
Yellowgy 0y

BRck ey —

10

Y%
Y%
Y%
Y%

Cancel

Preview

4. Adjust the color values as needed, then click OK.

Loading Swatches From Another InDesign Document
To load swatches from another InDesign document:

StiboSystems

1. Inthe Swatches panel, click the Options menu, and then click Load Swatches. An Open a File dialog box

displays.

2. Navigate to the InDesign file that contains the swatches that you would like to import, then click Open. (This file
does not have to be another publication template; it can be any InDesign document.)

3. The Swatches from the selected InDesign file will automatically import.

Configuring Table Line Styles in InDesign

Rules defined in STEP are configured as table Line Styles in InDesign via the STEP > Table Settings menu.
Line styles govern the lines (‘borders' or 'rulers') that appear between cells and/or surround the table.

To create line styles in the InDesign publication template:

1. Navigate to STEP > Table Settings. The Table Settings dialog box displays.
2. Click Add in the lower left-hand corner. The New Line Style dialog box displays.
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Table Settings
Drefault Inset
Left 0in Above 0in Right 0in Below 0in
Style Name Line Weight  Line Colour Line Tint Line Type Gap Colour Gap Tint Left Above  Right Below
New Line Style
Style Name 1 pt Black
Line Weight 1pt
Line Colour Black -
Line Tint 100%
Line Type L}
Gap Colour -
Gap Tint
Inset - Left
Inset - Above
Inset - Right
Inset - Below
[ ok ][ cCancal | -
Add Remaove [ Import | OK Cancel

. Populate the fields in the New Line Style dialog as follows:

« Style Name: Name of the line style. Must exactly match the name of the corresponding rule created in
STEP. Is case sensitive.

« Line Weight: Width in points. The measurement unit will always default to points regardless of what
measurement unit is being used for the rest of the page (for example, mm, inches, or picas).

+ Line Colour: Color of the line style. An InDesign swatch for the color must first be created in the publication
template before the color will appear in this dropdown list.

« Line Tint: Opacity level of the line style. Default is 100%. Value must be typed.

« Line Type: Specify whether the line style should be solid (most common) or a different style such as dashed
or dotted. The same line styles available in the InDesign Stroke panel are available in the Line Type
dropdown.
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MNew Line Style
Style Name
Line Weight
Line Colour
Line Tint

Line Type
Gap Colour
Gap Tint
Inset - Left
Inset - Above
Inset - Right

Inset - Below

1 pt Black Dashed
1pt

Black

100%

ﬂ

Thick - Thick
Thick - Thin

Thick - Thin - Thick
Thin - Thick

Thin - Thick - Thin
Thin - Thin

Triple

mmm mmm Dashed (3 and 2)
mm  mmDashed (4 and 4)
s Left Slant Hash
sy Right Slant Hash
HIRN Straight Hash

* e eDotted

StiboSystems

« Gap Colour: Only applicable for non-solid rule lines. Defines the color that goes in between the dashes,
dots, hashes, etc. The same colors (swatches) that appear in the dropdown list for Line Colour appear in the

Gap Colour dropdown. Leave blank for solid rule lines.

« Gap Tint: Opacity level of the gap color. Default is 100%.

+ Insets (Left, Above, Right, Below): How much inset space ('padding') should be placed between the
edge of a cell that is bordered by the rule line and the text or image content within the cell. If left blank—or if a
value of 0 is inserted—the insets will default to InDesign's default table cell inset, which is 4 points (or, 0.0556
inches or 1.411 mm).

Note: If you would like no inset padding at all, enter a hairline space value of .0001. The system will recognize

this value as being so close to 0 that there will be no visible inset padding.

4. Click OK when finished. Any values entered during the initial creation of the line style may be edited later if

needed.

Loading Table Line Styles From Another InDesign Document
Toload table line styles from another InDesign document:

1. Navigate to STEP > Table Settings, then click the Import button in the lower left corner of the Table
Settings dialog box.
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Add Remove

2. AnOpen a File dialog box displays. Locate the InDesign publication template containing the line styles that
you would like to import, then click Open.

3. Theline styles from the selected InDesign file will automatically import.
4. Click OK to complete.

Configuring Paragraph Styles for Tables in InDesign
Style tags created in STEP and applied to tables are configured as paragraph styles in InDesign.

For example: If the tables you are mounting from STEP contain the styles 'HeaderRowStyle' and 'BodyRowStyle',
then there must be corresponding paragraph styles also named 'HeaderRowStyle' and 'BodyRowStyle'. STEP
style tags and InDesign paragraph styles are both case sensitive and must match exactly.

To create a paragraph style in InDesign:

1. InInDesign, navigate to Window > Styles > Paragraph Styles (or press F11). The Paragraph Styles panel
displays.

Pad L=y Linl Cj ¢ Paragraph Styles || m[ = J
Normal C _'?

[Basic Paragraph]

Ballet copry

bold

Bold C

Normal_L
 Mormalc
EaoldRed

bold—BaokiRed

2. Click the Options menu in the upper right corner of the Paragraph Styles panel, then click New Paragraph
Style.

3. Onthe New Paragraph Style dialog, enter a Style Name that exactly matches the corresponding style tag in
STEP.
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MNew Paragraph Style
- Style Name: Bold Header

Basic Character Formats

Location:
Advanced Character Formats |
Indents and Spacing LEEE
Tzbs
Paragraph Rules Based On: Mormal_C hd
Kesp Crptions
Hyphenation
Justification Shortcut:
Span Colsmns
Drop Caps and Nested Styles
GREP Style Style Settings: Reset To Base

Mext Style: [Same style] -

Bullets and Mumbsring
Character Color

MNormz|_C + nest: [Same style] »

CrpenType Featunes
Undesline Crptions
Strikethrough Orptions
Export Tagging

[ | Apply Style to Selection

[] preview [ oK | [ cancel |

4. Continue configuring the paragraph style as needed, then click OK to complete.

Merge of Row / Column Style Names

In the case where a row with a style applied crosses a column with a style applied, a third paragraph style is
created when the table is mounted in InDesign. The name of this third paragraph style (sometimes called an
'intersection style') is a combination of the name of the paragraph style used for the row and the paragraph style
used for the column, connected by an em dash.

For example, a table may contain a row style called 'bold' and a column style called 'RedBold'. In the cells where
these rows and columns cross over each other, the two styles will overlap. When the table is mounted in InDesign,
the system will automatically create a new paragraph style called 'bold—BoldRed'.

Adobe InDesign @

Style not found - creating:
! %, bold—BoldRed

However, with the system not knowing which of the two paragraph styles to 'pick up,' the newly created
'intersection’ style will appear as a generic (basic) paragraph style.

© Stibo Systems - Confidential 90



StiboSystems

ﬂ |_.| |_.| §|s Paragraph Sty... |_

bold—BaolkiRed
[B=sic Paragraph]
Bullet copy
bokd
Bold_C

MNormal_L

' o orma
Price s
BoldRed
bold—BoldRed

$7.99

Note: In order to avoid the creation of 'intersection’ styles in InDesign, it is recommended to apply text styling at
the cell level in STEP Tables where an overlap will occur between row and column styles. 'Intersection’ styles are
essentially duplicates of existing styles and can cause clutter in a long list of paragraph styles.

For more information on applying formatting to STEP Table cells, see Specifying Local Cell Formatting in the
STEP Tables documentation.

Loading Paragraph Styles From Another Template

If paragraph styles have already been defined in another InDesign document, these styles may be imported from
the other document in order to save time when setting up your publication template. The other InDesign document
does not need to be a publication template that was created using STEP'n'design; it can be any InDesign
document.

To load paragraph styles from another InDesign document:

1. InInDesign, navigate to Window > Styles > Paragraph Styles (or press F11) to open the Paragraph Styles
panel.

2. Click the Options menu in the upper right corner of the Paragraph Styles panel, then click Load Paragraph
Styles. (If you would like to load both Paragraph and Character styles from the other InDesign document,
select Load All Text Styles.) An Open a File dialog box displays.
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Duplicate Style...
Delete Style...

Redefine Style
Style Options...

Clear Overrides
Convert "Normal_C" Bullets and Mumbering to Text
Break Link to Style

Load Paragraph Styles...
Load All Text Styles...

Select All Unused
Edit All Export Tags...

Mew Style Group...
Open All Style Groups
Close All Style Groups

Copy to Group...
Mew Group from Styles...

Sort by Name

Small Panel Rows
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3. Navigate to the InDesign document that contains the styles that you would like to import, then click Open. A

Load Styles dialog box appears.

Load Styles
Type| Incoming Style Conflict with Existing Style [ QK I
[Basic Paragraph] IUse Incoming Defini [ = | -
[¥| 91 Art_Caption Auto-Rename =
[#| € Art_Caption_2 Use Incoming Definition E
[+#] 9 Body_ Text
|| 9 Body:Bullet
¥ 9 Box_Text L
[ checkal | [ uUncheckal |
Incoming Style Definition Existing Style Definition

[Mao Paragraph Style] A [Mo Paragraph Style]

4. Selectthe styles that you want to load. As default, all styles are selected. Use the Check All / Uncheck All

buttons depending on your needs.
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5. Ifanincoming style conflicts with an existing style (meaning that an incoming and an existing style both have
the same name), text will appear in the Conflict with Existing Style column.

6. Choose Auto-Rename if you do not want to overwrite the existing style. Click Use Incoming Definition if you
want to overwrite the existing style and use the imported style.

7. Click OK.
8. Repeat these steps to load styles from other documents to the publication template.

Sorting Templates in STEP

The sorting of publication templates, product templates, and page templates in the STEP Workbench Tree is
determined by the Manually Sorted setting on the publication group object type in which templates are stored
(which is typically 'Publication group root').

Automatic Sorting

If Manually Sorted is set to No on the publication group object type, all template types shown in the STEP
Workbench Tree are grouped by type, with alphabetical sorting applied within each group. The default sort order is
as follows:

1. Product templates (in alphabetical order)
2. Page templates (in alphabetical order)

3. Master (publication) templates (in alphabetical order)

E}ﬁ Templates

..... @ Page Templates

[+l Product Templates

[+-{g Publication Templates

----- D Arts & Crafts Product Template
----- D Holiday Product Template

----- D Main Product Template

----- D Wedding Product Template

..... TFE 2x2

----- Tl Main Publication Template
----- Tl Publication Template
----- I Wedding Publication Template

Manual Sorting

If Manually Sorted is set to Yes on the publication group object type, templates may be sorted in a non-
alphabetical order. No additional configurations are required, as publication templates, product templates, and
page templates are not included as object types in System Setup.

© Stibo Systems - Confidential 93



System Setup

|__=| Primary Product Classification -
@‘ Product-Overrides
= (2 publication group types|
¢ =& Publication
: - (& Publication group types
- Publication section types
lﬁ‘ Publication types
[ﬂ‘ Setup Group type root
]% Tags
- Units
]tﬁa Users & Groups
EI--Bu. Reference Types
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<
References | Log |
® Descripti

Value
__

W}I

F

» ID Publication group root
ublication group types

>

Mame

>

Last edited by 2015-10-09 15:49:26 by USER

>

Mame Pattern

g I ey O sy By A |

>

>

| anually Sorted .ﬁ

ID Pattern [id]

loon

Note: Manually sorted templates still remain grouped by type (product, page, and publication) within the

publication group folder that contains them.

=} Templates

----- D Main Product Template

----- D Wedding Product Template

----- D Holiday Product Template

----- D Arts & Crafts Product Template
..... 168 3x3

..... 1FE 2x2

..... 1FE 4x4

----- [@ Wedding Publication Template
----- I Main Publication Template

----- I Publication Template

For more information about object type sorting in STEP, see the 'Manually Sorted' section of the System Setup /

STEP Super User Guide documentation.

Organizing Publication Sections in STEP

Sections and subsections in publications can be manually organized in the Tree through simple drag-and-drop
operations as long as the following object types are set to Manually Sorted = Yes:

« Publication Group (typically, the object type with the STEP ID 'Publication group root')
« Publication (typically, the object type with the STEP ID 'Default publication type')
« Section (typically, the object type with the STEP ID 'Section')
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-85 (Availability)

r_=| Alternate Classifications
-- Assets

@' Basic Object Types

’ Commerdial Types

lﬂ' Entity user-type root

%‘ Event Queue Object Types
|__=| Primary Product Classification

(-3 Product-Overrides

= (A publication group types
E]@’ Publication

@‘ Section
Publication group types
W‘ Publication section types
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Object Type References || Log

® Descripti
Mame » |Value

» ID Publication group root

» MName Fublication group types

» Last edited by

2015-04-08 14:49:13 b

> Name Pattern

* D Pattern
» Manually Sorted

[id]

_— o - e

=

> Lcon

» Dimension Dependencies

» (Catalog Group Theme

Subsections may be dragged and dropped out of their parent sections and promoted to higher-level subsections
or top-level sections. Likewise, sections may be dragged and dropped into other sections, enabling the 'demotion’

of sections to subsections.

This functionality simplifies the maintenance of more complex publications where multiple levels of organization

are needed.

The following screenshots shows a 'before' and 'after' example of sections and subsections rearranged in the Tree
through drag and drop. The 'before' image (left screenshot below) shows two top-level sections ('Safety' and
'Safety Equipment') with three subsections below the 'Safety Equipment’ section. The "after' image (right
screenshot below) shows an updated order, with 'Safety' as the parent section and multiple levels of subsections

beneath.
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Note: Sections may still be rearranged by drag and drop in the Tree if Manually Sorted is setto No on
publication group, publication, and section objects, but the sections will automatically arrange themselves in

alphabetical order.

Templates (Publication, Product, and Page) may also be manually sorted in the Tree if Manually Sorted is set to
Yes on the publication group object type. See the Sorting Templates in STEP section of the STEP'n'Design

documentation for more information.

For more information about object type sorting in STEP, see the Manually Sorted section of the System Setup /
STEP Super User Guide documentation.
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Working With Version Layers

This section describes how to work with version layers when creating publications in STEP’n’design. The STEP
database, as well as STEP’n’design, is capable of supporting multi-dimensional product data. This means that the
database can store multiple views of the same product data. Typically, these views (or 'versions' as they are
called), are modeled around specific language and country views on data. Versions could also be created to
support currency zones, vertical markets, or types of catalogs. Therefore, product data in STEP must be
organized into different versions in a publication.

This part of the STEP’n’design User Guide will explain how you can work with these different versions in your
STEP’n’design mounting and pagination process.

Note: Version layers do not apply to Page Templates.

Using Version Layers

There are two ways of working with version layers:

« Adopting layout from another version
o Using STEP Flatplanner

Adopting Layout from another Version

Note: Adopting layout from another version is not relevant if using STEP Flatplanner.

When creating new version layers it is possible to adopt the layout from another Version.

The normal workflow for working with version layers in STEP’n’design (without using STEP Flatplanner) is that
you first create your full master version layer. This means that you mount your products from your first version into
your InDesign page or spread. Then you use the features of InDesign to edit or modify the layout and appearance
of the pages and the product on the page. Only when you are happy with the way a version's pages look, you will
start creating the other version layers. Following this procedure will make it easier for you to let the remaining
version layers in a publication adopt or reuse the layout you have created on a version layer pages after mounting
the product data.

Itis possible to duplicate a version layer from the Layers tab (Window menu/F7) and then change version
afterward. This way, you keep all your formatting and layouting from one version to another within a publication
and you can mount several versions (pointing at different context) of a publication.

1. Click the relevant version layer in the Layers tab (F7), expand the Options menu, and then click Duplicate
Layer “*”.

A Duplicate layer dialog box appears.
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¢ Layers | Pages | =
o [.‘}F.'ar'u:e -
I | L

=1 | =

MNew Layer...
Duplicate Layer "USA"™
Delete Layer "USA"

Page: 2, 3 Layers

Layer Options for "USA"™...

Select Itemi{s) on "USA"™

2. Inthe Name field, type a name for the new layer, and then click OK.

StiboSystems

Note: Itis recommended to change the layer name to something that relates to the context that the version

defines, e.g. “German version”.

A Layer Version Update dialog box appears.

Layer Yersion Update

umentg ———————————————————————————— Reuise d
’-:ubh(auun: Mazter F:ubhtalmn: IMaster _I |
Layer ersion Workspace Context “ersion \orkspace ‘Context Clear Context Owerrides  Apply
Aol Master Main Global [Master <] man Global r |
[l
[~ Obtain values from transformed tables, checking for table structural changes Main - | Cwerride Yersion Workspace
™ Do not update matching DB/placed values Cancel

To have the new version layer to pick up a new context, click Layer Version Update from the STEP menu.

4. Change the version for the layers as required, select the Apply check box, and then click OK.

The content on the new version layer now changes from the content in the duplicated version layer to the
correct content as defined by the context of the new version - but the layout of the versions are identical.

Working with Version Layers together with STEP Flatplanner

A huge advantage of using the STEP Flatplanner is the possibility of mounting all your versions in one operation -
provided that you have defined the relevant layer mappings for your publication. When mounting one Version, all

the other versions are mounted automatically in new layers.
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For information about viewing the different version layers, see "Viewing Version Layers" below.

For more information about layer mapping, see the STEP Flatplanner User Guide.

Viewing Version Layers

From your DTP application, you can inspect the different versions you are mounting from, by clicking the Layers

tab (Window menu/Layers or F7). Each version has it's own layer (see example in illustration below).

|| & Layers = |
@ [ |CJcemnan version
TN

2 Lavers

Likewise, you can see how STEP’n’design knows which STEP PIM context is mounted on a layer, by clicking
Layer Version Update in the STEP menu.
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Layer ¥ersion Update

Changing Versions

To change the viewing versions in your DTP application do the following:

1. Inthe STEP menu, click Change Version.

A Change Version dialog box appears.
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2. Unfold the relevant publication, click the version you want to change to, and then click OK.

Mapping Versions to Layers
When you create a new version you must define which layer it will use.

In [Tree], unfold the Publication hierarchy.
2. Click the relevant publication and then click the Publication tab.

Under Layer Mappings, click the Versions column for the layer you want to map a version to, and then click
onthe....

A Select version dialog box appears.
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P

m Select Versions @
|| French FR
| English us
| English UK
Owner | -
’ OK ] ’ Cancel ]

4. Selectthe relevant version(s).

5. If you have selected more than one version, you must select which version should be the owner.

Note: The Owner Version is the version that will be used when mounting in the DTP application.

6. Click OK.

7. Inthe Template column, enter the case-sensitive name of the layer in the product template that you want to

map to version(s).

. Inthe Document column, enter that name you want for the layer in the DTP document created when
mounting in the DTP application.

. Tocreate more layer mappings, repeat step 1-8.
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Mounting Products

This section contains a description of how to mount products in InDesign using product templates.

Using a product template, you can mount one or several products directly to the page in one operation. If the
product template uses more layers (e.g. a text/ language layer and an image layer), then the
elements will automatically be mounted on the defined layers in the product template.

Note: Itis possible—but not recommended—to mount product data without using a product template. You then
mount STEP data one attribute at a time.

Mounting Products Using Product Templates

This section describes how to mount specified product data of one or several products directly to the page in one
operation by using a product template. It also contains information about mounting 'single' attributes—though
using a product template—in case you need to add data that is not part of the product template.

Before you start mounting data using a product template, you should check the following:
« The page you mount data onto must have settings for object, paragraph, line and color styles that your
template uses.

« A valid product template must exist and must be active when you mount data.

A valid product template can be stored either at a location on your local hard drive, or it can be uploaded to
STEP and thus stored centrally.

Note: You define whether to use alocal or a STEP-stored product template under Preferences in the STEP
menu. For more information, see "Installing STEP’n’design" on page 12..

+ Relevant versions must exist pointing out the context and workspace from which the product data must be
mounted. For more information about creating versions, see the STEP User Guide.

« If working with multiple layers in the product template, ensure that layer mapping has been performed. For
more information, see STEP PIM User Guide.

To mount products, you must do the following:

1. Open InDesign, log on to the relevant STEP environment, and then define which template to use in
Preferences dialog box (Preferences command in the STEP menu).
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To use locally stored templates do the following:

« Inthe Preferences dialog box, you must select the Template Path where your local templates are stored.
Ensure that None is selected from the Server Presentation list.

To use STEP-stored object templates do the following:

« Inthe Preferences dialog box, select the Product Default from the Server Presentation list. When
mounting products, then the product template applied the Productin STEP PIM will be used.

Note: Before you can use a default template, the product you want to mount on a page needs to have the
Default InDesign Template designated in the workbench. For more information about setting the default

template, see Online Help.

To use a combination of centrally STEP-stored product templates and locally stored templates, do the

following:

« Inthe Preferences dialog box, select the Product Default from the Server Presentation list. If you have
not selected a default InDesign Product template for the product you are mounting, then the system will
attempt to use a local product template instead.
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For information about uploading a product template to STEP and use it as default template, see "Storing your
Product Template" on page 68.

To use Publication rules validated object templates do the following:

In the Preferences dialog box, select the Publication rules from the Server Presentation list. When
mounting products, then the product template found from the validated publication rules in STEP will be used.

. Inthe STEP Structure View (if using locally stored product templates), click the relevant template from the
Template list.

Note: The selectable product templates in the list are the templates stored in the Template Path folder
(Preferences command under STEP menu).

% STEP Structure View

b [ as==t= =
b [ |Classifications

B [~ |Configurations

P [ |ETIM 5 Article Groups

P [ |ETIM & Article Groups

b [ IMerchandising Hierarchy
3 Ijﬁuppﬁers

b [TlEntity Root

» ) Gpsn

b ) GDSN Receiver N

¥ ) promations N

4 @whﬁmﬁms \
b [ |Primary Product Hierarchy
Templata:

Acme Product Temnplate.indd
Holiday Product Template.indd
Main Product Template.indd

Price Table Product Template.indd

Fit to destination | ¥

e

+— Acme Took [ English US

. Find your product in the STEP Structure View either by navigating through the classification hierarchy or by
searching for the product using the Product Search field.

. Drag the product.

If you have selected the Prompt for Version check box in the Preferences dialog box, then a Choose
Version to mount dialog box appears, when you try to drop the product into the desired location on the page.
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Click the relevant version, and then click OK.

5. Drop the product into the desired location on the page.

Note: When working with product templates you must mount (drag) the product—or product family—not the
attribute, as the product template only takes effect on products and product families.

Note: You can mount several products in one operation. Simply hold down Ctrl or Shift and select multiple
products in the STEP Structure View before dragging into page. Products will be mounted sequentially in the
column you drag them into. If product data exceeds available column space, STEP’n’design will flow datainto
next column or page. Be aware that your multi-selection must be within the same classification or product
family.

Once dropped, the product is mounted to the page, using the layout and formatting from the product template.

Attribute Mounting
In some situations you may need to mount attributes—and not just products—to the InDesign page.

Note: To mount single attributes you must have selected the Show Attributes in Tree check box under
Preferences. For more information, see "Installing STEP’n’design" on page 12..
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If not already, log on to STEP.

2. Optionally, draw a text frame using the Type tool (T).

The width and height of the frame should be the correct width / height for your future output.
Inthe STEP Structure View, find your product either by navigating through the classification hierarchy or by
searching for the product using the Product Search field.

You can mount data from either the blue product structure or the yellow classification structure - or a
combination of both.

The Product Search field allows you to search for a string of text within the name of the product or product
family.

Note: The Product Search will not search classification names or values of product attributes.

The Product Search supports the wild card operators ? and *. Product Search is not case-sensitive.

This means that a search for:
“canon * printer ?12”

will return hits on:
Canon Laser Printer 112
Canon Inkjet Printer 212

but not on:
Canon Laser Printer 1112

or:
Brother Laser Printer 112

Once you have found your product, click on the arrow to the left of the product to expand it and view the
attributes within the product.

5. Click the attribute and drag (i.e. hold down mouse button) and drop it e.g. into the text frame you created.

Galley Text Mounting

When mounting galley text and galley key letters onto an empty document it is necessary to perform the following.

1.

Ensure that you have setup preferences to use the Place in Galley option instead of the Place in Free Space
option. For more information about setting preferences, see "Installing STEP’n’design" on page 12.

To mount galley text with galley key letters you must now:
« Create the needed text frames with numbers.
+ Create the needed image frames and then mount the relevant images.

o Add numbers manually in the mounted text (galley).

Note: When adding numbers in the mounted text it is recommended to put the numbers outside the brackets,
otherwise they will disappear during update.
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Finalizing Pages and Saving Documents
If using STEP Flatplanner, please refer to "Mounting Planned Pages" for a description of how to finalize pages.

1. After you have mounted all the products, make relevant adjustments to the page using normal InDesign
functionality.

Itis possible to drag and drop additional elements from STEP (e.g. from STEP Images and/or STEP
Structure View.

2. Optionally, if you want to continue with mounting products in another version:

« Click the Layers tab (F7), expand the Options menu, and then click Duplicate Layer “*”.
« Inthe Duplicate layer dialog box, type a name for the new layer, and then click OK.

« To have the layer to pick up a new language and context, click Layer Version Update from the STEP
menu, and then make the necessary changes, and then click OK.

Products are now mounted in the new version also.
For more information about working with version layers, see "Working With Version Layers" on page 97.

3. Optionally, you can check database for updates before saving the documents back to STEP.

For more information about checking for STEP PIM database updates, see "Checking Database Update" on
page 141.

4. Now save the document. You must always save the document locally first before InDesign allows you to save
the page back to STEP.

¢ Onthe File menu, click Save.

A Save As dialog box appears.

© Stibo Systems - Confidential 108



SliboSystems

savens . I .
Save in: I d by Computer j o ﬁ I i e

14 314 Floppy (42
1 Sk (1)

Dezktol p

4

by Diocuments

File name: I j | Save |
;I Cancel |

4

Save az type: IInDesign C52 document

¥ Alwaps Save Preview Images with Documents

Use Adobe Dialag I

Indicate in which folder and under what name the file should be saved, and then click Save.

+ Tosave the page backto STEP, click Save Document to DB inthe STEP menu.

A Save Document to STEP Database dialog box appears.
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Select the publication you are working on, and then click Save Page Information from the list.

When clicking Save Page Information a thumbnail of your page as well as information regarding the page
numbers and the space allocation are saved.

Note: You can also click Save Document and Page Information from the list. This will save page
information as well as the physical page itself. This means that you can open the documents from STEP.

Click OK to save the page back to STEP within the correct publication.

5. After the pages have been saved back to STEP, itis possible to create document indexes. For more

information, see "Creating Document Indexes" on page 120..

Calculation of Space Usage

When pages have been saved back to STEP PIM, then it is possible to see which product is mounted on a page,
and how much space it uses on the mounted page. Calculation of space usage is visible in the Page Data Editor in

STEP PIM.

Note: Calculation of space usage is important to the catalog coordinator, as it makes it possible to determine if the

product has enough space on the page to make sales better.

« Unfold the relevant publication, unfold DTP Documents, and then click the page you want to see.
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9 Description

hlame

S| | Walue

= I

istibo.1 707490

= [Name

4

= |[Crested

wWed Jun 06 230518 CEST 2007

- [Status

= [Pagenumber

4

= [Whitespace area

122 |-30796.0 mm2

-
-~

Le]

= | Name

| Page Type

4013-059

4013-059

33680 mm2 \

ctual

4015-979

4015-979

3291 0 mm2 \

ctual

5007116

S007-116

35930 mm2 1\

ctual

5007129

5007129

3482.0 mim2

Actual

5009-754

5003-754

3694.0 mm2

ctual

5003-143

S003-143

[3388.0 mm2

Actual

a007-324

a007-324

34850 2 /

Actusl

5007-325

5007-325

3511.0mm2 /

Actual

a010-205

al010-205

//

e oz /

Actual

9 Images

—

The space used is per default calculated as a square around each product. Within that square, there are brackets
around each line/table/image.

Note: Space calculation can be customized. It is beyond the scope of this User Guide to cover the options for
customizing the space usage calculation.

Using the Repeat Function for Subproducts

Use the Repeat function to repeat XML tags for subproducts.

The repeat function takes effect in the cases where you are mounting a product family with one or more child
products. Using the repeat function, you can make STEP’n’design place specific attributes of the child products
into the page in 'repeat-mode’, which means that if you have children within the product family, you can have the
values for all children mounted as you mount the product family level. Effectively, this function can enable you to
display data for multiple products in a tabular way, without having to create a specific table in STEP.

As an alternative to creating a table in STEP, you can make a range of attributes repeat for any sub-products to
the product being mounted. This will enable you to create a simple, table-like structure on your InDesign page
where every sub-product has its own row.

Note: A more complex presentation is to build a STEP table, as this provides more complex formatting options.

To use the Repeat function:

1. Within the InDesign text frame, select the XML tag in which you want the repeating text. One or several STEP
XML tags can be selected.

2. Inthe Repeat Sep. field (in the STEP Template Palette panel), set a “Repeat Separator” string or character.

The most commonly used separators are \n (hard return), \r (soft return) and \t (tab).

This separator string will be placed in-between the individual product rows in the product family.
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3. Incase you want individual rows to have different styles applied:

« Inthe Options menu, click Repeat Options. A Set Repeat Options dialog box appears.
First Line Style: |
Odd Line Style: |

|

Ever Line Style:

Mo Paragraph Style]

Mo Paragraph Style]

Odd Last Line St | Mo Paragraph Style]

[
[
[Mo Paragraph Style]
[
[

Even Last Line 5 | Mo Paragraph Style]

(] 4 I Caricel

| Ll el e

Activating the “Set Repeat Options” dialog box will enable you to assign specific InDesign styles to the rows
in the table created by the repeat function.

« Define your repeat options, and then click OK.

1. Mark up the relevant tag markers in your text frame.

2. Inthe Options menu, click Repeat Selection to insert the repeat tag into your XML tag structure in the text
frame.

Creating an Index Words Structure

In order to generate and extract an alphabetical index from a publication in STEP, a hierarchy of Index Words
must first be created. These words must then be linked to the products that should appear in the index. Index
words are created in the Tree under the Index Words root node and can be linked to as many products as needed.
For example, you may need to link a product family containing chair products to two different index words—
'Chairs' and 'Furniture.' Child products within the family could further be linked to sub-levels of index words, for
example, 'Swivel chairs' or 'Recliners.’

The index word hierarchy functions similarly to a classification hierarchy in STEP. Products are linked to index
words from the product References tab, similar to how products are linked to classification folders. Index word
links are also inherited from parent to child objects.

The following screenshot shows a partial sample of an index exported from a publication in STEP:
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The next screenshot shows a section of the same index, superimposed with a portion of the index words hierarchy

Acid-free
Bookplates & Protectors....... .52
Book Tape... . . 104
Page Protectors... ... 268
Activity Centers/Mirrors .. 898 900—903
9309, 947
Activity Tables ......828-834, 872,903, 945,
951, 956
ADA Compliant
Circulation Desks ..o ..488
Desks... . 488
Signs ... 559 578-579
Tables . 450 452 476 800- 812, 814-815,
817-818, 851
Workstations 809-812, 814-815, 817-818
Address Labels .16-17, 19, 55, 57, 146, 242
Adhesive
Pockets... . 135-138
Remowers... . 116 237
Transfer Guns & Tape 112
Adhesives
Glue .o, 114-115, 119, 236-238
Mounting ... 234, 237-238, 240, 284-285,
551
Acrylic Tape ... e 114
Reusable.......... .284-285
Rubber quwd Cream Glue.. 114

that was used to generate the index:

Xapu| Pnpoid

IAcid-free
ookplates
I Page Protectors.
Activity Centers/Wi

939, 947
Activity Tables .......

851, 956
ADA Compliant

Circulation Desks ... . A88

Desks... 488

Signs ... 559 578-579

Tables. 450 452 4?6 809 812, 814-815,
817-818, 851

Workstations 809-812, 814-815, 817-818

Back Room Shelving

See Utility Shelving ........cooeeee..... 9990
Bags

See also Canvas Tote Bags ................9999

Book.......... 148, 1022-1024, 1027-1028,

1021-1023, 1036-1040, 1045, 1047,
1049-1052, 1054-1057
Browsing Tote..........148, 151, 1056-1057

Custom Imprinted e 1489
Hanging ... .. 185-189
Interhl:znrarj.r Loan... e 148-150
Library & Reading Promotion .. .. 148,

1022-1024, 1027-1028, 1021- 1i333,
1036—1040, 1045, 1047, 1049-1052,

1054-1057
Malllng L148-149
Mesh Media ..o .188
Multimedia.... 173 185 189
Plastic............ 1022 1024 1027 1028,

1021-1023, 1036—1040 1045, 1047,
1049-1052, 1054-1057

Zipper-lock. i 173
Band Daters.............................144-145
Banners

Custom .. ..590-591

Flag... 420

lerary & Readmg Promotion ..1022- 1025

1050, 1054-1055

Tree

B[] ETIM6 Article Groups
-1 ETIM Article Groups
B Index Words

B2 Acme Library Supplies
--@ Manufacturer Index

~ E-E2 Product Index

"~ B 123
\m@,q

e — = Accession Records

"--...__*El {2 Acid-free

{2 Binders

= Bookplates & Protectors

= Book Tape

‘*@ Fage Protectors
-2 Activity Centers/Mirrors

-2 Activity Tables

-2 ADA Compliant

-2 Address Labels

#-{= Adhesive

StiboSystems

When generating an index, it is possible to use InDesign’s standard features. However, for a typical STEP-
produced publication, standard InDesign functionality is not ideal as it typically requires a manual selection of index
words on each individual page. An index created in STEP, however, can generate an entire publication index with
a single STEPXML export in the 'Alphabetical Index - XML' format.
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For detailed instructions on how to export an index from a publication in STEP, see the Creating Document
Indexes section of the STEP'n'design documentation.

Creating Index Words

1. Inthe Tree, navigate to the Index Words root node, then right-click and select New Index Word.

H-[—] Assets

Index Words
Sub Products || References || Referenced By || Status [_

&[5 Configurations @ Description

(-1 ETIMG Article Groups Name > [Valua

-0 ETIM Article Groups ;

EI@ e Waords * D stibo.IndexWordRoot
== Adme[ = New Index Word | Name Index Words
-5 Acme Revision 0.1 Last edited by Stibo Systems on Fri Jan 02
B level 1 @ Export Data Below : o

B[] Merchand Approved + Approved on Fri Jan 02 00:00:00 EST 1970

&7 Suppliers| 38 cut Ctrl+X Translation Mot Translated

{7 Template Copy Ctri+C Path Classification 1 root/Index Words

F-[) Web Sites —

[]..i Entity Roa Paste Ctr+V VISIbIlItY

..... [ GDSN Biodegradable abe

&) GDSN Rec Delete KeyAttl abe

- Promotior B2 Duplicate Ctrl+) KeyAtt2 ahe

-0 Publicatio e -~

w03 Primary P Approve Object  Ctrl+Shift+) [P90 10

-3 Collection Approve Recursivel

-3 eCatalogs A .

= Recydle B Search Below

2. Inthe Create Classification dialog that displays, enter a Name for your index word, then click Create. (By
default, the 'Index' alternate classifications object type [ID = stibo.IndexWord] is configured to autogenerate an

ID by using the ID Pattern of [id].)

m Create Classification
Object Type

x5

| (@) Index

D 179684
Mame |A|

Create l [ Cancel

3. To create additional sub-levels of index words, right-click on the index word you just created (in this example,
'A'), select New Index Word, then repeat step 2. An unlimited number of sub-levels may be created.

© Stibo Systems - Confidential

114



StiboSystems

=

&3 ETIM6 Article Groups
-3 ETIM Article Groups
= Index Words

Note: Typically, an index word hierarchy intended for use with a single language will have a 'parent' level of
single index letters (for example, A, B, C). For dimension-dependent indexes, however, it is recommended to
instead use a transformation on export that extracts the first letter of each word that begins a new letter in the
index. For information on this method, see the Creating Document Indexes section of the STEP'n'design
documentation.

Using a Sort Word

In the index word editor, enter a Sort Word if, on output, you would like your index word to be placed in a different
area of the index than its alphabetical order. For example, if you are creating a supplier index and one of your
company names begins with a numeral, such as '"1st Acme Corp.', you may want this company to appear in the F
section of the index output (listed with other companies whose names begin with the word 'First') instead of
appearing before the letter A, where entries that begin with numbers would be placed in a standard alphabetical
sort order.

1st Acme Corp. rev.0.1 - Index Word

=-[7] Assets - || BUlLEERVLIGN | Sub Products || References || Referenced By || Status || State Log || Tasks
--1“_=| Configurations & Description
-3 ETIME Article Groups Name >| > [Value
B3 ETIM Article Groups ;
B2 Index Words L Loois
B2 Acme Educational Supplies > Name 1st Acme Corp.
I Acme Library Supplies > [Revision 0.1 Last edited by USER7 on Thu May 19 17:36:05 EDT 2016
E-=y Manufacturer Index
R 123 * |Approved 3€ Never Been Approved
..... {&= 1st Acme Corp * [Translation Mot Translated
HHE= A > |Path Classification 1 root/Index Words/Acme Library Supplies/Manufacture
ggi > Wisibility
F-EE D » Biodegradable abe
IR E =[] > [KeyAttl abe
HEET > KeyAtt2 abe
FE= G -
[}_g H > [Sart Word abe [First

Linking Products to Index Words from the Product Hierarchy
Once your index words hierarchy is created, you may now link these words to products.

1. Inthe Tree, navigate to the product to which you would like to link your index word(s).
2. Onthe References tab, expand the flipper for Index Words and click Add Index Word.
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< Sweet 16 Hat rev.0.2 - References =
Commercial || Tables State Log || Tasks

| Product “ Sub Products I Referenced By ” Images & Documents ]

* |Add Index Word

3. Select the relevant index, then click through the additional levels until you have applied the desired index
words. Click OK.

fAcme Party Supplies/H/Hats/Birthday Hats/Sweet 16

Index Level 1 Level 2 Level 3 Level 4 Level 5

Acme Educational Supp » | |A - m 1st Birthday & -
Acme Furniture C

Acme Library Supplies _

Level 1

-
< i » - - - - -
| oK || Cancel

4. The productis now linked to the index word.

P

Inherited From > |Index *llevel 1 »|Level 2 > |Level 3 > |Level 4 »
* Locally defined  |Acme Party Supplies  H Hats Birthday Hats Sweet 16
|* |Add Index Word

5. Repeat the above steps to link your product to additional index words. A single product can be linked to multiple
index words, depending on all of the index locations where the product should appear.

Note on Index Word Pathnames

If the system setting Use full pathname for classes on Product References Tab is setto Y, the lowest level of
each linked index word will appear as a path instead of an individual word. However, this will not impact the output

of the index words in the 'Alphabetical Index - XML file; linked index words will correctly appear as words, not
paths.
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3 Index Words
Inherited From  * |Index *|Level 1 >|Level 2 > |Lewvel 3 * |Level 4 >
* |Locally defined Acme Party Supplies  |H Hats Birthday Hats  [Index Words/Acme Party Supplies/H/Hats/Birthday Hats/Sweet 16

* | Add Index Word

For more information on this system setting, see the Product Information Manager Default Settings section of
the System Setup / STEP Super User Guide documentation.

Viewing and Linking Products from the Index Words Hierarchy

All products linked to a particular index word can be viewed from the Sub Products tab of the index word object.
Additionally, products can be added to index words from this tab.

1. Inthe Tree, navigate to the index word to which you would like to link your product(s).

2. Onthe Sub Products tab, click 'Add Product.'

Confetti Makers rev.0.1 - Sub Products

{7 Assets References || Referenced By || Status || State Log
--r_=| Configurations | | Index Word ] Sub Products
[#-{1 ETIM6 Article Groups =
(-2 ETIM Article Groups e
B2 Index Words
EHE= Acme Party Supplies D > [Name > |0b;
LR A Name > ID Name Obj
R C Confetti Maker * 179780 Confetti Maker Tter
E..@ Confetti Confetti Makers > 1179779 Confetti Makers Tter
. [ Confetti Makers
“[i2) Metal Foil Confetti
@ H
A=y Level 1
-] Merchandising Hierarchy - < [l 3
< | 1 b ’ Add Product

3. Inthe Select Classification Product Link dialog that displays, browse or search for the product(s) that you
would like to link to the index word. Multiple products may be selected by holding Shift or Ctrl when making
selections.

4. Click Select to close the Select Classification Product Link dialog. The products are now linked to the index
word.

Inheritance of Index Words

Index words are inherited in a similar fashion to how standard product-to-classification references are inherited.
By default, index words are inherited in an Accumulative fashion. This means that an index word that is linked to
a parent product will inherit to all of its child products, and additional index words can be linked to the children in
addition to the inherited word(s). However, inherited words cannot be overwritten or removed from lower levels.

The Inherited From column displays the level at which the index word is linked in the hierarchy. In the following
example, the words 'Hats' and 'Birthday Hats' are linked to the parent product 'Paper Hats.' The index word
'Sweet 16'is linked locally ('Locally defined') on the child product.
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P Index\Words

Inherited From | * Index
» [Faper Hats Acme Party Supplies
*» |Paper Hats Acme Party Supplies

Locally defined Acme Party Supplies
Add Index Word

* |Level 1
H
H
H
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For more information on reference link inheritance, see the Reference and Link Types section of the System

Setup / STEP Super User Guide documentation.

Note on the Index Word Product to Classification Link Type

The Index Word product-to-classification link type (ID = stibo.IndexWord) is a hidden objectin STEP. It can only
be accessed by searching for its ID in the Goto field or on the Search tab. Typically, no configuration changes
should be made to this object. However, an occasional configuration need may arise, such as the need to make

th

e link type externally maintained.

System Setup

[+

Unlinking Products from Index Words

Unlinking From the Product Hierarchy

1.

N

B

# Users & Groups
Bl Reference Types
743 Product Reference Types

#- 1 Classification Reference Types
-4 Product to Classification Link Types

4 [(stibo. IndextWord))

----- ) Classifications
i~k Merchandising Link

------ ) Supplier Link

-y WebsiteLink
Bl Product Attribute Link Type

E
-5 Image and Document Reference Type
E

Navigate to the relevant product in the Tree, then expand the Index Words flipper on the product References

tab.

Right-click the arrow to the left of the word that you would like to remove, then select Remove Index Word
from the menu. (Note that only words designated as 'Locally defined' can be removed. Inherited words can

only be removed from the parent level to which they are linked.)

¢ Index Words

Inherited From »|Index
* ocallv defined Acme Party Supbplies
> Hide es
> Show All Rows as
> Rotate Table

o Add Index Word Ctrl+Plus

& |Remove Index Word CtrI+Minu5|

= |inked Attributes from Classification Hierarchy
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Unlinking From the Index Word Hierarchy
1. Navigate to the relevant index word in the Tree, then click the Sub Products tab.
2. Right-click the name of the product that you would like to unlink, then select Remove Product.

< Sweet 16 rev.|
Index Word References || Referenced By

D
[ame > ID
Sweet 16 Hat I > 12R0Q75 |
Yellow & Pink Party H Hide
Show All Rows B

Rotate Table
Add Product Ctrl+Plus
Remove Product Ctrl+Minus
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Creating Document Indexes

This section provides information about creating document indexes after the finalized pages have been saved
backto STEP.

Generally, STEP’n’design uses standard InDesign functions in the creation of document indexes such as indexes
and tables of contents.

This section briefly describes two recommended strategies for creating document indexes such as tables of
contents and indexes.

Table of Contents

To create a traditional table of contents (the one you typically find in the beginning of a catalog or section) it is
recommended to use the standard table of contents function in InDesign.

For more information about creating a standard table of contents in InDesign, see the topic “Basic steps for
creating a table of contents” in the InDesign online help. (Press F1 on keyboard).

Note: When creating a standard table of contents in InDesign, you most likely do not have to style up manually
any of the table of contents entries (such as the headlines or sub-headlines) as these styles probably already exist
in your document.

Indexes

You can create different types of indexes in STEP, e.g. an Alphabetical Index or a Stock number Index.

Examples of index words and levels in an alphabetical index could be names such as:

e Chairs

« Swivel chairs
« Filing cabinets
« Tables

o Workstations

Examples of index words in a stock number index could be numbers such as:

« 100
o 1002345
» 1003456
e 200
o 2001234

Index word are created in the Tree under the Index Words tree node and can be linked to as many products as
needed. You may e.g. need to link a Product Family: Chairs to the index words “Chairs” and “Furniture”. And, a
leaf product could be linked to the index words “Chairs”, “Swivel chairs” etc.
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When generating an index, it is possible to use InDesign’s standard features. For instance, a stock number index
can be easily created by having all stock numbers formatted with a specific InDesign style, and then using that
style to create an alpha-sorted table of contents. For more information about creating a standard Index in
InDesign, see the topic “Index” in the InDesign Online Help. (Press F1 on keyboard).

Note: For a typical STEP-produced product catalog, the functionality of standard InDesign is not ideal, as it—in
most cases—requires a manual selection of index words on each individual page.

Exporting Index Data from STEP

Before you can create an Index in InDesign, the relevant Index words must be created in STEP PIM, and then
exported to an XML file from STEP.

The index export is a specific output format, which you activate within the STEP Export Manager. Name is
Alphanumerical Index.

Using the standard STEP Export Manager mapping tools, you can determine which STEP attribute you wantin
your index output (Product Name or Short Description are two typical choices).

Page number is normally the attribute named Page Numbers (ID: ProductPageNumber). This attribute is
automatically populated with actual InDesign page numbers once you upload an InDesign document to STEP.

The STEP Export Manager also enables you to select sort sequence of index words, as well as the separator the
system should add between multiple page numbers (such as 1-3 or 1...3).

The exported index will organize the index entries into XML tag structures, such as:

<Level1>

<Word>Laser Printer</Word>
<PageNumber>2,5-6</PageNumber>
</Level1>

Note: The names of the tags are important to remember, as they will be used for formatting and styling later.

To export an index using STEP Export Manager:

1. Navigate to File > Export > Data. The Export Manager dialog displays. Select Create New Export, then click
Next.
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P =

E] Export Manager @

Steps Select Configuration

1. Select Configuration
2. Select Objects

3. Select Format

4. Map Data

5. Advanced

6. Select Delivery Method (@ Create New Export

(") Use Existing Export

Back | | MNext |[ Finish H Cancel

2. To define the publication from which you would like to export index words, click Add Objects, browse for the
relevant publication, and then click Select.

P

B

B Export Manager E*] Select Objects x4

Steps Select Objects Search

1. Select Configuration D E Te.rﬁplates ~ | Lih

) 5[ Web Sit
2. Select Objects > | Add Objects E Eniity ot

3. Select Format () GDSN

4. Map Data ---_,l GDSN Receiver il
5. Advanced ---_,l Promaotions

#-I5) Primary Product Hierarchy
=82 Publications

G- Templates

=+ @& Standard Publications
L
~@ Acme Toys

#- [l Acme Clothing

@ Christmas Catalog

. @@ Halloween Catalog N F
4| 1 ' F

6. Select Delivery Method

11

4|

Only export selected ob

Lo i ;
Only export leaf objects Dl -

Include object types [ Select H Cancel ] [3

[ Back H Mext H Finish H Cancel ]
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E] Export Manager
Steps

1. Select Configuration
2. select Objects

3. Select Format

4, Map Data

5. Advanced

6. Select Delivery Method

EXS

Select Objects
D > [Mame > |Object Type * |Version > |Path >
> 177994 Acme Tools Publication English US Publications/Standard...
” |Add Objects

Only export selected objects (H]

Only export leaf objects

Include object types

Export: :P‘roduct v:

[ Back ” Next H Finish ” Cancel l

<All object types=

3. To define from which publication version you want to export index words, click the field in the version column,
then select the desired version. Click Next.

E! Export Manager
Steps

1. Select Configuration
2. Select Objects

3. Select Format

4. Map Data

5. Advanced

6. Select Delivery Method

Select Objects
D * [Name * |Object Type * [Wersion * |Path »
> 177994 Acme Tools Publication English US w [Publications/Standard...
* |Add Objects q
French FR
Only export selected objects O
Only export leaf objects O Export: |Product =
Include object types <All object types=> [E
[ Back ] [ Hext ] [ Finish l [ Cancel l

Note: Regarding the Only export leaf products check box: When exporting as XML, then this option is

ignored.
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P

E] Export Manager @

Steps Select Format

1. Select Configuration :Alphabetical Index - XML v:
2. Select Objects

3. Select Format
4, Map Data Sort Language Code en

Provides a format for export of alphabetical index in XML format

5. Advanced Sort Country Code us
6. Select Delivery Method
Fage Mumber Separator

Fage Range Separator

Use Numerical Sort :‘_I’ES v:

’ Back ]| Next |’ Finish H Cancel

4. Fromthe list, click Alphabetical index - XML, then add the relevant information about sort codes and
separators (what separator the system should add between multiple page numbers etc.).

Click Next. A Map Index Data window displays.
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3. Select Format

4. Map Data

5. Advanced

6. Select Delivery Method

E] Export Manager
Steps Map Data
1. Select Configuration | <D=
2. Select Objects | i <MName:>

----- <Parent ID>
----- <Object Type Name:>

----- <Attributelinks>

----- <Is deleted=

----- "Constant Value"

----- <Page Number=

#H-E0 All Attributes

----- Select Attribute
H-Classifications

t-Index Words

t-Product Classification Links
t-Product References
t-Asset References
t-Classification References
+-Entity References

H-STEP Workflow Task Info
----- Multi level References

OO OO OO oy O g IO e OO e OO

----- Insert Referenced Objects
#-Commercial (Publication)
H-Custom Attributes
(-Systemn Setup

----- Multi level Parent attributes

----- <Product-Override Child ID>

el

Provides a format for export of alphabetical index in XML format

3 |‘$‘ Index words * (0 mapped)

3 |¢' Page Number * (0 mapped)

Inherit Data and References * = Mandatory field Red = Unmapped mandatory field
l Back l | Next | [ Finish l [ Cancel
You now need to perform mapping of index data as described below:
5. Map the index hierarchy:
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3. Select Format

4. Map Data

5. Advanced

6. Select Delivery Method

E] Export Manager
Steps Map Data
1. Select Configuration | <D=
2. Select Objects | - <Namex>

----- <Parent ID>
----- <0bject Type Name>
----- <Product-Override Child ID=
----- <AttributeLinks=
----- <Is deleted=
----- "Constant Value"
----- <Page Mumber=
F-E2 All Attributes
----- Select Attribute
#-Classifications
F-Index Words
E-Acme Educational Supplies
E-Acme Library Supplies
F-Manufacturer Index
. E-Product Index
F-Level 1
H-Product Classification Links
H-Product References
+-Asset References
+-Classification References
t]
t|

-Entity References

-STEP Workflow Task Info
----- Multi level References

----- Multi level Parent attributes
----- Insert Referenced Objects
F-Custom Attributes
[#-System Setup

g B e IO O B e O

S5

Provides a format for export of alphabetical index in XML format

@ % Index words * (1 mapped)

¢ 250873 Word
|[]sort word Path = 250873 Sort Word
|[DJword Path * |250873 ward

9 Page Number * (1 mapped)

‘@ <Page Number= Number

Inherit Data and References

* = Mandatory field

[ Back H Next ” Finish H Cancel l

« Unfold the Index Words hierarchy, click the relevant index, and then click the arrow to the left of Index
words (right side of window).

7. If you want an alphabetic index with Index Letters you must map a constant:
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% Export Manager
Steps

Map Data

1. Select Configuration
2, Seleck Products

3. Select Format

4. Map Data

5. Advanced

&, Seleck Delivery Method

AR e
H-=hame >
H--<Parent I0=
:l..

1[0 Al Attributes

H-Custom Attributes

H-Select Abtribute

H-Classifications

[=]-Indesx Words

5-5tibo Index Hierarchy
--Pencils German
--Pens German

[#-Product References

[#-Asset References

[#
E
E
[#
[ _onskant Yalue
[#-<Page Number =
[+
E
E
E

Inherit Data

=X
Provides a format for export of alphabetical index in %ML Format
' |Index words (1 mapped)
E]Pens German Word

@50"'5 wiord Path pens German Sort Word
M WD"d Path|pens German Word
' |Page Mumber (0 mapped)

l Back. ] l Text ] l Finish ] l Cancel

« Unfold the mapped index hierarchy by clicking the flipper icon to the left of it.
« Click Constant, and then click the arrow to the left of Word Path.

An Enter Value dialog box appears.

-

i-—
% Enterwalue

Enker constant walue

.

===

[ Save H Cancel ]

« Type e.g. <pathsep\>, and then click Save. The constant <pathsep/> is used to identify each single
IndexLetter, and to ensure that the same index letter is only shown one time.

If you want an alphabetic index with Index Letters you must now map the index hierarchy to the Word path
again. The first mapped index will be used for extracting the Index Letter from the Index Word through a
transformation (see step 10). The second mapped index will be used for extracting the Index Word.
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&, Select Delivery Method

Steps Map Data
1. Select Configuration E-<ID>
2. Select Products B1-<Name>
3. Select Format Bl-<Parent ID»
4. Map Data ---<Object Type Mame =
& MVEHOEL". B-"Constant Value™

--<Page MNumber =
#-E3 All Attributes

- Custom Attributes
Fl-Select Attribute
--Classiﬁcations
El-Index Wards

[=-5tibo Index Hierar

| ens Germari
--Product References
[#-Asset References
B1-Commercial

chy -
--F'enc:il German . .

SliboSystems

Provides a format for export of alphabetical index in XML format

E]Index words (1 mapped)

|TE]F'ens German Waord

5°’tW°"d Paﬂ'TiF'ens German SortWaord

WOl'd Paﬁ“lF’ens German “ord

|'{Paﬂ'15ep‘l,>'

|F'ens Gerrnan Word

\

Page Mumber (0 mapped)

Inherit Data

[ ack ][ Mext | [ Finsh ][ Conce l_

o Click the relevantindex under the Index Words hierarchy, and then click the arrow to the left of the Word
Path (right side of window).

9. Map Page:
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G Export Manager -
Steps
Lo ity Provides a format for export of alphabetical index in XML format
2, Select Products
3. Select Format -<Parent D> & Jindex wards (1 mapped)
4. Map Data ' ~<Object Type Mame> :E]Pens German Wword |
5, Advanced Constant Value™ Sort Word Path Pens German Sortword [ bt
&, Select Delivery Method Page Number = - — -
5 Al Attributes Uord Path Pens German Ward
ustom Atﬁ'ibutes "<Pathsep|>” ]
[(1-Select Attribute —
: |Pens Gerrman Word |

--Classiﬁcations
E-Index Wards L =

[ Stibo Index Hierarchy @E]PEQE Mumber (1 mapped)
--F'enc:il German | <Page Number = Mumber
; #-Pens Geman b :

--Product References

+-Asset References
Bl-Commercial

Fi

#)
B

[ Back ][ Next H Firiish H Cancel

« Click Page, and then click the arrow to the left of Page Number.

10. Make transformations on the relevant mapped entries. If you want an alphabetic index with Index Letters you
must make a transformation on the first mapped Index hierarchy:
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% Export Manager

3. Select Format

4. Map Data

5. Advanced

6, Select Delivery Method

[--<Parent ID >
[#-<0bject Type Name >

=5
Steps Map Data
L Select Canfiguration <D= Provides a format for export of alphabetical index in XML format
2, Select Products [i<Name>

'E]Index words {1 mapped)

[ ]Pens German Wwaord

B

SortWord Path Pens German Sortword

| (@) [x]

WUFd Path Pens German word

|"<Pathsep>" |

[l Custom Attributes
[ Select Attribute
--Classiﬁcaﬁons
=-Index Words

_.F'ens German Ward

[=-5tibo Index Hierarchy !?; Transformations //1
Ei Pencil Geman Target: Word Path

i E-Pens German Source: Pens German Word
[#1-Product References At :
[#-Asset References ' word 2ef
[*-Commercial Multi-value separator: i

Starh'ng from position | 1 extract | 1 characters

Add Transformation

[ Save ] [ Reset ] [ Cancel
Inherit Data Il
[ Back ] [ Mext ] [ Finish ] [ Cancel ]

The transformation shown in the illustration outputs the first letter in each word, and is used for the IndexLetter when a new letter
begins in the index. The constant <pathsep/> is used to identify each single IndexLetter, and to ensure that the same index letter is
only shown one time.

If for example you want the first letter in each word outputted and used for IndexLetter (A, B, C etc.) when a

new letter begins in the index, you must do the following:

« Click the Transformation icon @next to Word Path (testindex Word).

A Transformations dialog box appears.

i )

5

i-— .
% Transformations

Target: Wiard Path
Source: Pens German Ward
" T -

Mulki-value separatar; :

Add Tranzfarmation

[ Save ][ Reset H Cancel

¢ Click Add Transformation.

The Select Transformation dialog box appears.
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Er: select Transformation

Append kext
Change case
Convert Fractions to parsable tags

Exctract charackers ak position

Exctract charackers before a given kext in
Extract charackers between bwo pieces of text in the value
Extracts the last M characters af the value -

Extract characters after a given text in the value

khe value

[ Ok ][ Cancel

StiboSystems

« Click the relevant transformation - for example Extract characters at position, and then click OK.

The following dialog box appears.

-— .
% Transformations

Target: W'ord Path
Source: Pens German Word
Aspect: ward

rulti-value separatar; ;

(=]

Starting fram position |1

Add Transformation

exkrack 1| characters

[ Save H Reset H Zancel ]

-

« Ifyouwantto extract an IndexLetter, type 1 in the extract field, and then click Save.

« Make the needed transformations and remember to click Save after each transformation.

« When finished mapping data, click Next.

An Advanced window appears.
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i

E] Export Manager @

Steps Advanced

1. Select Configuration )
|| Tag conversion Coupon -
2. Select Objects
3. Select Format |:| Locale conversion from context
4. Map Data Resolve Inline References
5. Advanced Export Only Local Inline References
6. Select Delivery Method (@) Export Inherited Inline References

Include Calculated Attribute Values

Waorkspace :Main v:
Context :EGIobaI English v:
Select version used to resolve tables DA 2015 B

[ Back ] ’ Next I ’ Finish ] [ Cancel ]

11. The settings in the advanced step are not relevant for exporting index words. Click Next.

12. Select delivery method.

e

E] Export Manager @

Steps Select Delivery Method

. Select Configuration File 5
. Select Objects ' |
. Select Format

. Map Data

. Advanced

. Select Delivery Method

Delivers exported data in a file. You will be notified when the file is ready for download.

[= T ¥ | B S 4% B % B

Export Process Template: |Exporter

Next | [ Finish |[ Cancel

o Click the relevant delivery method from the list, and then click Finish.

A Save Export Configuration dialog box appears.
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E] Save Export Configuration @
Save Options
Save to Configurations/Index Export

(@) Start Export Process: | Index Export Configuration

() Don't export now

[ oK ” Cancel

« Define your save and export settings, and then click OK.

If clicking Start export process, the XML file is exported.

Creating Indexes

To use the recommended way for making a typical STEP product catalog index:

1. Exportthe Index out as XML from STEP PIM. For more information, see "Exporting Index Data from STEP" on
page 121..

2. InInDesign, click Import XML in the File menu to import the exported file into InDesign.

An Import XML dialog box appears.

3. Find the XML file you want to import, and then click Open.
An XML Import Options dialog box appears.

XML Import Options

—Optians
Mode: |Merge Content -
i I J J Caticel I

[ Create link

[~ &pply ¥SLT: |Use stylesheet from XML j
W Clone repeating text elements

[T Only import elements that match existing structure

W Import text elerments inta tables if tags match

™ Do not impart contents of whitespace-only elemerts

[T Delete elements, frames, and content that do not match imported XML

W Import CALS tables as InDesion tables
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As you can import the Index XML file without touching or changing the XML Import Options, just click OK.

After importing your STEP generated XML index file, the index words are made available in an XML hierarchy

(left side of screen).

# @ 3 o
= [¢3] aAlphalndes
[+ iEl Lewell
[+ Lewelz
[+ iEl Lewell
= [¢4] Levelz
EI 1ord
|=| PageMumnber

iEl Lewell

Lewelz

iEl Lewelz

Lewelz

iEl Lewelz

WV oW R

Skructure "_E e

F

Mt Element.. .

Ml Parent Element. .,

e Gkbpbute. ,
fewiomment.:.

few Processing Instruckian, ..
Delete

Edit:

[ntag Element

GG ko Ikenm

Walidake Fron Faok Element
Yalidate from Selected Element
Wiew List of Errors,.,

Load DTL...
Delete DTh
DD Cphons., .
i ST

Impork =ML, ..
Export =ML...

Hide Attributes

Hide Comments

Hide Processing Instruckions
Show Text Snippets

Add Untagged Ikems

Map Tags to Skyles. ..
Map Skyles to Tags. ..
Tagging Preset Options. ..

T

The index tags <Word> and <PageNumber> (see illustration above) are now selectable from within the XML

structure.

. Create the needed paragraph styles for each index tag in InDesign.

Note: The naming of the paragraph styles must be identical to the naming of the index tags (in this case

“Word” and “PageNumber”) to be able to apply the formatting successfully.

You can format the styles any way you want. For information about using “dot leaders”, see "Creating Dot
Leaders" on the next page.

. After having set up your styles, click the Options menu (arrow in the top-right corner of the XML hierarchy
view), and then click the Map Tags to Style.
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A Map Tags to Style dialog box appears.

Tag I Style | D
Alphalndex [Mat Mapped] 2l

Cancel I
Levell [Mot Mapped]
Levelz [Mot Mapped] Load... |

PageMurmbet 4] PageMurnber = .
Root (Mot Mapped] Presie
Wit 9 Word ;!

Map by Marne

&

6. If you have a perfect match between the names of your index tags and the names of your paragraph styles,
click Map By Name.

Alternatively, map the index tags to the paragraph style one by one by clicking the relevant styles from the style
lists.

7. Click OK.

8. When finished mapping index tags to the paragraph styles, draw a text frame on your InDesign page using the
Type Tool (T).

9. Drag the Index (from the Alphalndex level in the XML view) and drop it into the created text frame.

The index is now created with the relevant mapped styles applied to it.

Creating Dot Leaders

In many of the indexes, you would want a dot leader (a dotted line of variable width) pre-pending the page number,
e.g.:

Laser Printer ........ 1
Inkjet Printer ....... 2

To create a dotted line in your index with STEP and InDesign:

1. Make sure that your XML load file contains a character, which will enable you to separate the specific XML
tags.

Note: If the load file was not exported with such a character directly from STEP PIM export, you can easily
add one using a simple text editor such as WordPad for Windows.

Example:

Before replace:
</Word><PageNumber>
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After replace
</Word>#<PageNumber>

2. After you have imported the XML file with the separator character, you can now use that character:

« toturnyourindexinto an InDesign table by clicking Convert Text to Table in the Table menu.
« toformatthe index any way you want, using InDesign’s table formatting features.

« to convert the special character to a tab character by clicking Find/Change in the Edit menu. By now adding
a right-aligned tab with a dot leader to your PageNumber style, you can format your index entries with
proper, dotted lines (see Paragraph Style Options dialog box below).

General a Style Mame: [FageMumber
Bazic Character Fotrnats Lacation:
Advanced Character Formats Tabs

Indents and Spacing

IR

Paragraph Rules E 2
Keep Options ||:| |E- |12 |13 I24

- PN PR PR i s P e Bl AT ISP B B Y Lo i NN-ER Lo ) et ) B[ o Wl |
Hyphenation

Justification X 90rnmm Repeat | Clear &l |
Drop Caps and Mested Styles

Leader: |.
Bullets and Murnbering

Character Color Align On:
CpenType Features

l\

Undedine Options
Strikethrough Options

[ Preview (4 I Cancel

Once you have configured a tab leader for your page number style, you can make the page number space out to
the full width using a dot leader character.
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Writing Data Back to STEP

This section describes how you can write certain types of data from your InDesign page back to STEP without
having to launch STEP and locate the product and attribute first.

As the InDesign page is not really designed as a database front end, a range of restrictions apply to the writeback
function.

The restrictions are as follows:

« You can only write data back to the STEP database provided you have the required user privileges.

Note: This means, that you can never write data directly back to the Approved workspace, as no users,
under normal circumstances, are allowed to change data in the Approved workspace.

« Calculated attributes or attributes which have undergone a data transformation (for instance in a table)
cannot be written back to the STEP database.

« Graphical formatting such as bold, italic or underscore might be written back to the database if you manage
the styles carefully (i.e., if this formatting is tied to InDesign character styles that have corresponding Style
Tagsin STEP)

« Invalid tags or special characters not defined in STEP PIM can not be written back
STEP’n’design supports two ways of writing data back from document to database:

« Adialog box that shows all items on the document that could be written back and allows the user to mark the
items chosen.

« Adirect writeback option, where you select the specific element on the page that you want to write back to
the database.

General Data Writeback

To perform a general STEP PIM database writeback operation after you have changed some attribute text on the
InDesign page:

1. Inthe STEP menu, click Writeback to DB. The Writeback to DB dialog box appears.
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[ Writeback to DB
[+ 2] Frameilong Ttem Desoiption
= [£2) FrameiLlong Item Desaiption
7 g Context:Context] Workspace: Main Object: 109951 Object Type: Product
= [E5) Attribute Ttems
% []7 Long Item Description
Placed: Show your love with red heart confett? Assorted colors.
DE:Show your love with red heart confett
= [£2] Frame:Long Item Description
7 gl Context:Contest] Workspace:Main Object: 109953 Object Type: Product
=[] Attribute Ttems
# [T Long Item Desoiption

DE:Why bany? Do it yourselt with this easy-to-use confetti maker!
[+ 2] Frame:Object Name
[+ [£5] Frameilong Item Description
[# 2] Frame:long Ttem Desoiption

Select / Deselect All
[¥] Write inherited value to owner object
Writehack workspace:  Main -

Placed: Do it yourself with this easy-to-wse confetti makerd Graat for 2ll ages!

FNEEE FEEEE

HEE

6/ & Selected

Frame Perspective - [ oK ||

]

13

StiboSystems

. From the list at the bottom of the dialog box, click either Frame Perspective or Object Perspective

depending on how you want your changes to be presented.

. Select the relevant check boxes to the right for the data you want to write back to STEP.

4. Select/deselect the Select / Deselect All check box if you want to allow selection / deselection of all items

within the tree. The check box indicates how many items have been selected, and the total amount of items.

. Select Write inherited value to owner object if you are writing an attribute value back to STEP from a
mounted 'child' object in InDesign. Checking this box will write the locally updated attribute value back to the

owner (parent/ grandparent) object.

. Inthe Writeback workspace list, click the workspace you want to write back to. The list displays all created
workspaces. If not selecting a workspace, the default value is Main.

. Click OK. The contents of your attribute on the InDesign page will now be written back to the STEP database,

provided that the STEP database allows it.

© Stibo Systems - Confidential

138



StiboSystems

8. A Writeback to DB Results dialog box appears. If no errors have been encountered during the writeback
process, you may click OK to close the window. Users who do not have privileges to make changes in the
STEP Workbench, such as changing attribute values, may receive errors in the Writeback to DB Results
dialog when attempting a data writeback.

9. After the writeback operation has been performed, it will take the STEP Workbench a few seconds to update.

Writeback to DB Results 1

[5 lihttan OK - 1 =]
[ Emors with attribute walue - 0

[ Etrors with attribute - 0

[ “alidation errors - 0

[+ Permission ervars - 0

[+ System emors - 0

Direct Data Writeback

To perform a direct STEP PIM database writeback operation after you have changed some attribute text on the
InDesign page:

1. Place the text cursor within the item to be written back.

2. Right-click and select Write Page Selection back to DB, which appears near the bottom of the pop-up
menu.

Go To Page Selection in Structure view
Go To Page Selection in Workbench
Update Page Selection

Force Update Paﬁe Selection
Write Page Selection back to DB

InCopy

Mew Mote

Writeback Errors for Inherited Values

If Write inherited value to owner object is left unchecked in the Writeback to DB dialog box, even users with
Super User privileges—who are granted All Setup Actions and All User Actions—will receive a permission error in
the Writeback to DB Results dialog when attempting to locally update an inherited attribute value from within
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InDesign. This error occurs because inherited attribute values may not be locally overwritten from within InDesign
by anyone. Inherited attribute values may only be locally overwritten in the workbench.

When this error appears, the value(s) contained in the error message have not written back to STEP at all. Thus,
the only option to update an inherited attribute value from within InDesign is to write back to the owner object.

‘Writeback to DB Results

[» Written OK - 0
|» Emoes with attribute vahe - 0
|» Emoes with attribute - 0

[ walidation emors - 0

F Permission emors - 1

‘Context:Context] Workspace: MainCbject: 10995 30bject TypeiProduct: ProductGroupDescription = Confetti for 2ll aocasions, Great for weddings, birthday parties, and skeepovers!

i+ System emors - 0

Considerations and Limitations for Writeback to Owner

« Writing a value back to an owner (parent / grandparent) object that exists in the Approved workspace will
cause this object to become unapproved. Users should take care to ensure that data writeback from
InDesign does not impact other processes (such as Outbound Integration Endpoints) that rely exclusively on
products in the Approved workspace.

« A dialog containing the Write inherited value to owner object checkbox will not appear when writing data
back to STEP using the Write Page Selection back to DB option. Users will only receive the Writeback
to DB Results dialog, containing the Permission error(s).

« The Permission errors warning is not associated with user privileges as defined under Users & Groups
in System Setup. 'Permissions' here refers to core functionality of STEP'n'design itself, in which no users
have the authority to overwrite inherited values from within InDesign.
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Updating Documents in InDesign

A key feature in STEP’n’design is the ability to update your already created page(s) with the latest changes from
the database. This ability enables you to start building your pages even when product data is not complete or
approved yet. Using the update features, you can, at all times, make sure that the contents of your page matches
that of the STEP database.

STEP’n’design supports three ways of updating documents:

o Checking the STEP database for updates
« Selectively choosing which data structure to update

« Direct update, where specific elements on the page are chosen for updates

This section describes how to check the content of the document against the corresponding contentin STEP and
how to update already-created pages with the latest changes from STEP.

Checking Database Update

As you can start building your pages even when product data is not complete or approved yet, it is possible to
check the database for updates before saving the documents back to STEP.

1. With the relevant InDesign page opened, click Check DB Update from the STEP menu.

A Database updates since place dialog box appears.
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= [C_JFrame: Description I- ;I
= [C)Context: EM &ll All Worispace: Main Object: 11236 Objact Typea: Product N
= [T Atibute Tterns |
=i JIDescn'ptinn I-

Placed: 12" Dual Torque Harmrmer Crill =0:0000 =Modal 1194484 SRE <0x0000 = <0c0000 = *
DE: 1j2" Dual Torgue Hammer Drll 2000000 =Model 119485k 2000000 = =0x0000=  * D

w
=7 Ternplate Sections N jl

= Template Section: Context: EM &ll All Warkspace: Main Ohject: 19337 Object Type: Product Source]
Additions: 1134EWM

[ Select [ Deselect &l 010 Selected

[~ oObtain values from transformed tables when structure matches

W Show ohiect lists

Frame Perspective - ;9 Canicel

[ P [ | | 4

The dialog box lists all the cases, where a newer version of the data exists in the STEP database.

. Select/deselect the Select/Deselect All check box if you want to allow selection/deselection of all items within
the tree. The check box indicates how many items have been selected, and the total amount of items.

. From the list (lower left corner) you can select between Frame Perspective and Object Perspective,
depending on how you want the update-candidates to be shown.

. Select the Show Object lists check box if you want to split the dialog box into two areas, with the lower area
showing object lists. If repeated areas or template sections have a different object list, then items are shown in
the object list.

. If you want to update the document, select the relevant check boxes (in the right hand-side).

Note: If atable as such is updated, the entire table is re-sent from the database, and all formatting applied on
the InDesign page is lost. To prevent this, you can choose to only update the relevant attributes within the table
using Update Document Data command from the STEP menu (see "Updating by Type" on the next page)
or perform a direct data update on the table (see"Direct Data Update" on page 145).

© Stibo Systems - Confidential 142



StiboSystems

6. Ifatableis chosen for update, you can select the Obtain values from transformed tables when structure
matches check box if you want to retain table structure (e.g. keep current row/column sizes) and only update
the values.

If not selecting this check box, then the table is updated to the database value.

7. Click OK.

If you selected check boxes, then the document is updated. If not, you are just closing the dialog box after
viewing the database update-candidates.

Updating by Type

You can selectively choose which data structure to update, if you know that a certain category of data (such as
image references, attributes or tables) have been changed in the database, and you want to have your page
updated to reflect those changes. You can update either a small data structure such as one individual attribute, or
you can update an entire group of attributes, images and tables. A very typical use of this feature isto do a
traditional price merge, where all price attributes must be updated.

To perform an update by type operation after you have changed some attribute text in the STEP PIM database:

1. When having the relevant InDesign page opened, click Update Document Data from the STEP menu.

A Document Update dialog box appears.
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Document Update

Property Selection
[ 5] Attribute Groups
[+ 01 Object Properties
[ 2] Commercial Types
[+ EﬁTal:nlE Types

[ [£2]Reference Types
[» [£2)Table Content

(| (|

[T Select | Deselect Al 0/ 33 Selected
[T Update Template Section

[T Update Repeat Area

[T Obtain values from transformed tables, checking for table structural changes

[ Force Update

[T Update Attribute Groups ITI Cancel

| .

2. Select the relevant check boxes (right hand-side) for the elements to be updated.

You can select between groups or individual attributes, object names, table or image type. If checking the
highest level, then everything underneath is automatically selected.

If you choose a table type for update, the tables of that update are updated to the database value. Attributes
within tables where the type is not chosen are updated according to the attributes selected. In effect, at table
can be updated and its format maintained by checking all the top level, except the table types, since that will
update every attribute/asset in the table.

Note: If a table type as such is updated, the entire table is resent from the database, and all formatting applied
on the InDesign page is lost. To prevent this, you can choose to perform a direct data update on the table. For
more information, see "Direct Data Update" on the next page..

3. Select/deselect the Select/Deselect All check box if you want to allow selection/deselection of all items within
the tree. The check box indicates how many items have been selected, and the total amount of items.

4. If selecting the Update Template Section check box the list of objects applicable to a template section is
compared to those mounted on the page (ignoring order). Additional objects are placed at the end of the list
unless deleted items are also found - in which case added items replace the deleted items until there are no
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more deleted items and the remaining items are then placed at the end of the list. When the Force Update
check box is selected the template section is removed from the page and replaced with the original gap etc
settings - thus the objects will appear in the order of the database.

This will refresh the selected sections with the current data that is in the database.

If selecting the Update Repeat Area check box the list of objects applicable to a repeat area is compared to
those mounted on the page (ignoring order). Additional objects are placed at the end of the list unless deleted
items are also found - in which case added items replace the deleted items until there are no more deleted
items and the remaining items are then placed at the end of the list. When the Force Update check box is
selected the repeat area is removed from the page and replaced with the original gap etc. settings—thus the
objects will appear in the order of the database.

If a table is chosen for update, you can select the Obtain values from transformed tables when structure
matches check box if you want to update attribute values by resolving the table and getting the value from the
table (e.g. if a selected attribute appears in a mounted table (and the table type is not chosen) and the table
structure matches (same #rows, same #cells in each row, same attribute in each cell).

The option is very useful since transformations in a table are applied in a sequence, and the resulting attribute
value in a cell therefore be very different from the value entered by the PIM operator.

If not selecting this check box, then the table is updated to the database value.

Select the Force Update check box if you want to have a value re-sent from the STEP database to the page
and overwrite local changes on the InDesign page.

Important: If selecting the Force Update check box, then all local changes on the InDesign page are overridden.

9.

If not selected, an attribute is only updated, if the current value is different to the value when it was mounted.

Select the Update Group check box if you want to have updated the sequence and number of visible
attributes within in a referenced Attribute Group.

Click OK. The document is now updated to match the contentin STEP.

Direct Data Update
You can perform a direct data update after you have changed some attribute text or table values in STEP.

Direct Data Update of Attribute Text
To perform a direct data update:

1.

2.

Place the cursor within the tag markers of the element on the InDesign page.

If the tag markers (the [ and ] characters) are not visible, click the View menu, point to Structure, and then click
Show Tag Markers.

Right-click.

The following options become available.
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Zuk ZEE
Copy Ckrl4+C
Paste Chrl+Y
Fank g
Size g
FindfChange. .. Ckrl+F
Speling 3
Anchored Object 3
Change Case r

Show Hidden Charackers  Alk+Cerl+I

Cross-References 3
Insett Yariable r
Insert Special Character 3
Insert White Space 3
Insert Break Character 4
Insert bk
Delete r
Select r
Tag Text L4
Unkag Texk

Select in Struckure

Interactive bk

Edit in Skary Editar Chrl+

Go To Page Selection in Struckure wiew
G0 To Page Selection in \orkbench
IIpdate Page Selection

Force Update Page Selection

IIpdate Table

Force Update Table

Idpdate Table Content

Force Update Table Conkent

Write Page Selection back to DB

InCopy 3

3. Click either Update Page Selection or Force Update Page Selection.

« Clicking Update Page Section, updates the attribute value if it is different since mounted.

« Clicking Force Update Page Selection, forces the attribute value to be updated.

The content is updated on the page, reflecting the data in the database.
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Direct Data Update in Tables

To perform a direct data update in a table:

1.

Cuk

Copy
Paste

Right-click anywhere in the table you want to update.

The following options become available.

o JI

Crl+3
Chrl4-C
CErl+Y

Font
Size

Find/Change...

Ckrl+F

Spelling
anchored Ohjeck

Zhange Case
Show Hidden Charackers

AlE+Chrl4-T

Cross-References

Insert Yariable

Insert Special Character
Insert White Space
Insert Break Character

Insert
Delete
Select

Tag Text
Lntag Texkt
Select in Struckure

Interactive

Edit in Story Editor

Chrl4-

Go To Page Seleckion in Struckure visw
Go To Page Selection in Workbench

IIpdate Page Selection

Faorce Update Page Selection

Ipdate Table
Force Update Table
Idpdate Table Content:

Force Update Table Content

Wite Page Selection back to DE

InCopy
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2. Depending on whether you want to update the whole table (changes in content as well as structural changes),
just content changes or just structural changes do the following:

« Toupdate all structural and content changes (styles, transformations, attribute values etc.) in a table, click
either Update Table or Force Update Table.

Clicking Update Table updates the table if it is different since mounted.
Clicking Force Update Table forces the table to be updated.

« Toupdate table content, click Update Table Content.

Clicking Update Table Content updates every attribute in the table if the table structure matches, and the
update only take place if the attribute value is different to that when it was mounted.

If both structural changes and changes to content have been made, then a STEP Alert dialog box appears -
otherwise, the content is just being updated.

STEP Alert

Table structure missmatch - content update cannot be performed, Update to:

[ DB attibute |  DETable | Skip |

Click DB Attribute to update the content of the table. If you want to update the structual changes as well, you
must click DB Table.

« Toforce atable content update, click Force Update Table Content.

Clicking Force Update Table Content forces the table content to be updated with the current values in the
STEP database.

If both structural changes and changes to content have been made, then a STEP Alert dialog box appears -
otherwise, the content is just being updated.

STEP Alert

Table structure missmatch - content update cannot be performed, Update to:

[ DB Attribute |  DETahle | Skip |

Click DB Attribute to force update the content of the table. If you want to force update the structural changes
as well, you must click DB Table.

Exporting and Importing Publications

Publications may be exported from and imported into STEP by using an Excel format called Publication Excel.
The Publication Excel format supports all publication types: standard STEP'n'design ('drag and drop'),
Flatplanner, and AutoPage. In addition, publications and their accompanying templates can be exported from one
STEP system and imported into another through the use of publication Transfer Packages.
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Using Publication Excel sheets and publication Transfer Packages to export and import publications can help
reduce the time spent on manual publication-building tasks in the workbench, such as the manual creation of
publication hierarchies as well as the linking of product, asset, and classification objects into publication sections.
Publication Transfer Packages also include this functionality, plus remove the need to manually link templates into
a new publication exported from one STEP system and imported into another.

The ability to export and import publications also greatly simplifies the migration of publications from one STEP
system to another, reducing the number of manual steps needed to duplicate and/or rebuild these publications.

The following sections of this documentation explain the information included in the Publication Excel
spreadsheet for standard ('drag and drop') and AutoPage publications. For information on the additional
information included in the export of Flatplanner publications in the Publication Excel format, see these sections
of the Flatplanner documentation:

« Exporting and Importing Flatplanner Publications in Excel

+ Contents of Flatplanner Publication Excel Exports

Exporting Publications in Excel

Publications can be exported and imported in an Excel format called Publication Excel. The Publication Excel
format supports all publication types: standard STEP'n'design ('drag and drop'), Flatplanner, and AutoPage.

The instructions in this section focus on the export process, as the typical first step in using a Publication Excel
sheet to import a publication is to export a pre-existing publication. This exported Publication Excel file can then be
used as a 'template' sheet to import new publications.

Note: The Publication Excel format is only available when exporting from the publication level. It is not available
for exports from the publication group level or section level.

The following screenshots show a sample Publication Excel spreadsheet in three sections; columns A - F, G-M,
and N- W. The Publication Excel format only allows one object per row.

A, E C D E F

1 Publicationlll  Publicationtarne  PublicationTupe PublicationTermplatellr  PublicationlnberitedUnit  PubPageTemplatelD
2 Meran Zeta Tools Default publication type | TI0TIG inches
3

[E] H | o I L fd
1 VerzionlD “VerzionMarne VersionContextlD  WersionWorkzpacelDd  LavertdappingTernplate  LavertappingDocurnent  LaverkAdappi ngChwner
2
3
4 27 French FR Context2 kain
& France France tre
B Images Images falze
7 fiz733 Englizh US Contextl kdain
g US4 IS4 frue
9 Images Images trie
0 Fzras Englizh LK, Context? Pain
1 Lk LK true
12 Images Images falze
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N [u] F =] Fi g T 1] Y W
1
2 <Action ID="ProductTemplateAction” Type="ProductTemplateAction” parametertemplatelD=
3 CatalogTheme Zeta Tools 2016
4
5 07821
6 "108803
7h 109032 Toolboxes Section <Action ID="PublicationTemplateSpreadindexAction” Type="PublicationTemplateSpreadinde
8 SectionTheme Toolboxes
9 20881 Product
10 7829 Product
1 0832 Product
12 "Bans Product
131 109148 Nails and Screws  Section
14 SectionTheme Nails and Screws
15 5108 Product
16 20674 Product
17 7829 Product
18 f01118 Product
19 07828 Asset
20 07629 Asset
211 109033 Garden Tools Section <Action ID="PublicationTemplateSpreadindexAction” Type="PublicationTemplateSpreadinde
22 SectionTheme Garden Tools
232 110370 Weed Trimmers Section
243 110379 Electric Section
253 "110395 Corded Section
2% 5 10399 25 Cords Section
27 109952 Product
28 109951 Product
29 09955 Product
305 "10403 50' Cords Section
31 110049 Product
32 "10050 Product
33 "109953 Product
34 109954 Product

Information Included in the Export

The following table outlines the contents of a Publication Excel export, in the order that the columns appear.

Column Header Description

PublicationID STEP ID of exported publication
PublicationName STEP Name of exported publication
PublicationType Object type ID of exported publication

PublicationTemplatelD STEP ID of publication template linked to the exported publication

PublicationInheritedUnit | Unit applied to the publication group that contains the publication (mm, inches,
points, or picas)

VersionID STEP ID of the publication version(s) of the exported publication

VersionName STEP Name of the publication version(s) of the exported publication

VersionContextlD STEP ID of the context(s) used in the publication version(s) of the exported
publication

VersionWorkspacelD STEP ID of the workspace(s) used in the publication version(s) of the exported
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Column Header Description

publication

LayerMappingTemplate | Name of the layer in the templates (Publication, Product, and InDesign-created
Page templates)

LayerMappingDocument | Name of the corresponding layer in the Publication Document (mounting page)

LayerMappingOwner Displays whether the publication version to which the layer is mapped is the owner
of the layer
SectionLevel A number that represents whether the section is a top-level section (1) or a

subsection (2, 3, 4, etc.)

SectionID STEP ID of the exported publication section(s)

SectionName STEP Name of the exported publication section(s)

SectionTypelD Object type ID of the exported publication section(s)

MetaDataAttributelD STEP ID of metadata (description) attributes linked to the publication or section

(column will not appear in the export if there are no values populated for the
metadata attributes)

MetaDataAttributeValue | Value of metadata (description) attributes linked to the publication or section
(column will not appear in the export if there are no values populated for the
metadata attributes)

RuleSettings Pagination Rules used in the publication(s) and sections

Example: <Action ID="PublicationTemplateSpreadindexAction"
Type="PublicationTemplateSpreadindexAction"
parametertemplateSpreadindex="1"> <Condition ID="AlwaysCondition" />

</Action>
ProductTemplatelD STEP ID of the product template(s) linked to the exported publication
LinkedObjectID STEP ID of the product, asset, or classification object linked into the section(s)
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Column Header Description

LinkedObjectType Value will either be 'Product’, 'Asset’, or 'Classification' depending on whether a
product, asset, or classification object is linked to the section(s). 'Product’, '‘Asset’,
and 'Classification’ are generic terms and do not specify the exact object types of
the product, asset, or classification.

Location of Publication Export Information in STEP

The following sections use a sample publication to illustrate where the information included in a Publication Excel
export resides in the STEP workbench.

Publication Group Tab (Parent Publication Group)

The PublicationInheritedUnit field contains the unit used in the publication. The unit for a publication is set on
the publication group parent object that contains the publication. This unit inherits to all publications contained
within the publication group.

Autopage Publications rev.0.1 - Publication Group

Publication Group |EEERT

Mame »| » |Value ]
> ID 108372
> Mame Autopage Publications
* Dhject Type Publication group types
> Revision 0.1 Last edited by USER on Fri Sep 25 09:49:37 EOT 2015
» Path Publications fAutopage Publications

Init nches

ail Date (same as Effective | &

Publication Tab

In this example, the sample publication contains eight top-level sections, two linked product templates, one
metadata (description) attribute that contains a value, and four mapped layers.

1. The PublicationID and PublicationName columns contains the STEP ID and STEP Name of the
publication, respectively.

2. The PublicationType column contains the object type ID of the publication.
3. The PublicationTemplatelD column contains the STEP ID of the publication template.

4. The MetaDataAttributelD and MetaDataAttributeValue columns contain the STEP ID(s) and STEP Names
(s) of populated metadata attributes that appear on the publication and section(s). (If a publication / section has
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linked metadata attributes but these attributes do not contain values, the MetaDataAttributelD and
MetaDataAttributeValue columns will not appear on the exported sheet.)

5. The ProductTemplatelD column contains the STEP ID(s) of the product template(s).

6. The LayerMappingTemplate column contains the name of the layer in the templates (Publication and/or
Product); LayerMappingDocument will contain the name of the corresponding layer in the Publication
Document (mounting page); and LayerMappingOwner will display whether the publication version to which
the layer is mapped is the owner of the layer—value of 'true’ or 'false.' In the following screenshot, 'English US'
(displayed in bold) is the owner of the 'Images' layer.

Note: When exporting a 'model' publication in order to use the resulting Publication Excel sheet as a template for
later publication imports, it is recommended to populate at least one metadata attribute on the publication (and
each section) with a 'dummy’ value. This ensures that the MetaDataAttributelD and MetaDataAttributeValue
columns appear on the 'template’ sheet and will not have to be manually inserted later.
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< Zeta Tools - Publication "

AutoPage Publication Planner || Pagination Rules || Page [nspector || Status || State Log || Tasks

[ Flan " Yersion " Pages " Publication Planner " Flan Motes “ Financial Summary ]

MName | * |Value
* D o 109027
* [Name Zeta Tools
* |Object Type 9 Publication
* |Revision 0.4 Last edited by USER4 on Fri Jul 15 13:44:22 EDT 2016
* |Path Publications/AutoPage Publications/Zeta Tools
* |Pages per spread 2

* |Auto page Document Level| |1
Zeta Tools Publication Template (110408) 9

[

* |Publication template

* [Output engine InDesign

* DTF Queue

* [Effective Date [

» [Expiration Date E

> |Catalog Theme abe Zeta Tools 9
> |LastPageNumber A0

? Product Templastes
Name @ >

* TocIndex
* [Main Product Tembplate
> | Add template

©Page Templates

® layerMappings

_Template * |Document * \Wersions >

> [France France French FR

» Images Images English US; French FR; English UK @

> USA USA English Us

s UK LK English UK

* |Create Mapping

1—
MName >

* |Create Import Configuration

Sections, Subsections, Linked Products, and Assets

The sample AutoPage publication also contains subsections (sections within sections), product objects, and asset
objects linked to the publication sections.
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+ The SectionLevel column contains a number that represents whether the section is a top-level section (1) or a
subsection (2, 3, 4, etc.).

¢ The SectionID and SectionName columns contain the STEP IDs and STEP Names of all sections and
subsections.

o The LinkedObjectID column contains the STEP ID(s) of the product and/or asset objects that are linked to
each section.

+ The LinkedObjectType column contains either 'Product’ or 'Asset’' depending on whether a product object or
an asset object is linked to the section. 'Product’ and 'Asset' are generic terms, as the exact object types of the
products or assets are not necessary for the Publication Excel format.

=l Zeta Tools 2016
w5 Commerdal Data
[+ @ Toolboxes

=} B8 Mails and Screws

- | EVN-12
- | EVN-24

- {4 050-42151

----- m| 20803

-2l OTP Documents
=} [E8 Garden Tools
EI Weed Trimmers

- 21933
-\ 22196
- | 20862
- 20883

-/ @) 910835

-/ @] 910836

= [EF Gas Powered

Regular

-l Gas-Oil Mix

-- DTF Documents

[=}-[E8 Electric

Rechargeable

El Corded

. - 25 Cords
--ﬁ 50" Cords

‘ =] OTP Documents

-- DTP Documents

Version Tab

All information related to the publication version(s) is included in the export.

1. The VersionID column contains the STEP ID(s) of the publication version(s).

2. The VersionName column contains the STEP Name(s) of the publication version(s).
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3. The VersionContextID column contains the STEP ID(s) of the context(s) to which each publication version is

linked.

4. The VersionWorkspacelD column contains the STEP ID of the workspace to which each publication version

is linked (will either be 'Main' or 'Approved’).

<

| Publication ” Flan ]

AutoPage Publication Planner

Zeta Tools - Version

Fage Inspector |§ta1us State Log | Tasks

Pagination Rules

_...|

[ Pages ” Publication Planner

Flan Notes H Financial Summary l

7 Version Description

Pagination Rules Tab

ID * |Mame > |Context * |Workspace * |Price
* 127315 o English UK 9 English UK 9 Main o
» 127313 English US English US Main
* 127314 French FR French FR Main
> | Add version

STEPXML code for Pagination Rules linked to the publication and/or sections are included in the RuleSettings

column. The screenshot below shows four pagination rules set at the top level of the publication.

If a publication has no pagination Rules, the RuleSettings column will not appear on the exported sheet.

Note: When exporting a 'model' publication in order to use the resulting Publication Excel sheet as a template for
later publication imports, it is recommended to manually set up the desired pagination rules first. This ensures that
the RuleSettings column appears on the 'template’ sheet and will not have to be manually inserted later.
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Zeta Tools 2016 - Pagination Rules ~pm
AutoPage Publication Planner |BRERLENCHIN N [ Page Inspeckor || Status || Stake Log || Tasks
| Publication ” Plan Version Pages ” Publication Planner [ Financial Summary
D Object Layout
Condition » [Action
» Default condition |Jse product template Doc-dev prod temp
Add Rule
D Position rules
Condition > [Action
s If first in section 1 Flace at top of new document
Add Rule
2 Set publication template spread index
Condition » lction
» Default condition Set publication template spread index 1
Add Rule
T Using gap
Condition » [Action
» Default condition Flace using gap of 0,55 inches
Add Rule
[ Add Rule Group ]

Importing Publications in Excel

Publications can be imported in an Excel format called Publication Excel. All objects required for a publication in
the green Publication hierarchy can be created with a Publication Excel import, with the exception of publication
group objects. The Publication Excel format supports all publication types: standard STEP'n'design (‘drag and
drop'), Flatplanner, and AutoPage.

The typical first step in importing a publication in the Publication Excel format is to export a pre-existing publication.
This exported Publication Excel file can then be used as a 'template' sheet for new publications, i.e., existing
information on the export sheet will be replaced with new information for the subsequent import. For more
information on the Publication Excel export process, see Exporting Publications in Excel.

The following screenshots show a sample Publication Excel spreadsheet that could be used to create a two-
version publication with multiple sections and subsections. In addition, this sheet is populated with data that will link
product and asset objects to the sections, populate metadata attributes that exist on the publication and sections,
and create pagination rules for the publication and sections. Note that the ID fields have been left blank for
PublicationID, VersionlID, and SectionID, as the intention is for the system to autogenerate these IDs upon import.

Note: Itis strongly recommended that the STEP ID is set to autogenerate (by use of an ID Pattern) for the
'Publication Version' Basic Object Type and all object types used to create publications and sections (typically
'Default publication type' and 'Section'). If not, you must provide these IDs in the Publication Excel import sheet. If
a Publication ID on the import sheet matches the ID of an existing publication in STEP, the import will simply
update the existing publication. For information on autogenerating STEP IDs, see Autogenerate using Name
Pattern and ID Pattern in the System Setup / Super User documentation.
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1
2 Zeta Tools Default publication type "110408 inches

3
4 FrenchFR  Context2 rain

5 France Frarce true

[:] Images Images falze

7 EnglishUS  Contextl ain

8 Usa usa true

9 Images Images true
10 English UK. Context? Main
il LIk LK true
12 Irnages Irmages false

] o P Q R = T 1] W W

1

2 =Action ID="Produc{TemplateAction” Type="ProductTemplateAction” parametertemplatelD="107821" parametertemplateTitle=

3 CatalogTheme Zeta Tools 2017

4

5

3 "07821

7 "108803

Elgl Toolboxes Section <Action ID="PublicationTemplateSpreadindexAction” Type="Publication ction” parameter &
8 SectionTheme Toolboxes

10 "20881 Product

1 fra28 Product

121 Nails and Screws  Section

13 SectionTheme Nails and Screws

14 108 Product

15 20674 Product

16 1 Garden Tools Section <Action ID="PublicationTemplateSpreadindexAction” Type="Publication ction” parameter &
17 SectionTheme Garden Tools

182 Weed Trimmers. Section

19 20882 Product

20 21833 Product

213 Electric Section

2 20695 Product

23 20714 Product

2412 Corded Section L

Mandatory and Optional Information for Publication Excel Imports

The following table outlines the contents of a Publication Excel import spreadsheet and whether the fields are
mandatory or optional. The columns are ordered from top to bottom as they would appear left to right when
exported from STEP. Columns can be reordered or removed before import as long as there is only one object per
row. Columns may be reordered or removed if, for example, you find that a certain order is more intuitive or if you
would like to work with a more compact spreadsheet that contains only the columns that you need.

Though a publication template and product template(s) are required to manually create a publication in STEP, this
is not the case for Publication Excel imports. The fields for PublicationTemplatelD and ProductTemplatelD are
listed as optional in the following table because templates can be linked to publication(s) in STEP after the
publication is created. In addition, a Publication Excel import can create sections without a designated version,
hence the optional designation for VersionID. This functionality is useful if you would like to quickly create the
structure of a publication before deciding which templates or versions you will need. The bare minimum amount of
information that is required to create a publication with a Publication Excel import is the object type ID of the
publication and the object type ID(s) of the section objects.

Note: Even though the system will allow a Publication Excel import to create a publication without a version, it is
not recommended to do so. A version must still be created before the publication can actually be used for
production, as actual pages cannot be built in InDesign without a version.

Column Header Description Mandatory?

PublicationID STEP ID of imported publication No

(Yes ifthe STEP ID of
the publication object
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Column Header Description Mandatory?

type is not set to

autogenerate)
PublicationName STEP Name of imported publication No
PublicationType Object type ID of imported publication Yes

PublicationTemplatelD STEP ID of publication template linked to the imported | No, but it is strongly
publication recommended to provide
this information.

If not provided in the
import, a publication
template must be
manually linked to the
publication before it can
be used for production.

PublicationInheritedUnit | Unit applied to the publication group that contains the No, but it is strongly
publication (mm, inches, points, or picas) recommended to provide
this information.

If not provided in the
import, the unit will
default to mm, regardless
of what unit is set on the
existing publication

group.
VersionID STEP ID of the publication version(s) of the imported No
publication
(Yes ifthe STEP ID of
the Publication Version
object type is not set to
autogenerate)
VersionName STEP Name of the publication version(s) of the No
imported publication
VersionContextID STEP ID of the Context(s) used in the publication No, but it is strongly
version(s) of the imported publication recommended to provide
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Mandatory?

this information.

If not provided in the
import, the Version
Context ID must be
manually added to the
publication before it can
be used for production.

VersionWorkspacelD

STEP ID of the workspace(s) used in the publication
version(s) of the imported publication

No, but it is strongly
recommended to provide
this information.

If not provided in the
import, the Version
Workspace ID must be
manually added to the
publication before it can
be used for production.

LayerMappingTemplate | Name of the document layers in the templates No
(Publication, Product, and InDesign-created Page
templates)
LayerMappingDocument | Name of the corresponding document layers in the No
Publication Document (mounting page)
LayerMappingOwner Whether the publication version to which the layer is No
mapped is the owner of the layer ('true’ for yes, 'false’
for no)
SectionLevel A number that represents whether the sectionis atop- | No
level section (1) or a subsection (2, 3, 4, etc.) .
(Yes if you do not want all
sections to import as top-
level sections)
SectionID STEP ID of the imported publication section(s) No

(Yes ifthe STEP ID of
the section object type is
not set to autogenerate)
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Column Header Description Mandatory?
SectionName STEP Name of the imported publication section(s) No
SectionTypelD Obiject type ID of the imported publication section(s) Yes
MetaDataAttributelD STEP ID of metadata (description) attributes linkedto | No
the publication or section
MetaDataAttributeValue | Value of metadata (description) attributes linked to the | No
publication or section
RuleSettings Pagination Rules used in the publication(s) and No

sections

Example: <Action
ID="PublicationTemplateSpreadindexAction"
Type="PublicationTemplateSpreadindexAction"
parametertemplateSpreadindex="1"> <Condition
ID="AlwaysCondition" /> </Action>

ProductTemplatelD

STEP ID of the product template(s) linked to the
imported publication

No, butitis strongly
recommended to provide
this information.

If not provided in the
import, a product
template must be
manually linked to the
publication before it can
be used for production.

LinkedObjectID STEP ID of the product, asset, or classification object | No
linked into the section(s)
LinkedObjectType Value will either be 'Product’, 'Asset', or 'Classification' | No

depending on whether a product, asset, or
classification object is linked to the section(s).
'Product’, 'Asset’, and 'Classification’ are generic
terms and do not specify the exact object types of the
product, asset, or classification.

(Yes if you have provided
a LinkedObjectID, as the
possibility exists that a
product object and asset
object could share the
same STEP ID)
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1. Right-click on the publication group object in which you would like to create your publication, then select Import

Publication.

Elﬁ Publications
ﬁ Templates

E]ﬁ Autopage Public

=l Acme Tools
Eﬁ Commer:
--ﬁ Power Ti
--ﬁ Hand To
-- Toolboxe
-- Garden 7

Eﬂ--ﬁ Flatplanner Publi

- WeblUIPublicatio

- [0 TempWebUIPub

-7 Primary Product Hier

-5 Collections

- [E3 eCatalogs

:IT} Recyde Bin

| R e B e B |

@ Standard Publications

m
m

]

"R

# & X

Mew Publication Group

Mew Publication...

Create Mew Publication from existing one...

Mew Page Template ...

Export Images & Documents...

Cut

Copy
Paste

Paste Link

Delete
Duplicate

Run Bulk Update
Search Below

Export Data Below

Import Publication... I

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+L

Ctrl+]

2. Inthe Select Excel file dialog that displays, navigate to the desired Publication Excel file, then click Open.

3. Inthe Save Import Configuration dialog that displays, select Start Import Process, then click OK. The file
will import with no additional prompts, as columns do not need to be mapped for Publication Excel imports.
STEP automatically recognizes the file format, which is pre-mapped.

Importing a Publication Excel Sheet — Alternate Methods
Alternately, you may import a Publication Excel sheet by the following methods:

« Import Manager (File > Import > Data)

« Hotfolders (lIEP)

o Publishing Web Ul (Import Publication XLS Action)
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Importing Publication Excel Files in the Import Manager (File > Import > Data)

The File > Import > Data method launches the Import Manager wizard, which involves more screens to click
through but provides more control over what happens when the Publication Excel file is imported. Some standard
options in the Import Manager wizard are available for the Publication Excel import format just as they are for other
formats, including the ability to perform a test-only import and run business rules on import.

Note: The imported publication will be created beneath the top (root) node of the Publication hierarchy if this
option is chosen.

The following steps presume that a new import configuration is being created.

1. In Step 1 (Select Configuration), choose Create New Import. Click Next.
In Step 2 (Select Data Source), choose the Publication Excel file that you would like to import. Click Next.

In Step 3 (Select Format), the Publication Excel format will already be selected and the Import Manager will
display a preview of the file. This visual representation of the file may prove useful as a 'final check' on the
import sheet's contents before proceeding with the import. Click Next. Steps 4 and 5 will be skipped.

2] Import Manager (=

Steps Select Format

1. Select Configuration Format | Publication Excel =
2. Select Data Source
3. Select Format

Imports a publicationExcel files

“h o Lk Conversion Preview
5, Identify Gbjects - — - - - - -
. Publicatio... > |Publicatio... » |Publicatio... > RuleSettings » MetaData... » |MetaData... > MersionName » |VersionCo... » |VersionW... > |ProductTe... > |SectionLevel > SectionName > |SectionTy... > |LinkedObj... > |LinkedObj *
& BT Zeta Tooks 2... Default publi... (110408 <Action ID=...
7. Select Business Rules CatalogTheme Zeta Tools 2...
8. Advanced Settings French FR Context2 Main
English US Contextl Main
107821
108803
<Action ID=... 1 [Toolboxes Section
SectionTheme Toolboxes
20881 Product
7329 Product
20682 Product
5806 Product
1 Nails and Scr... Section
SectionTheme Nails and Scr...
8108 Product
20674 Product
7828 Product
101118 Product
107628 Asset
107629 Asset
<Action ID=... 1 Garden Tools  Section
SectionTheme Garden Tools
2 Weed Trimmers Section
20682 Product
21933 Product
5806 Product -
< m o
‘ Back | [ Next 1 | Finish | ‘ Cancel

4. In Step 6 (Identify Destination), all settings may be ignored, as none of them apply to publication objects.
However, you may check Test Only Import if you would like to run the import as test only. Click Next.

5. In Step 7 (Select Business Rules), business conditions and/or actions may be selected if workflows have been
configured for publication and/or section objects. Click Next.

In Step 8 (Advanced Settings), all settings may be ignored. Click Finish.

7. Check Save Options on the Save Import Configuration screen if you would like to save the Publication Excel
import configuration. Click OK to complete.
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Importing Publication Excel Files Via Hotfolders

Publication Excel files may also be uploaded via hotfolders, which are configured through Inbound Integration
Endpoints (IIEPs). Configuring an IIEP for Publication Excel imports is similar to configuring a Publication Excel
import using the standard Import Manager.

Note: The imported publication will be created beneath the top (root) node of the Publication hierarchy if this
option is chosen.

For more information on configuring hotfolders and IIEPs, see Creating Inbound Integration Endpoints in the
Integration Endpoints documentation.

Importing Publication Excel Files in Web Ul

In the Web Ul, Publication Excel import functionality is available through the Import Publication XLS Action, which
can be added as a button on a Node Details component. It is intended to be used from a publication group details
screen, as publications must be imported into a publication group folder.

GO <) | Pubication Group @ +eromns vin @ O

&5 Print on Demand Publication

Publications » Autopage Publications

D 108372
Select an existing public ation to review or edit the 4 o
public ation and generate a new POF. Note: This tree has Name Autopage Public ations
been configured to show the top level publication group
but ¢ an be modified to show a sub-group instead. Object Type Publication group types

v [ Public ations

> @ Templates

> @ Standard Public ations Configuration
-

=

> @ Flatplanner Public aticns

public aticngroupdetails ¥ ||Save| Close||New...| Delete| Rename|(Save as...
> @ WeblIPublic ationTypes
> @ TempWeblIPublic ations Butto ns propertles go to parent
Component Description Contains 8 number of buttons to display
¢ -
q onents
4
“ Actions I ImportPublic ationXLSAc tion I
[Tree | (€~ import Publication
- Add. [[Remove| |Up|Down

Considerations and Limitations

« Though multiple publications may be exported in a single Publication Excel file, multiple publications may not
be imported in the Publication Excel format. To import multiple publications at once, the STEPXML format
must be used. For more information on STEPXML imports, see STEPXML Format in the STEP Import
Manager documentation.

« Import of layer mapping information is not currently available in either the Publication Excel or the STEPXML
format.
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For More Information

For information on Publication Excel exports, see the Exporting Publications in Excel section of the
STEP'n'design documentation.

For more information on the export and import of Flatplanner publications in Excel, see Exporting and
Importing Flatplanner Publications in Excel in the Flatplanner documentation.

For more detailed information on Import Manager functionality and the Import Manager wizard, see Data Import
Manager Wizard in the Import Manager documentation.

For information on the Publishing Web Ul, See STEP Publishing Web Ul in the Web User Interfaces
documentation.

Linking Objects to the Publication Hierarchy by Excel Import
Product, classification, and asset objects may be linked to publication sections in the Publication (green) hierarchy
by using a Publication Excel import sheet.

Though the Publication Excel format can be used to create entire publications on import, it can also be used to link
objects into the sections of existing publications.

Note: The Publication Excel format will only link objects to publication sections. If you need to link objects to a
publication, this linking must be performed manually. See the Linking and Unlinking Publication Products,
Assets, and Classifications section of the Getting Started / STEP User Guide.

To obtain the 'template’ spreadsheet that you will use for your import, you should first export the publication into
which you would like to link your objects. To export the publication, follow the steps outlined in the Exporting a
Publication Excel Sheet section of the STEP'n'design documentation.

Once you have the Publication Excel sheet, follow these steps to link objects to the sections within your
publication. (The first two steps are optional, as columns do not actually need to be removed for the sheet to
function correctly. However, removing extraneous columns keeps the sheet easier to manage.)

1. Delete all columns between PublicationID and SectionLevel (in this example, columns B through J).

A B C D = E G H | J K
PublicationID I PublicationName  PublicationType PublicationTemplatelD  PublicationinheritedUnit PubPageTemplatelD ~ VersionlD VersionName VersionContextlD VersionWorkspacelD ISectionLevel
177904 ACME TOOIS Default publication type 110408

"177996 French FR Context2 Main
177997 English US Context1 Main

2. Delete all columns after SectionTypelD (in this example, F through H).

A B C D E | G H
PublicationlD  SectionLevel SectionlD SectionName SectionTypelD I MetaDataAttributelD MetaDataAftributeValue RuleSettings I
="Rept

1
2 77904 =ACToN
3

CatalogTheme Acme Tools

3. Addtwo columns at the end with these headers: LinkedObjectID and LinkedObjectType.

© Stibo Systems - Confidential 165



StiboSystems

A B C D E E =

1 PublicationlD  SectionLevel SectionlD SectionMame SectionTypelD LinkedObjectiD LinkedObjectType
r

2 M77904

3 £ M77908 Toolboxes Section

4

5 " M1779990 Nails and Screws Section

6

7 £ 178000 Garden Tools Section

8

9 g 1178001 Weed Trimmers Section

10 £ 178002 Gas Powered Section

11 " 178003 Gas-0il Mix Section

12 " 178004 Regular Section

13 " 1178005 Gloves Section

4. Insert blank rows beneath each Section into which you would like to link products, assets, and/or
classifications. Then, enter the STEP IDs of the linked objects in the LinkedObjectID column, starting with the
row directly beneath the appropriate Section row.

A B C D E F G
1 PublicationlD  SectionLevel  SectionlD SectionName SectionTypelD  LinkedObjectiD  LinkedObjectType
2 77904

3 ¢ 77908 Toolboxes Section

4 H8210
5 "g212
6 18213
7 "8216
5 700812
g 68527
10 1100703
11 100305
12 H8207
13 f8214
14 M8215
15 Hg217
16 0803
17

18 ¢ 77900 Nails and Screws Section

19

20 ¢ 178000 Garden Tools Section

Alist of STEP IDs of products, assets, and/or classifications may be obtained by exporting the relevant
objects—in Excel format—from their respective hierarchies in STEP or from a Collection. These IDs can then
be pasted into the LinkedObjectID column of the Publication Excel sheet where needed. See the Exporting
in Excel or CSV Format section of the Exporting Data and Images documentation for more information.

5. Inthe LinkedObjectType column, enter 'Product’, 'Asset’, or 'Classification', depending on what type of object
is being linked.

Note: The generic terms 'Product’, 'Asset', and 'Classification' are required; the actual object types of the
linked items should not be specified.
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A B B D E F G
1
2 M77904
3 ¢ "77908 Toolboxes Section
4 18210 Product
5 18212 Product
6 8213 Product
7 8216 Product
8 100812 Product
9 68527 Product
10 100703 Product
11 00305 Product
12 8207 Product
13 18214 Product
14 8215 Product
15 M8217 Asset
16 0803 Classification
17
18 ¢ 177990 Nails and Screws Section

6. Repeat the above steps for each additional section into which you would like to link objects.

Importing the Sheet

Once all STEP IDs and object type designations have been added to the sheet, import it into your publication by
following these steps:

1. Right-click on the publication group that contains your publication and select Import Publication....
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=& Publications
ﬁ Templates
ﬁ Standard Publications
E}ﬁ Autopage Public ™

El Acme Tools
% Commer
[+ (@ Power Ti
-- Hand To
-- Toolboxe

[ |

G- Garden A

F}- ﬁ Flatplanner Publi
- [l WebUIPublicatio

B

| oy O B e A |

vt B8l TempWWebUIPUbl

T Primary Product Hier
-5 Collections

i3 eCatalogs

/-5 Recyde Bin

X

» Path
> Init

Mew Publication Group

Mew Publication...

Create Mew Publication from existing one...
Mew Page Template ...

Export Images & Documents...

Cut

Copy
Paste
Paste Link

Delete
Duplicate

Run Bulk Update
Search Below

Export Data Below

Import Publication... I

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+L

Ctrl+]

StiboSystems

2. Inthe Select Excel file dialog that displays, navigate to the desired Publication Excel file, then click Open.

3. Inthe Save Import Configuration dialog that displays, select Start Import Process, then click OK. The file
willimport with no additional prompts, as columns do not need to be mapped for Publication Excel imports.
STEP automatically recognizes the file format, which is pre-mapped.

linked into the publication sections.

When the background process successfully completes, the product, asset, and/or classification objects will be

For more information on other ways to import a Publication Excel sheet (for example, by using the Import Manager
or in Web Ul), see the Importing a Publication Excel Sheet section of the STEP'n'design documentation.

Working with Publication Transfer Packages

Publications and their accompanying templates can be exported from one STEP system and imported into
another through the use of Publication Transfer Packages.

Publication Transfer Packages enable the exporting of entire STEP publications and their associated templates
into a .ZIP folder, which can in turn be easily imported to another STEP system in a single operation. These
Transfer Packages contain the following items:

« Publication Excel spreadsheet
« Publication STEPXML file
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Publication templates

Product templates

Page templates (for Flatplanner publications only)
XML mapping files that link the STEP names of all templates to STEP IDs
Export configuration property file

Note: Your STEP system must be connected to an InDesign server in order to import publication Transfer
Packages. If your system is not connected to an InDesign server, contact Stibo Systems for assistance.

Exporting a Publication Transfer Package
To create a Transfer Package for export, follow these steps:

1. Inthe Tree, navigate to the publication that you would like to export.

2. Right-click on the publication and select Export to Transfer Package.

&[5 Promotions

=0 Publications & Cut Cirl+X
- [g8 Templates Copy Ctrl+C
g iti”dard Z‘U Paste Ctrl+V
=8 utopage PU _
il Acme To Paste Link Ctrl+L
Delete
=@ Ac Duplicate
w0 Zeta
=-[@ Beta T Search Below
- Beta Too
[ Flatplanner | Financial Report
@ WebUTPublic @ Y Export Data Below
E-El TempWebUl

&0 Primary Produd Export to Transfer Package
#-L5 Collections
[ 10

<3 eCatal i
H e elatalogs 2 Autopaginate

3. Abackground process starts and the Starting process Export to Transfer Package dialog displays. Click
Go to process in order to view the background process on the BGProcesses tab.

4. When the export process is complete, click on the file icon (located at the bottom right corner of the
Background Processes tab screen), then save the .ZIP file to a location on your computer.
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port to Transfer Package: - Background Process -

TRE ] YUPNLaLE meLun sivery

% ETIMvZUpgradeProcess & Exported 1 Publication Groups(s), 1 Publication(s), 6 Section(s), 0 Planned Page(s *
% Event Consumer Exported publication objects in 0 seconds. (Thu Apr 07 14:31:29 EDT 2016)

% Event Processor (16) Exported qualifiers (cross context) in 0 seconds. (Thu Apr 07 14:31:29 EDT 2016)
% Event Queue Delete Exporter completed in 0 seconds. (Thu Apr 07 14:31:29 EDT 2016)

-£ ExcelExportDownload — Export of publication completed (Thu Apr 07 14:31:29 EDT 2018)

{4 Export Manager Pipeline Export product template: Parly Product Template_tiled (Thu Apr 07 14:31:29 EDT 21

-£& Export to Transfer Package (1) =
- Queued Processes

Export product template: Arts & Crafts Product Template (Thu Apr 07 14:31:29 EDT
T Export product template: Holiday Product Template (Thu Apr 07 14:31:29 EDT 201€

E% Ended Processes (1) Export publication template: Main Publication Template (Thu Apr 07 14:31:28 EDT :
% Export to Transfer Package: Created InDesign package /workarea/background-processarea/ExporTritPckg/BG
éﬁ% Export to Transfer Package: Export to Transfer Package done handling request

..... 45 Export to Transfer Package:

- GDSNConverter « a4 |1-a20f42] B »

-£& GDSNReceiverSubImport
-£i GDSNValidation

----- % Active Processes

11

-#% GetPDFOfActualPage ? Result |
- Global Update b |Exported file Acme_Tools.zip E]]l -
<« | L] ’ < | 1 1 4

5. Thereis no need to extract the contents of the .ZIP file, as the .ZIP file itself is the Transfer Package that will
be used to imported the publication and templates into another STEP system. However, the folders contained
in the .ZIP file are as follows:

#~

Mame Type
. pageTemplates File folder
| productTemplates File folder
| publication File folder
| publicationTemplate File folder

+ pageTemplates: Contains all page templates associated with the publication plus an XML file
(TemplateNamelDMapping.xml) that maps the file names of the templates to their corresponding STEP IDs.
The pageTemplates folder is always included but will only contain content when a Flatplanner publication is

exported.

-

Mame Type
3x31.generic GENERIC File
3x32.generic GENERIC File
Ax41.generic GENERIC File
Ax42.generic GENERIC File
Doc-dev page templ.generic GENERIC File
Doc-dev page tempZ.generic GENERIC File
TemplateNamelDMapping.xml XML File
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+ productTemplates: Contains all product templates associated with the publication plus an XML file
(TemplateNamelDMapping.xml) that maps the file names of the templates to their corresponding STEP IDs.

s

Name Type

'. Arts & Crafts Product Template.indd InDesign Document

'. Holiday Product Template.indd InDesign Document
'. Party Product Template_tiled.indd InDesign Document
TemplateNamelDMapping.xml XML File

« publication: Contains a Publication Excel sheet, a publication export STEPXML file (PUBLICATION _
EXPORTED.xml), and an export configuration file (ExportConfiguration.tmp).

o~

Name Type

ExportConfiguration.tmp TMP File

5"j exported.xls Microsoft Excel 97-2003 ...

PUBLICATION_EXPORTED.xml XML File

+ publicationTemplate: Contains the publication template associated with the publication plus an XML file
(TemplateNamelDMapping.xml) that maps the file name of the template to its corresponding STEP ID.

-~

Mame Type
'. Main Publication Template.indd InDesign Document
TemplateNamelDMapping.xml XML File

Importing a Publication Transfer Package
To import a publication Transfer Package, follow these steps:

1. Inthe Tree, navigate to the publication group into which you would like to import the publication Transfer
Package.
2. Right-click on the publication group and select Import Transfer Package.
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&l Templates

-6 Publications H
@ Stand=rd Buhlicatione

- Yuto] B New Publication Group
- Natp New Publication...
E TEh: Create New Publication from existing one...
w5 Primaky| BE New Page Template ...
#-03 Collecty ¥  Export Images & Documents...
#-E3 eCatal
5% Recycle Cut Ctrl+X
Copy Ctrl+C
Paste Ctrl+V
Paste Link Ctrl+L
Delete

Duplicate Ctrl+)
bun Bulk Update

barch Below

Import Transfer Package

3. The Select Zip File dialog displays. Navigate to the publication Transfer Package .ZIP file that you would like
to import, then click Open.

4. Inthe Import Transfer Package dialog that displays, check the Create Group for Templates box if you
would like to create a new publication group to house the templates contained within the Transfer Package.
This new group will be created inside of the publication group that you have selected.

Enter an ID and a name for the new publication group, then click Ok. (If you leave the box unchecked, then the
templates will be imported directly into the publication group that you have selected.)

E] Import Transfer Package @
Create Group for Templates:

Template Group ID: NewTemplateGroup

Template Group Mame: New Template Group

Cancel

5. Abackground process starts and the Starting process Import Transfer Package dialog displays. Click Go
to process to view the background process on the BGProcesses tab.

6. When the background process completes, the publication and its associated templates are now created on the

destination system. If you checked the Create Group for Templates box in step 4, this new publication group
is also created.
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Note: If the Publication Excel / Publication STEPXML files in your Transfer Package contain the IDs of Products,
Classifications, or Assets that do not exist on the destination system, these objects will not be created in the
destination system.

For More Information
For more information on exporting and importing publications in the Publication Excel format, see the following
topics:

« Standard (‘drag and drop') and AutoPage publications: Exporting and Importing Publications in Excel

« Flatplanner publications: Exporting and Importing Flatplanner Publications in Excel

Linking to an Asset Location

This topic describes a common setup for users of STEP'n'design when connecting to an Asset Location from
within the InDesign client. The asset location is specified in the STEP Preferences menuin InDesign. Typically,
the asset location contains the path to high-resolution images that have been pushed from STEP onto the DTP
(InDesign) server through an asset push event queue.

Preferences

Multi-place Gap 0.0417 in Multi-drop commit 0

Structure Tree view options

Show all Attributes in Tree -
Show Tables in Tree
Show Asset References in Tree
Show ID after name
Place in Galley

+ |Place in Free Space

| Fit Calculated Table Width to Frame Width

Process Folder C:\Users\abcd\step-dtplindesign, |:|
Template Path C:\Users\abcd\Documents Templates \:l
Template Cache size 1]
Server presentation MNone -

Use default asset path
Asset Location L\ |:|
Mote Layer MNotes
Mote Colour -

Don't mount Done Notes

v | Prompt for Version

Auto Show Version Update Auto save before save to DB
SOAP Timeout 900 cURL Timeout q0o0
Export... [ oK | [ Cancel |

In many scenarios, the images on the InDesign server are pushed again from the InDesign server to a local file
location using a third-party file synchronization application such as rsync. But, even when using such an
application, the file path placed into the Asset Location field in STEP Preferences must be an exact match to the
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file path of the image location on the InDesign server. This ensures that the image links remain unbroken between
the mounted pages, the InDesign server, and STEP. (If these links become broken, they can be fixed using the
asset relink features of STEP'n'design. See the next topic in this documentation, Relinking Assets in
STEP'n'design, for information on how to repair broken image links.)

Assumptions

This topic does not cover the following and assumes that the applicable steps have been taken prior to users
connecting to an asset location in InDesign:

« How to configure Asset Push event queues. For information on Asset Push, see the Asset Push Overview
section of the Exporting Data and Images / STEP Asset Push User Guide documentation.

« How to set up an InDesign server. For more information, contact Stibo Systems.

« How to remotely connect to an InDesign server. The method of connection will vary depending on your
operating system and server setup. For more information, contact Stibo Systems.

« Alternate ('non-standard') setups for connecting to an asset location, such as connecting to an external
image storage platform such as Scene7. For information on non-standard setups, contact Stibo Systems.

+ How to share folders and map network drives. As these processes are standard Windows and Mac
functionality, they are outside the scope of this documentation.

About the InDesign Server
An InDesign server is used in conjunction with STEP for the following Publisher-related capabilities:

o Proof View

« Creating documents via AutoPage

« Flatplanner planned page previews

« Creating documents from a Flatplan via a Flatplanner workflow
« Generating PDFs from documents in STEP

« Including actual pages when duplicating publications

« Import of Publication Transfer Packages

¢ Document-Asset Re-link

An InDesign server is not required for 'standard' STEP'n'design functionality (‘drag-and-drop'), as users can
manually create publications by dragging and dropping objects onto pages, then manually saving the pages back
to STEP. However, an InDesign server is required to autogenerate pages, and it unlocks much of the functionality
of STEP'n'design and its associated components, as listed above.

How the InDesign Server Locates an Image

In a'standard’ setup, asset push will push high-resolution images out to a folder on the InDesign server (though
images can be pushed to any server within the STEP landscape, based on user needs). When the InDesign
server application automatically mounts pages based on requests from STEP, it is 'told' where to locate high-
resolution images by piecing together information that exists in the following locations:
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1. dtp-server.properties: This file is located on the InDesign server and contains the 'stem’ file path of the image
location, for example, E\:\\step\\assetpush\\images

| dtp-server.properties - Notepad M=] E3
File Edit Format ‘iew Help
#This file contains the configuration needed Tocally on this dtp serwver =]
#Fri Dec 04 04:19:25 PST 2015
serverDir=Ch:/Program Files/adobesAadobe InDesign CS6 Server x64
#Backgroundroot=set this to shared background ﬁracess directory
#adobeserializationDir=0ptional. sSet this to the directory that contains the adobe

= 'I-'|m-'| P2 i i 'I-:m-: = = ‘jbe_pr‘tk)
AssetPUshROOT=EY:NWhstepihassetpushhyimages
LAk LN =) g = O = N L g L = e L P e n ey g ey Path to the prov. xm1 file. This contains
the provisioning information needed when serializing.

[~

2. Asset ID: The ID of the image

€ Streamers - Blue & Orange rev.1.1 - Images & Docu...

LT SRR LTI N | References || Referenced By || Status || State Log || Tasks
7 Description
MName »| 2 _Walus > AT L g
T =l
> D 110051 L= .
=) Ei )"
> |Name Streamers - Blue & Orange * . { \_\
e
> Object Type Product Image T-«\:: a
> |Revision 1.1 Last edited by USER on Fri Oct 16 ... [_te 2 . M
* |Approved + Approved on Fri Oct 16 09:37:30 E...

3. sharedconfig.properties: This file is located on the STEP application server and contains configuration
entries that tell the InDesign server the ID of the Asset Push Configuration (created in the workbench in
System Setup) to use based on the workspace that is currently in use. For this example, the 'DTP Queue'
event queue contains two asset push configurations, 'raw-approved' and 'raw-main.'

IZZI-- Tags

H-g Units

% Users & Groups
B, Reference Types
IZII~ Workspaces
- Table

H-E Keys

=¥ Event Queues

B0 Asset Push 1 Queue
[0 Assst Push 2

50 DTP Queue

i [raw-approved

raw-main

L)
[ZI--!; Object Types & Structures -

< raw-approved - Asset Push Configuration

Gl TR R T E TG | Asset Push Configuration Statistics || Log
>

Name » Walue
> ID raw-approved
* [Name raw-approved

v

Notification Email

W

Workspace

Approved

W

Image Conversion

<source=

W

Relative Path Template

$configID$/$contentdimensionpointsID$/ $IDpath$/$assetiD$. Sautodetected-extension$

W

Auto Cleanup

111

true

v

Include Classification

Icons, Tlustrations, Logos, Product Images

|image,"*

Configuration entries in the sharedconfig.properties file point the InDesign server to the appropriate queue.
AssetPush.DTPConfiguration is the default queue to use when the workspace is Main, and
AssetPush.DTPConfiguration.Approved is the default queue to use when the workspace is Approved.
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#::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::#
# AssetPush event queue configuration. Must always be configured!
#::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::#

EnableAssetPushQueue = yes

AssetPush Usesysiem = new
AssetPush.DTPConfiguration = raw-main
AssetPush.DTPConfiguration. Approved = raw-approved
FASSCLPUSH. Legalinars = —sU-U30a-Z30A-Z%

The combination of numbers 2 and 3 above (Asset ID plus Configuration ID) enable the InDesign server to obtain
the 'STEP path' of the image. For example, raw-main/00/51/110051.png. The path is the result of the setup of the
Relative Path Template. (For information on the Relative Path Template, see the Relative Path Template
section of the Asset Push documentation.)

Streamers - Blue & Orange rev.1.1 - Status

Images & Documents || References || Referenced By m State Log || Tasks

¢ Asset Push Status

Configuration * [Asset Push Status Relative Path Workspace * \isibility >
* raw-main v Up to date la2| raw-main/00/51/110051.png Main Language R...
* raw-approved | Downloaded laz| raw-approved,/00/51/110051.png Approved Language Root

When this 'STEP Path' is combined with number 1 above, the 'stem' path, the InDesign server can now locate the
external image by its complete path and file name. For example, E:\step\assetpush\images\raw-approved\00\51.

l E:'\step' assetpushtimagesraw-approved' 00451

GC) | Etlsteplassetpushiimagestraw-approved|00is1| -] &) search st L

Organize +  Incudeinlibrary »  Sharewith v Mew Folder = ~ O @&
e Local Disk (C:) 2l name - | Date modifisd | Type | Size | |
Cw image (E:)

B 110051.png /232015 11:47 M PNG image 118 KB

; Java

. step
| assetpush

J sidecar-cache
. images
| rav-approved
. on
-1
. 52

Setting an Asset Location in InDesign

When mounting documents from InDesign, the Asset Location designated in the STEP > Preferences menu
should be the same image location accessed by the InDesign server. By default, the Asset Location field is blank.
When logging into STEP from within InDesign, the error message 'Warning: Asset path is not set' displays every
time you log in until an asset path is specified.
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Adobe InDesign @

8 Warning: Asset path is not set

To keep this error from appearing, a path to the high-resolution images must be specified in the Asset Location
field.

Important: Though acceptable for testing purposes, the Asset Location field should never be left blank in an
actual production environment.

Determining the Asset Location

In order to connect to an asset location, you must first know what file path to enter. The following section describes
a typical scenario in which images are located on a Windows InDesign server and the high-resolution assets have
been pushed from STEP into a file location on this server by use of an asset push event queue.

Instructions for Mac users are nearly identical to those for Windows except for Mac file path formats and specifics
of how to share folders on a Mac operating system.
Shared File Location

On any file location where images are stored, the folder containing the images must first be shared with users
before they can connect. This section assumes that your image folder has already been shared. As the steps to
share a folder are standard Windows functionality, they are not outlined in this topic.

The following screenshot shows a sample 'images' folder hierarchy containing images that have been pushed
from the main and approved workspaces in STEP (raw-main and raw-approved, respectively). To determine the
correct path to enter into the Asset Location field in the STEP Preferences menu:

1. Onthe InDesign server, navigate to the shared 'images' folder that contains the high-resolution assets pushed
from STEP by asset push.

2. Right-click on the 'images' folder and select Properties from the menu.

3. Inthe'images Properties' dialog, click on the Sharing tab. The Network Path: that is displayed in the
'Network File and Folder sharing' area is the location that should be specified in the Asset Location field.
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Instead of directly typing this location into the Asset Location field, however, you must first connect to this
location by mapping a network drive to the network path. In the above screenshot, the path is \STEP-
DTP\images.

(Instructions on how to map to a network drive are not included in this topic, as it is standard Windows function-

ality.)
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assetpush-location.properties

Once the network drive is mapped, go to STEP > Preferences... in InDesign.
Click the ellipsis button (...) next to the Asset Location field.

In the 'Select a Folder' dialog, navigate to the 'images' network drive that you just mapped in step 4.

© N o O

The path to the high-resolution images on the InDesign server is now present in the Asset Location field. In this
example, since the path is a mapped network drive, only the letter of the drive name displays.

Use default asset path

Asset Location I\
Mote Layer Motes

Default Asset Path

A default asset path can be setin InDesign that allows users to connect to a client-specific asset location that
overrides the default asset push location defined in the sharedconfig.properties file (the queues pointed to by
AssetPush.DTPConfiguration and AssetPush.DTPConfiguration.Approved).

To set a default asset path, the AssetPush.DefaultDTPClientAssetLocation property must be inserted into the
sharedconfig.properties file, followed by the asset location, as such:

AssetPush.DefaultD TPClientAssetlLocation = \\\server/images/AssetPush_highres

If a default asset path has been set in the sharedconfig.properties file, then users should leave the Asset Location
field blank in the STEP Preferences menu and instead check the Use default asset path box. (If no default asset
path has been set up in sharedconfig.properties file, even if this box is checked, it will be exactly as if no image path
atallissetup.)
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Preferences

Multi-place Gap 0.0417 in Multi-drop commit 0

Structure Tree view options

Don't show Attributes in Tree -
[]show Tables in Tree
Show Asset References in Tree
[] show ID after name

Place in Galley

[] Place in Free Space

+ | Fit Calculated Table Width to Frame Width

Pracess Folder C:\Users\user\step-dtp\indesign, \:|
Template Path C:\Users\user\Documents\ Templates |:|
Template Cache size 0

Server presentation MNone -

Use default asset path

Asset Location \:l

Note: Default asset path cannot be used for production environments that use a mix of PC and Mac clients. The
environment must be either all PC or all Mac.

Relinking Assets in STEP'n'design

Two functions exist within STEP'n'design to relink broken asset links (typically images) on mounted pages: Relink
Assets (which is run via the InDesign Client on an open document) and Document-Asset Re-link (which is
launched in STEP and causes a background process to run).

Although the standard InDesign function of relinking assets may be done via the Links panel, that method can be
cumbersome because it requires users to manually search for or navigate to image locations. If links are broken on
hundreds upon hundreds of pages, relinking assets by this method could become an extremely time-consuming
task. As such, this method is not recommended.

The STEP functions of Relink Assets and Document-Asset Re-link automate this task when users are
connected to a shared image location.

About Broken Links

Image links become broken when a document contains images that are no longer linked to the original location of
the actual image files. Though images appear on the page, they are only screen-resolution renderings of the
original files. Broken links can occur if the original file has been deleted or moved to a different folder or server after
it was originally imported into the document. They can also occur if client machines are not connected to the
shared image drive in exactly the same manner, or if users change the manner in which the shared drive is
connected from one day to the next.

When opening a document in InDesign that contains unlinked images, the following warning dialog displays:
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Adobe InDesign e

This document contains 8 links to sources that are missing. You
! * can find or relink the missing links using the Links panel.

Unlinked images display a red question mark to indicate that InDesign can no longer locate the original image:

Christmas Party Hat*

)

The Links panel displays the same red question mark for missing image links and a Status of 'Missing.' The
displayed Path indicates where InDesign is expecting to find the image. This location is where the current user
must be connected in order for InDesign to find the image.

—

e
=

€
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Common Causes of Broken Links for STEP'n'design Users

Missing Asset Location

StiboSystems

One cause of broken links may be if there was no Asset Location setin the STEP > Preferences menuin
InDesign when the pages were originally mounted (this refers to pages generated either manually or by creating a
document from a Flatplan). If no asset location is set here, images are downloaded directly from STEP into a 'tmp'
folder inside the Process Folder (designated in the STEP Preferences menu, pictured below). Once the

InDesign client is closed, the tmp folder is emptied, causing broken links.
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For information on how to determine what file path to place into the Asset Location field, see the Linking to an

Asset Location documentation.

Changes to How the Shared Image Drive is Connected

The most frequent cause of missing images is when the method by which the shared drive is connected to the

client or the location of the InDesign server changes.

For example, broken links can be caused if users connect too far up or too far down in the shared image folder
structure. In the following screenshot, the correctimage location is highlighted (the 'images' folder). A user who
connects to, for example, the 'assetpush' folder or the 'raw-approved' folder will experience broken links when
opening a mounted page that contains images that are linked to the correct location ('images'), which is being used

by the InDesign server.
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On Windows machines, the drive letter of the mapped network drive that is used to connect to the asset location
can also cause broken links if other users are connecting to the asset location using a different drive letter. In the
below screenshots, an Asset Location of 'l:\' is being used. The top screenshot shows how the Asset Location
looks in the STEP Preferences menu. The bottom screenshot shows a sample, extended file path using the |
drive. If another user is connecting to the asset location using, say, drive A, then their links will be broken when
opening documents that use the 'drive I' file paths.

[]use defautt asset path

Asset Location L\
Mote Layer Motes

Layer: Layer 1

Mg 118 PM

Path: I'raw-main' 111881121198, prg
Scale: 35.5%

For information on how to connect to an Asset Location, see the Linking to an Asset Location topic.

Mixed Windows and Mac Platforms

Another—Iless frequent—cause of broken image links is when there is a mix of PC and Mac platforms being used
in the same STEP'n'design production environment. This mix commonly involves one or both of the following:

« AnInDesign server is running on a Windows platform while end users are using Mac InDesign clients

« End users themselves are working on a combination of Mac and PC InDesign clients
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Even though end users are accessing images from the same shared location as the InDesign server, the
differences between Mac and Windows file path formats cause broken links. For example, when an InDesign
document is saved back into STEP from a Mac, InDesign saves the image path in a 'Mac-like' format, as such:

Volumes:images:raw-main:std.lang.all:44:05:4405.tif
When an InDesign document is saved back into STEP from a PC, the same image path is in a'PC-like' format:
E:\images\raw-main\std.lang.al\44\05\4405.tif

If a Windows user opens a document that was saved back to STEP from a Mac, the images will not be found.
Likewise, if a document that was saved back to STEP from a PC (or was created by a Windows InDesign server
and saved to STEP) is opened from a Mac, the images will not be found.

A 'standard' installation is when clients and the InDesign server are both on the same platform (either Windows or
Mac). In these cases, there is no conflictin Mac versus PC drive and path names.

Correcting Broken Links

Relinking Assets from InDesign

Missing assets can be relinked from within InDesign by using the Relink Assets function. (An InDesign server is
not required to perform this action.) Provided that the Asset Location is set correctly and connection to the shared
drive (asset push images folder) is established, STEP'n'design will be able to locate the images and change the
path in the document so the images are no longer 'Missing' and their status in the Links panel reads 'OK.'

Torelink assets on a page:

1. InInDesign, open the STEP menu and select Relink Assets.
STEP | 7% v | Ev  E=Ew

Connect to DB ...
Reload

Change Version ...
Preferences ...

Template Type r
Update Document Data ...

Layer Version Update ...

Check DB Update ...

Cleanup Mount Tags

Table Settings ...

Save Document to DB ...
Writeback to DB ...

Dump Document Data ...
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2. STEP automatically searches in the specified asset location and matches the IDs of the images in the
document to those of the images in the asset location.

3. Once therelink is complete, an Adobe InDesign dialog appears that displays the number of assets that were
relinked.

Adobe InDesign @

Asset Relink
' B Assets relinked.

If the relink fails, an error message displays to explain which images could not be relinked. 'Problem Asset IDs'
may occur if an incorrect image path is specified in the Asset Location field in the STEP Preferences menu or if
there is no connection to the shared image drive.

Adobe InDesign @

Asset Relink
¥ ) Assets relinked.
Problem Asset IDs: 121200

4. Anunbroken link icon now appears on the relinked images, and their status shows as 'OK" in the InDesign
Links panel. In addition, the updated file path is now displayed.
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Relinking Assets from STEP

A Document-Asset Re-link operation is performed from within the STEP Workbench and requires an InDesign
server.

Document Asset Re-link enables a one-click relinking of assets throughout an entire publication or section. As
mentioned in previous sections of this topic, image links can break on mounted pages when saved back to STEP
from Mac clients but are opened by an InDesign server that is running on a Windows platform. The broken links
become problematic when a user needs to perform an action on these document(s) within STEP that requires an
InDesign server, such as 'Generate PDF.'

In this scenario, if the saved documents contain Mac-style image paths (which cause broken links for the Windows
InDesign server), the Document-Asset Re-link function will correct all the links by locating the images and
converting the image paths to Windows-style paths.

As long as the dtp-server.properties file has the AssetPushRoot parameter set correctly and a connection to the
shared drive is established, the InDesign server will be able to open the InDesign documents that are in STEP,
locate the images, and change the path in the documents so that all images are no longer 'Missing.' The InDesign
documents are then saved back. Once completed, the InDesign server will be capable of, for example, generating
a PDF that contains high-resolution images using the 'Generate PDF' function.

Torelink all assets in a publication or section:
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1. Inthe workbench, navigate to the relevant publication or section, then right-click and select Document-Asset
Re-link.
H-[@ Promotions cut

=& Publications | .,
Bl Template Copy

Fjﬁ Standard Paste
Paste Link
Delete
i Duplicate
iy Search Below
[
E- B TempWwe . .
1[I Primary Prod Financial Report
-3 Collections Export Data Below
#-E3 eCatalogs
=7 Recycle Bin Export to Transfer Package

utopaginate

eapply Layout Rules

eck for update needed...
Ukdate...

Ruk Bulk Update

(#

Reset Document Mames
Document-Asset Re-link
Update actual page with plan changes.
i Generate PDF

2. Abackground process launches. Click 'Go to process' to monitor the relink progress.

£%] Starting process Re-link assets in: Power Tools @

Starting process "Re-link assets in: Power Tools" (Re-link Document Assets).
Process started

l Go to process ]| Close

3. Ifthe process is successful, alist of relinked asset IDs appears in the Execution report on the Background
Process tab. If unsuccessful, error messages will appear to indicate the problem.

InDesign Queues

Multiple InDesign queues may be created in STEP in order to sequence and prioritize jobs that are sent from
STEP to an InDesign server, such as autopagination and proof view requests. InDesign queues allow jobs to be
queued in the STEP server instead of within the InDesign server, allowing more control and prioritization of job
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requests. Such prioritization can ensure that smaller tasks are handled before larger tasks so users do not have to
wait for a large job to finish before starting another. In addition, multiple queues can be created to handle multiple
versions of InDesign.

Note: InDesign queues are not relevant unless your STEP system is linked to at least one InDesign server
sidecar. For more information on deploying an InDesign server sidecar, contact Stibo Systems.

Use cases for needing different InDesign queues include:

1. Your creative department may need to run multiple versions of InDesign. In this case, for example, you would
use one queue for InDesign CS6 and another for InDesign CC. By allocating a publication to the CS6 queue,
you will ensure that all of its documents use CS6.

2. Your creative department may be international. In this case, users in one country will use one queue, and users
in another country will use a different queue. Users in each country will then have their own set of InDesign
server resources and will not be 'delayed' if users in the other country are sending large jobs to the InDesign
server (such as the autopagination of a publication with hundreds of pages).

3. You may need to create a queue with no InDesign server renderers. This queue could be called, for example,
'Frozen.' Once a publication is finished it could be set to use the 'Frozen' queue, meaning that STEP users
cannot make any further updates / changes to the documents via workbench actions. (Note that this does not
prevent an InDesign user from opening and saving the document.)

Setting up the InDesign Queue

InDesign queues in STEP are created under System Setup > InDesign Queue.

System Setup < InDesign Queue =
&3 Attribute Groups Publications

I% Httr.ibute Transformations © DTP Queue Definition
[-{Z2] Action Sets
[-[&| Contexts

> | 10.64.205.155 cs6 >

-7 InDesign Queue Reserved for Foreground *(90%90  >|9091 >
Ej Lists of Values / LOVs Onling? > v v

#-{F Change Packages

[y Default Queue (cs6™)  *|0 4 o

D Completeness Metrics 9 ( )

[#-(5] Event Processors Default Queue (CC) >0

| Gateway Endpoint * |Manage the queues

:] GDSN WF and BR

(%] Global Business Rules

D Inbound Integration Endpoints
-5 Match Codes and Matching Algorit

% DTP Queue: Default Queue (cs6™)
User * |Renderer » |Description  * |Background ... * |Start Time *|Progress  *

In the above screenshot, the last two columns display the InDesign server renderers that are running, the port
numbers to which they are connected (for example, 9090), and the version of InDesign they are running (for
example, CS6).

Default queues are created automatically for any InDesign server renderers that are not assigned to a user-
defined queue. Multiple default queues are created so that one queue does not contain multiple InDesign versions.
Multiple InDesign versions in a queue could cause problems if, for example, a document is created on a user's
local InDesign client with CC but is then sent to an InDesign server running CS6, in which case the document
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cannot be opened. A default queue with an asterisk (*) after the InDesign version is the queue used when a
specific queue has not been assigned to the publication.

There is no limit to the number of InDesign queues that can be created, but each InDesign server instance may

only be allocated to one queue. In other words, there is a 1-to-1 relationship between InDesign server and
InDesign queue.

Note: The initial connection of InDesign servers to your STEP system must be performed by Stibo Systems.
However, once the servers are connected, end users may create InDesign queues to prioritize the order in which
pagination and proof view jobs are sent to these servers.

To create a new InDesign queue, follow these steps:

1. Onthe System Setup tab, navigate to InDesign Queue.

2. Onthe InDesign Queue tab, expand DTP Queue Definition, then click 'Manage the queues' to display the DTP
Queue Editor.

< InDesign Queue L

@ DTP Queue Definition

W

10.64.205.155 cs6 >
Reserved for Foreground 9090 > (9091 *
Onling? > o o
Default Queue (cs6*) >0 o o
Default Queue (CC) >0

W

Manage the queues

Lo .
DTP m DTP Queue Editor @
= DTF (
> »|10.64.205.155 cs6 >
* |Reserved for Foreground »|9090  »(9091  *
Online? » 4 v
Default Queue (cs6*) > [0 Q) Q)
Default Queue (CC) >l 0 © @)
” | Add New Queue
[ OK ] ’ Cancel

3. Inthe DTP Queue Editor dialog, click 'Add New Queue.'

4. Inthe Unique Queue Name dialog, enter a name for the queue, then click OK.
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-

£33 DTP Queue Editor =3
> > 10.64.205.155 cs6 >
* |Reserved for Foreground * 9090 * 9091 >
Online? > o W
Default Queue (cs6*)  * | [0 @ @

Default Queue (CC) >y o
Add New Queue

m Unique Queue Name @ 0K Cancel

US Queue

0K Cancel

5. Inthe Reserved for Foreground column, enter a zero (0) for the queue(s) that should handle foreground
tasks, which are typically smaller jobs such as product proofs and page previews. Enter higher numbers for
queues that should handle background jobs, such as autopagination of large publications.

By default, all new queues are set to 0. Leaving all queues at 0 means that a foreground task (a smaller job)
may have to wait until a renderer has finished processing a larger job before it can complete.

£% DTP Queue Editor =

> *|10.64.205.155 cs6 *

* |Reserved for Foreground * 9090 * 9091 >
Online? > ' v
Default Queue (cs6*) > 0 Q) Q)
Default Queue (CC) o - -
US Queue >l |0

* |Add New Queue
0K Cancel

6. Click OK to complete the queue setup.

Queue Operation
Prioritization

Foreground tasks are given higher priority over background tasks—otherwise the oldest task has higher priority.

Parallel Processing

Some background jobs are able to run in parallel—for example, generating a PDF of a large publication section
can retrieve multiple documents in parallel and stitch them into a single PDF as each document is returned.
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Queue Status

When requests are sent to the queues, the InDesign Queue screen displays the jobs in progress for each queue.
The following screenshot shows an autopagination task that is being handled by the 'Default Queue (cs6*)' queue.
To view the associated background process as the task is in progress, click on the Background Process button.

£ InDesign Queue P

InDesign Queue |l

§ DTP Queue Definition

W

10.64.205.155 cs6 >
Reserved for Foreground 9090  »(9091
Online? > v o
Default Queue (cs6*) >0 W o
Default Queue (CC) *10

>

W

Manage the gueues

% DTP Queue: Default Queue (cs6™)

User * |Renderer * |Description * |Background Process__> |Start Time >|Pr0gress >
> luser 10.64.205.155:9080  Paginating page 18 Paginate Zeta To...| &qThu Apr 21 11:26:29 ... || B
% DTP Queue: Default Queue (CC)
| |User *|Renderer *> |Description * |Background Process * |Start Time * |Progress >

Assigning a Queue to a Publication

Publications can be set to use a particular queue via the DTP Queue list, which is located on the Publication tab.
If only one queue exists, or if no queue is specified on the publication, the default queue indicated by an asterisk (*)
after the InDesign version will be used.

I Plan H Version H Pages H Publication Planner H Plan Notes ]
? Description
Mame *| * |Value >
> [ID 109027
> Name Zeta Tools 2016
* |Dbject Type Publication
* Revision 0.3 Last edited by USER on Wed Apr 20 17:50:39 EDT 2016
> |Path Publications/Autopage Publications/Zeta Tools 2016
* |Pages per spread 2
> |Auto page Document ... 1
* |Publication template Zeta Tools Publication Template (110408) B
* Output engine InDesign
>| DTF Queue | Default Queue (CC) iw

The publications assigned to each queue are displayed on the Publications tab in the InDesign Queue editor:
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